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Certification Information
Certification Information

F.C.C. Information

Electronic test equipment is exempt from Part 15 compliance (FCC) in 
the United States. However, compliance verification tests are 
systematically performed on most EXFO equipment.

 Information

Electronic test equipment is subject to the EMC Directive in the European 
Union. The EN61326 standard prescribes both emission and immunity 
requirements for laboratory, measurement, and control equipment. 
This unit has undergone extensive testing according to the European Union 
Directive and Standards.

IMPORTANT
Use of shielded remote I/O cables, with properly grounded shields 
and metal connectors, is recommended in order to reduce radio 
frequency interference that may emanate from these cables.
DWDM Passive Component Test System ix
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1 Introducing the IQS-12004B 
DWDM Passive Component 
Test System

The IQS-12004B DWDM Passive Component Test System, an automated 
test solution for component manufacturers and system integrators, consists 
of a series of IQS modular test and measurement instruments that are 
completely integrated by an off-the-shelf software application. This 
revolutionary system rapidly analyzes important parameters to help you 
improve your production efficiency and decrease your product time to 
market.

Characterization of multiplexers, demultiplexers, filters, and other passive 
components is a critical step in ensuring the optimum performance of a 
wavelength-division multiplexing (WDM) system.
DWDM Passive Component Test System 1



Introducing the IQS-12004B DWDM Passive Component Test System
Step-by-Step Approach
The system performs DWDM component characterization and measures 
insertion loss, spectral uniformity, bandwidth, crosstalk, channel central 
wavelength, polarization dependence and optical return loss 
measurements on multiplexers, demultiplexers, filters, and other passive 
devices. These parameters must be controlled and tested throughout the 
entire life cycle of a component, from research and development through 
to production and even deployment.

The rapidity of the test procedure is achieved by scanning a very-low-noise 
tunable laser source (in this case the IQS-2600B or IQS-2600CT Tunable 
Laser Source) across the DUT’s spectral band while power is measured 
simultaneously on all device ports. Due to the medium coherence and 
unmatched sidemode suppression of the IQS-2600B/IQS-2600CT, a 
dynamic range of nearly 60 dB is easily attained. 

The standard configuration includes IL and ORL measurements. Adding 
the IQS-5150 PSA will enable you to perform PDL measurements.

Step-by-Step Approach
Guided by your selection parameters, the software based on Windows 
2000 controls the test procedure from start to finish. This systematic 
approach eliminates the possibility of data entry and reporting errors, and 
avoids costly procedural mistakes. In addition, time-saving features such as 
Pass/Fail testing, filter masks and a part number database simplify the job 
of DWDM component characterization.
2 IQS-12004B



Introducing the IQS-12004B DWDM Passive Component Test System
Test Features and Results
Test Features and Results
Each test step may be accessed either automatically or manually. 
Complete results are calculated at the end of the scan and are available 
both graphically and in a data table; values outside the defined test limits 
are highlighted. All data is saved to a database for archiving and future 
display or printing. 

Create as many port types as you require. Once defined, they will be used 
to build a database of part numbers, enabling you to quickly reconfigure 
parameters simply by selecting the appropriate part number. The 
parameters in the port mask are used in the automatic Pass/Fail analysis.

Modularity and Flexibility
The system is built with the future in mind; the modular nature of the 
hardware and the flexibility of the software make it easy for you to upgrade 
or expand your test station. A single-channel system for measuring filters or 
gratings can be expanded to 32, 64, or more channels by simply adding the 
necessary plug-in modules. The system is also very compact: an entire 
16-channel system, including PDL, will fit into a 4U (standard rackmount 
units) rackmount space. 
DWDM Passive Component Test System 3



Introducing the IQS-12004B DWDM Passive Component Test System
System Overview
System Overview
The IQS-12004B DWDM Passive Component Test System provides spectral 
insertion loss (IL), polarization-dependent loss (PDL), and optical return 
loss (ORL) measurements with high resolution and accuracy.

The DWDM Passive Component Test System sweeps a very-low-noise 
tunable laser source across the spectral band of interest (C-band or 
C+L-band). While the source is sweeping, synchronized measurements 
from the Wavelength Reference Module (WRM) and the measurement 
power meters are acquired into the system software. At the end of the 
sweep, advanced signal processing is applied to the data, resulting in 
accurate IL, PDL, and ORL data. 

This configuration ensures quick testing time that is practically 
independent of the number of device ports (there is a nominal data 
transfer and analysis penalty per channel). Because of the low source 
spontaneous emissions (SSE) of the IQS-2600B/IQS-2600CT Tunable Laser 
Source, a dynamic range of 60 dB is easily attained. The wavelength 
reference module ensures wavelength and loss accuracy by providing 
a fast and continuous wavelength and power reference throughout the 
sweep. 

The numerous software features are explained later in this user guide.

IQS-1643T
IQS-2600B 
or 
IQS-2600CT

Tunable 
Laser 
Source

IQS-5150

Polarization 
State 
Adjuster

IQS-9401

Wavelength Reference 
Module

Device 
Under Test

Power Reference

ORL

Wavelength 
Reference

IQS-1643T
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Introducing the IQS-12004B DWDM Passive Component Test System
Testing Many Devices with the MultiPath Testing Option
Testing Many Devices with the MultiPath 
Testing Option 

With the MultiPath Testing Option, you will be able to use the standard 
IQS-12004B DWDM Passive Component Test System along with an optical 
switch to perform tests on one or many DUTs with a variable number of In 
ports and Out ports.The MultiPath Testing Option provides:

A LabVIEW application that can be either used as is to perform 
references, calibrations and tests, or can be tailored to your needs.

COM objects offering all the necessary properties and methods to build 
your own multipath software.

The MultiPath Testing Option can be used for:

Environmental testing of DWDM passive components.

Testing arrayed components like variable optical attenuators (VOAs).

Testing multiplexers (IL, ORL, PDL, directivity).

Testing optical cross-connections (OXC) and other switches.
DWDM Passive Component Test System 5



Introducing the IQS-12004B DWDM Passive Component Test System
Hardware Components Description
Hardware Components Description

Module Usage

IQS-510P Controller Unit Controls the measurement process as well as data 
interpretation and storage. The controller unit is supplied 
with the necessary equipment for connection to a local 
area network (LAN). For more information, refer to the 
IQS-500 Intelligent Test System user guide.

IQS-510E Expansion Units Houses the instruments required by the system. If 
necessary, a maximum of nine expansion units may be 
connected to the controller unit. For more information, 
refer to the IQS-500 Intelligent Test System user guide.

IQS-2600B or IQS-2600CT 
Tunable Laser Source

For more information, refer to the IQ-2600 user guide or 
IQS-2600B Tunable Laser Source user guide.

IQS-1643 Power Meter Allows DWDM filters and multiplexers characterization. 
For more information, refer to the IQS-1600 High-Speed 
Power Meter user guide.

IQS-5150 Polarization State 
Adjuster (optional)

Allows PDL measurements. 

GPIB-controlled switch 
(optional)

Allows to use the MultiPath Testing Option to perform 
tests on one or many DUTs with a variable number of In 
ports and Out ports.
6 IQS-12004B



Introducing the IQS-12004B DWDM Passive Component Test System
Tunable Laser Source
Tunable Laser Source
EXFO has modified its IQS-2600B Tunable Laser Source in order to 
integrate it into the IQS-12004B DWDM Passive Component Test System. To 
optimize the performance of the system, the optical attenuator which 
ensures a constant power output from the tunable laser source has been 
removed. 

You can easily identify which tunable laser source you have. The unit 
designed for the DWDM Passive Component Test System bears the 
mention 2600CT, while the standalone unit bears the mention 2600B.

Every customer purchasing the IQS-12004B DWDM Passive Component 
Test System for applications covering both the C- and L-bands will receive 
an IQS-2600CT model. Even though the tunable laser source has been 
modified, it can still be used as a standalone instrument using an IQS-500 
Intelligent Test System.

However, you will notice a warning message when turning the instrument 
on. This warning informs you that the automatic level control (ALC) is 
disabled. Also note that the power stability and repeatability values 
presented in the IQS-2600B specification sheet do not apply to the 
IQS-2600CT.

Any other functionality or specification, particularly those concerning the 
accuracy of the instrument and wavelength stability, will not be affected by 
this design change.
DWDM Passive Component Test System 7



Introducing the IQS-12004B DWDM Passive Component Test System
Module Description
Module Description
This section describes the IQS-9401 Wavelength Reference Module and the 
IQS-5150 Polarization State Adjuster. For a description of the other modules 
used in the DWDM Passive Component Test System, refer to the modules’ 
user guides.

IMPORTANT
In order to keep the optical ports clean, the protective caps should 
always be installed when the module is not being used.

Input port,
UPC connector

Output port, 
UPC connector

LED push button

lights up when the
controller unit is

turned on

IQS-5150

OUT

IN

Polarization State Adjuster

Retaining screw knob
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Introducing the IQS-12004B DWDM Passive Component Test System
Testing Procedure
Testing Procedure
The IQS-12004B DWDM Passive Component Test System prompts the 
operator to perform a series of steps, after which it controls the different 
IQS modules to perform measurements on a device under test (DUT).

The testing procedure used by the system is outlined below.

You can configure different test parameters in the Setup step.

System calibration is performed the first time the system is used. It can 
also be performed as needed. Calibration comprises three elements: 
detector null measurement of power meters and the WRM, 
wavelength response calibration, and return loss calibration.

IL/PDL and ORL reference measurements are required each time the 
system is turned on and are recommended whenever there is a 
significant change in environmental conditions.

The measurement scan(s) is performed. The insertion loss (IL) 
measurement requires one scan, the IL/PDL measurement requires 
four scans, and the ORL measurement requires one scan. 

At the end of the scan(s), the results are calculated and analyzed. You 
can view the results and print reports as required. 
DWDM Passive Component Test System 9



Introducing the IQS-12004B DWDM Passive Component Test System
Testing Procedure
Once a supervisor has configured the IQS-12004B DWDM Passive 
Component Test System, a typical test sequence would be similar to the 
flow chart shown below.

Connect DUT

Measure

View results

Print report

Select DUT

Test another component

Open database

Perform a reference
10 IQS-12004B



Introducing the IQS-12004B DWDM Passive Component Test System
Database Structure
Database Structure
The IQS-12004B DWDM Passive Component Test System uses several 
different databases for storing test results and configuration information. 
You have full control over the results database file name and location. The 
database structure is organized as shown below.

To save test results for later analysis, the IQS-12004B DWDM Passive 
Component Test System uses three databases:

Customer.MDB: This database contains information about your 
customers. It is managed internally by the system.

DUTPort.MDB: This database contains Pass/Fail information about the 
devices that you want to test. It is managed internally by the system.

ResultsN.MDB: This database contains test results. You can create as 
many files as you want. For example, it might be practical to have 
different files for different customers, components, or test sessions. 
Basically, the system has built-in flexibility to let you choose the best 
way of saving test results.

ResultsN.MDB

Customer.MDB
Results1.MDB

Results2.MDB

Results3.MDB

DUTPort.MDB
Scan data files

Scan data files

Scan data files

Scan data files
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Introducing the IQS-12004B DWDM Passive Component Test System
Using GPIB or COM to Control the System
The IQS-12004B DWDM Passive Component Test System also uses scan 
data files. These files are the test results data files containing the IL vs. λ, 
PDL vs. λ, and ORL vs. λ data. These files are created and managed by the 
DWDM Passive Component Test System. They are saved only if Save 
Results Curves is selected in the System Settings window.

When you create a new database in the system, you are creating only a 
new ResultsN database. The customer and DUT information that you 
previously entered in the first two databases (Customer and DUTPort) will 
be available for the new ResultsN database.

If you need information or details about the database structure, please 
contact EXFO (see Contacting the Technical Support Group on page 223).

Using GPIB or COM to Control the System
The IQS-12004B DWDM Passive Component Test System gives you the 
opportunity to develop your own applications using either SCPI commands 
(GPIB control) or COM objects. 

The MultiPath Testing Option allows you to develop your tailored 
applications using COM objects.

In order to be able to take IL, ORL, and PDL measurements with the 
standard DWDM Passive Component Test System or the MultiPath Testing 
Option, there are a number of required steps and procedures to follow.
12 IQS-12004B



Introducing the IQS-12004B DWDM Passive Component Test System
Using GPIB or COM to Control the System
A typical test sequence would be similar to the flow chart below. 

Each time a new test sequence is started, the above steps are required or 
highly recommended. In some cases, the system will generate error 
messages where the prerequisite steps have not been performed.

Calibrate system
IL/PDL
ORL

Reference system
IL/PDL
ORL

Test DUT

Optimize power

Initialize hardware

Null power meter

Select input port

Measure/analyze

Retrieve data

C
yc

lin
g 

us
in

g 
th

e 
sw

it
ch

Test DUT

Retrieve results

Standard IQS-12004B 
DWDM Passive 
Component Test System 
(one DUT at a time)

MultiPath Testing 
option (possibility of 
several DUTs at a time)
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Introducing the IQS-12004B DWDM Passive Component Test System
Conventions
Conventions
Before using the product described in this manual, you should understand 
the following conventions:

WARNING
Indicates a potentially hazardous situation which, if not avoided, 
could result in death or serious injury. Do not proceed unless you 
understand and meet the required conditions.

CAUTION
Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury. Do not proceed unless you 
understand and meet the required conditions.

CAUTION
Indicates a potentially hazardous situation which, if not avoided, 
may result in component damage. Do not proceed unless you 
understand and meet the required conditions.

IMPORTANT
Refers to information about this product you should not overlook.
14 IQS-12004B



2 Safety Information

Laser Safety Information

Safety Information 
Your instrument is a Class 1 laser product in compliance with standards 
IEC 60825-1 Amendment 2: 2001 and 21 CFR 1040.10. Laser radiation may 
be encountered at the output port.

The following label indicates that a product contains a Class 1 source:

Note: Label shown for information purposes only. It is not affixed to your product.

The DWDM Passive Component Test System may be equipped with the 
IQS-2600B or the IQS-2600CT tunable laser sources. For more information 
on these modules, refer to the IQS-2600B Tunable Laser Source user guide.

WARNING
Do not install or terminate fibers while a light source is active. 
Never look directly into a live fiber and ensure that your eyes are 
protected at all times.

WARNING
Use of controls, adjustments and procedures for operation and 
maintenance other than those specified herein may result in 
hazardous radiation exposure.

CLASS 1
LASER PRODUCT
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3 Getting Started with Your 
DWDM Passive Component 
Test System

This chapter contains a description of hardware components and modules 
used in the system, information on how to install hardware components 
and how to install and start the IQS-12004B DWDM Passive Component 
Test System software. You will also find a description of the utility to 
organize test files as well as a description of the application main window. 

Inserting and Removing Test Modules 

To insert a module into the controller or expansion unit:

1. Exit IQS Manager and turn off all your units.

2. Remove the protective cover from the desired unused module slot.

2a. Pull the retaining screw knob firmly towards you and release the 
bottom of the cover.

2b. Gently pull the top of the protective cover downwards, to remove 
it from the unit grooves.

CAUTION
Never insert or remove a module while the controller unit and its 
expansion units are turned on. This will result in immediate and 
irreparable damage to both the module and unit.
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Getting Started with Your DWDM Passive Component Test System
Inserting and Removing Test Modules
3. Position the module so that its front panel is facing you and the top and 
bottom protruding edges are to your right.

4. Insert the protruding edges of the module into the grooves of the unit’s 
module slot.

Retaining screw
knob

Protective cover
2b

2a

Retaining screw

Retaining screw knob

Protruding edges 
(right side of module)

5
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Getting Started with Your DWDM Passive Component Test System
Inserting and Removing Test Modules
5. Push the module all the way to the back of the slot, until the retaining 
screw makes contact with the unit casing.

6. While applying slight pressure to the module, turn the retaining screw 
knob (located at the bottom of the panel) clockwise until the knob is 
horizontal. This will secure the module into its “seated” position.

The module is correctly inserted when its front panel is flush with the front 
panel of the controller or expansion unit.

When you turn on the controller unit, the startup sequence will 
automatically detect your module.

Note: You can insert IQ modules into your controller or expansion unit; the IQS 
Manager software will recognize them. However, the IQS-500 locking 
mechanism (retaining screw) will not work for IQ modules.

To remove a module from your controller or expansion unit:

1. While pulling gently on the knob, turn it counterclockwise until it stops.

The module will slowly be released from the slot.

6
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Getting Started with Your DWDM Passive Component Test System
Inserting and Removing Test Modules
2. Place your fingers underneath the module or hold it by the retaining 
screw knob (NOT by the connector) and pull it out.

Retaining screw knob

YES

NO

Retaining screw
knob

Connector
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Getting Started with Your DWDM Passive Component Test System
Inserting and Removing Test Modules
3. Cover empty slots with the supplied protective covers. Simply slide the 
top of the protective cover into the upper grooves of the unit, and then 
snap into place by pushing the retaining screw knob.

CAUTION
Pulling out a module by a connector could seriously damage both 
the module and connector. Always pull out a module by the 
retaining screw knob.

CAUTION
Failure to reinstall protective covers over empty slots will result in 
ventilation problems.
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Getting Started with Your DWDM Passive Component Test System
Installing Hardware Components
Installing Hardware Components
The DWDM Passive Component Test System has been configured and 
tested at the factory, under normal conditions, and installed by an EXFO 
authorized installation engineer. The following information is provided in 
the event that it is necessary to move, transport, or reinstall the system.

Controller and Expansion Units

Please refer to the IQS-500 Intelligent Test System user guide for detailed 
information about installing and connecting the controller and expansion 
unit(s).

Source, Wavelength Reference, and PSA

The source (IQS-2600B or IQS-2600CT), the wavelength reference module 
(IQS-9401), and the optional polarization state adjuster (IQS-5150) must be 
installed in the same expansion unit and in a specific order.

The recommended configurations are presented hereafter.

CAUTION
Never insert or remove a module while the controller or expansion 
unit is turned on. This will result in immediate and irreparable 
damage to both the module and unit.
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Getting Started with Your DWDM Passive Component Test System
Installing Hardware Components
Configuration with PDL

Connect the tunable output of the IQS-2600B/IQS-2600CT to the input of the 
IQS-5150 using the rigid patchcord supplied with the 
IQS-2600B/IQS-2600CT. Connect the output of the IQS-5150 to the input of 
the IQS-9401, as illustrated below.

Connect the launch fiber to the output of the IQS-9401. 

Note: The IQS-9401 has an angled (APC) output connector.

IQS-2600CT

ACTIVE

OUTPUT

MONITOR
OUTPUT

TRIG IN

TRIG OUT

Tunable Laser Source
IQS-5150

OUT

IN

Polarization State Adjuster
IQS-9401

OUT

IN

Wavelength Reference Module

Sync
Out
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Getting Started with Your DWDM Passive Component Test System
Installing Hardware Components
Configuration without PDL

Connect the tunable output of the IQS-2600B/IQS-2600CT to the input of the 
IQS-9401 using the rigid patchcord supplied with the tunable source, as 
illustrated below.

Connect the launch fiber to the output of the IQS-9401.

Note: The IQS-9401 has an angled (APC) output connector.

IQS-2600CT

ACTIVE

OUTPUT

MONITOR
OUTPUT

TRIG IN

TRIG OUT

Tunable Laser Source
IQS-9401

OUT

IN

Wavelength Reference Module

Sync
Out
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Getting Started with Your DWDM Passive Component Test System
Installing Hardware Components
Configuration of Power Meters

The IQS-1643T power meters must be installed sequentially in the unit. Use 
the short synchronization cables to connect power meters in the same 
unit, and the long synchronization cables to connect power meters in 
different units. It is also necessary to install a synchronization cable 
between the IQS-9401 and the first power meter, as illustrated below.

IMPORTANT
The power meters must be correctly installed and configured before 
starting IQS Manager or before turning the unit on. If modules need 
to be repositioned, you will have to restart the system.

IMPORTANT
To keep the optical ports clean, ensure that protective caps are 
always installed when the module is not being used.

SYNC OUT SYNC IN

IQS-2600CT

ACTIVE

OUTPUT

MONITOR
OUTPUT

TRIG IN

TRIG OUT

Tunable Laser Source
IQS-5150

OUT

IN

Polarization State Adjuster
IQS-9401

OUT

IN

Wavelength Reference Module

Sync
Out

C1

C2

C3

EXFO

NT
T-F

C

Sync

Sync In

4-Ch Power Meter
IQS-1600T

C4

Out

Trig

C1

C2

C3

EXFO

NT
T-F

C

Sync

Sync In

4-Ch Power Meter
IQS-1600T

C4

Out

Trig

C1

C2

C3

EXFO

NT
T-F

C

Sync

Sync In

4-Ch Power Meter
IQS-1600T

C4

Out

Trig

C1

C2

C3

EXFO

NT
T-F

C

Sync

Sync In

4-Ch Power Meter
IQS-1600T

C4

Out

Trig
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Getting Started with Your DWDM Passive Component Test System
Installing Hardware Components
To work with the MultiPath Testing Option, you will have to add a switch to 
your standard IQS-12004B DWDM Passive Component Test System to 
benefit from its inherent features.

The minimum hardware components required for multipath testing are:

Tunable laser source (IQS-2600B or IQS-2600CT).

Wavelength reference module (IQS-9401).

Power meter (IQS-1643T), one or more.

Switch (either the IQS-9100, or a GPIB-controlled switch. Check with 
EXFO to see if a specific model is supported.).

Regardless of whether you will be using an EXFO switch or any of the 
supported switches, the connection of the switch in the system will remain 
the same.

The switch has to be connected to the Wavelength Reference Module () 
and to the power meters. Use the supplied  to link the Out port of the WRM 
to the common port of the switch. Connect the DUT(s) between the power 
meter and the switch.

CAUTION
Never insert or remove a module while the controller or expansion 
unit is turned on. This will result in immediate and irreparable 
damage to both the module and unit.
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Getting Started with Your DWDM Passive Component Test System
Installing Hardware Components
 To work in high-power mode, you will have to add a switch and an EDFA 
to your standard IQS-12004B DWDM Passive Component Test System. 

The minimum hardware components required for multipath testing in high 
mode are:

Tunable laser source (IQS-2600B or IQS-2600CT).

Wavelength reference module (IQS-9401).

Power meter (IQS-1643T), one or more.

The KPS-AMP-C-20 fiber amplifier (EDFA).

A high-power GPIB-controlled switch.

IMPORTANT
In order to be able to control the EDFA, the GPIB address of the 
EDFA must be smaller than the GPIB address used for the switch.

CAUTION
Never insert or remove a module while the controller or expansion 
unit is turned on. This will result in immediate and irreparable 
damage to both the module and unit.
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Getting Started with Your DWDM Passive Component Test System
Installing the IQS-12004B DWDM Passive Component Test System Software
Installing the IQS-12004B DWDM Passive 
Component Test System Software

For the DWDM Passive Component Test System to function properly, the 
IQS Manager software must be installed on your IQS-500 Intelligent Test 
System.

Normally, you wouldn’t have to install the IQS Manager software or the 
DWDM Passive Component Test System software, except in particular 
circumstances (such as after having reinstalled Microsoft Windows). 

For information on installing IQS Manager software, refer to the IQS-500 
Intelligent Test System user guide.

To install the DWDM Passive Component Test System on an 
IQS-500 controller unit:

1. Insert CD of the DWDM Passive Component Test System in the CD-ROM 
drive.

2. Select Run from the Windows Start menu.

3. Type F:\ setup.exe in the Open text field.

4. Click OK to start the wizard and follow the on-screen instructions.
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Getting Started with Your DWDM Passive Component Test System
Installing the MultiPath Testing Option Software
Installing the MultiPath Testing Option 
Software

Before installing the MultiPath Testing Option software, ensure that the 
IQS-12004B DWDM Passive Component Test System software has been 
installed on the IQS-500 controller unit. For more information, see Installing 
the IQS-12004B DWDM Passive Component Test System Software on 
page 28.

To install the MultiPath Testing software on an IQS-500 controller 
unit:

1. Insert the MultiPath Testing software CD-ROM in the drive.

2. Select Run from the Windows Start menu. The Run window appears.

3. Use the Browse button to find the setup.exe file on the CD-ROM.

4. Click OK to start the installation.

EXFO recommends that you keep the default names and paths suggested 
by the setup program.

Follow the on-screen instructions. Once the LabVIEW demo is installed, 
the installation of the files required to run LabVIEW will begin. 
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Getting Started with Your DWDM Passive Component Test System
Installing the MultiPath Testing Option Software
If the following dialog box appears, that means that LabVIEW has been 
installed in a previous session.

If this is the case, choose Modify, click Next and follow the on-screen 
instructions.

For information on how to use the MultiPath Testing Option application, see 
Testing Multiple DUTs with the LabVIEW Application on page 117.

IMPORTANT
Selecting an option other than Modify may prevent the MultiPath 
Testing Option software from working properly.
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Getting Started with Your DWDM Passive Component Test System
Starting and Exiting the DWDM Passive Component Test System Application
Starting and Exiting the DWDM Passive 
Component Test System Application

To start the DWDM Passive Component Test System application:

On the Windows taskbar, click Start, select Programs > EXFO > 
IQS-12004B > IQS-12004B DWDM Test System.

OR

Double-click the IQS-12004B DWDM Test System desktop icon.

To exit the DWDM Passive Component Test System application:

Select Exit from the File menu.

At the starting of the application, a message may appear, indicating that the 
regional settings of your system were temporary changed. This change 
consists in using a period for the decimal symbol and using the 
YYYY-MM-DD date style.
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Getting Started with Your DWDM Passive Component Test System
Starting and Exiting the DWDM Passive Component Test System Application
By default, the Welcome/New Test window appears first when you start the 
DWDM Passive Component Test System (see Opening a New Test 
Database on page 61).

The Welcome/New Test window gives you the possibility to open a new 
test database, to open an existing test database, or to view the content of 
recent test databases. 
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Getting Started with Your DWDM Passive Component Test System
Starting and Exiting the DWDM Passive Component Test System Application
Clicking Cancel takes you to the application main window, as shown on 
the figure below.

The DWDM Passive Component Test System main window is the central 
location from where you access all functionalities.

Title bar

Menu bar

Function 
buttons

Position of 
modules in 
IQS unit

Status bar

Details the procedure 
in progress
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Getting Started with Your DWDM Passive Component Test System
Accessing a Specific Test Step
Accessing a Specific Test Step
During the step-by-step procedure, it is possible to access the Test Steps 
dialog box to manually go to a specific step via the Step button from the 
main window.

To proceed with
the current step

To skip the
current step
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Getting Started with Your DWDM Passive Component Test System
Starting and Exiting the MultiPath Testing Option Application
Starting and Exiting the MultiPath Testing 
Option Application

You may want to use the provided LabVIEW application to work with the 
MultiPath Testing option .

To start the LabVIEW application:

On the Windows taskbar, click Start, select Programs > EXFO > 
IQS-12004B > IQS-12004B Multi Path DWDM Test System.

OR 

Double-click the IQS-12004B MPT desktop icon.

The application main window is displayed.

To close the application, select Exit from the File menu.
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4 Setting Up the DWDM Passive 
Component Test System

The DWDM Passive Component Test System has been designed to let you 
define DUTs and optical ports that can be used for future tests. 

Configuring DUT Parameters for Pass/Fail 
Analysis

Note: You must be working at the Supervisor level to access this window.

The DUT Configuration window allows you to define specific parameters 
for the optical ports and DUTs you will be testing. Information entered in 
this window is used to construct and maintain two internal lists: one for 
port types and one for DUTs. These two lists provide an efficient way of 
identifying the Pass/Fail limits for all your commonly tested components.

The relationship between optical ports and DUTs is illustrated below. In this 
example, the DUT is a four-channel device with one common port and four 
output ports.

To identify the Pass/Fail criteria for this type of component, you must define 
the different parameters (IL, PDL, BW, etc.) for each port. In most cases, 
the characteristics for all ports will be identical, except for the wavelength.

The most efficient way of describing the above device would be to create a 
port (200 GHz bandpass) and define all its Pass/Fail criteria. When you 
define the DUT, you simply have to select a port type for each output and 
assign a wavelength to the port mask. This 200 GHz bandpass port will also 
be used for defining other devices. There is no practical limit to the number 
of different ports or DUTs that can be defined.

1x4 Demultiplexer 
(DUT)

Port 1 (200 GHz bandpass)

Port 2 (200 GHz bandpass)

Port 3 (200 GHz bandpass)

Port 4 (200 GHz bandpass)
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Setting Up the DWDM Passive Component Test System
Configuring DUT Parameters for Pass/Fail Analysis
This window can be accessed via the Configure DUTs icon from the 
Welcome/New Test window. For information on how to display this 
window, see Opening a New Test Database on page 61.

Optical Ports Configuration: This section contains the list of all 
configured ports. You can add new ports (click Add), modify the port 
indicated in the Port Type list box (click Modify), or delete an existing 
optical port (click Delete).

For information about the configuration of an optical port type, see 
Configuring an Optical Port on page 39.

DUT Configuration: This section allows you to configure DUTs based 
on the optical port types. You can add new DUTs (click Add), modify 
the DUT indicated in the Part Number list box (click Modify), or delete 
an existing DUT (click Delete).

For information about the configuration of a DUT, see Configuring a 
DUT on page 42.
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Setting Up the DWDM Passive Component Test System
Configuring an Optical Port
Configuring an Optical Port

Note: You must be working at the Supervisor level to access this window.

This window can be accessed via the Configure DUTs icon from the 
Welcome/New Test window. For information on how to display this 
window, see Opening a New Test Database on page 61.

When you click Add or Modify in the Optical Ports Configuration section, 
the following window appears where you can enter or modify port 
information. For details about the parameters contained in this window, 
see Definitions and Calculation Methods on page 405.

Note: Some parameters can be disabled (grayed out) when you select a certain 
mask type.

Port Type: Use this text box to give a unique name to the optical port 
defined.

Mask Type: This list box allows you to select one of two different mask 
types (bandpass and notch).
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Setting Up the DWDM Passive Component Test System
Configuring an Optical Port
The Spectral Parameters section is used to specify the limits or the 
acceptable values that will determine the Pass/Fail result of the tests.

BW1, BW2, and BW3: These text boxes allow you to specify the relative 
power levels (in dB) at which bandwidth is tested, and the acceptable 
bandwidth (in nm). Note that only BW2 and BW3 are tested when the 
Defined Bandwidth calculation method is selected.

BWx Tolerance: These text boxes allow you to specify the tolerance 
interval for the bandwidth test. For a DUT to pass this test, the 
measured BWx value must fall within BWx ±BWx tolerance.

Wavelength Tolerance: This text box is used to enter the central 
wavelength tolerance of the specified port. This test is not performed 
when the Defined Bandwidth calculation method is selected.

The Loss Parameters section is used to specify the flatness, crosstalk, 
rejection as well as the IL, ORL and PDL values.

Flatness: This text box is used to enter the acceptable flatness (in dB) 
of the curve in the measured BW1 interval.

Crosstalk: This text box allows you to enter the acceptable channel 
crosstalk (in dB) for the DUT. This option is disabled (grayed out) when 
the notch mask type is selected.

Rejection: This text box allows you to enter the acceptable rejection 
level (in dB) for the DUT. This option is disabled (grayed out) when the 
bandpass mask type is selected.

IL: This field allows you to specify the acceptable insertion loss value 
(dB).

ORL: This field allows you to specify the ORL limit value (dB).

PDL: This field allows you to specify the PDL limit value (dB).
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Setting Up the DWDM Passive Component Test System
Configuring an Optical Port
The Calculation Method Based On section is used to select which 
method will be used to calculate some of the different test results. For 
details about these methods, see Definitions and Calculation Methods on 
page 405.

Measured Bandwidth: This option allows BW1 to be determined from 
the measured data.

Defined Bandwidth: This option allows you to define BW1 yourself. 
When selecting defined bandwidth, you will enter the defined 
bandwidth in the BW1 box. During the data analysis, the software will 
use the CW ±BW1/2 as the analysis range for IL, crosstalk, ripple, etc.
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Configuring a DUT
Configuring a DUT

Note: You must be working at the Supervisor level to access this window.

This window can be accessed via the Configure DUTs icon from the 
Welcome/New Test window. For information on how to display this 
window, see Opening a New Test Database on page 61.

Once the optical ports are correctly defined, you can configure DUTs based 
on these ports. When clicking Add or Modify in the DUT Configuration 
section, the following window appears where you can enter or modify 
information about the DUT.

In the upper section of the DUT Configuration window, you enter 
identification and test parameters. These parameters will automatically be 
selected when performing a scan on a defined device.

Note: Once a device has been created, the Number of Ports cannot be modified.

Part Number: the part number for the DUT.

Description: a short description of the DUT.

Manufacturer: the name of the manufacturer.
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Setting Up the DWDM Passive Component Test System
Configuring a DUT
Analysis from X nm to Y nm: the default range of the analysis. The 
analysis limits can be modified later in the IQS-12004B Setup window.

Number of Ports: the number of ports, excluding the common port.

Port Number: In this list box, you select the port for which you will 
configure the type and central wavelength. You can also use the 
Previous and Next buttons to move from one port to another.

Port Type: In this list box, you select the type of port from the list of 
available ports that you configured previously. Usually for a device, all 
ports are of the same type, but this is not always the case; and the 
software allows you to configure devices with different port types. For 
more information, see Configuring an Optical Port on page 39.

Center Wavelength: You can specify a wavelength yourself (using the 
Specified Wavelength option button), or select one of the ITU 
wavelengths from the list (using the From List option button). The ITU 
wavelength values correspond to the list defined in the Channel List 
dialog. For more information, see Customizing the Channel List on 
page 46.

ORL Analysis: Select this option to perform an ORL analysis.

The PDL Analysis section allows you to select options for PDL testing.

If you intend to export detailed IL results, check the 
Keep IL traces for all states of polarization (4) box.

If you need to get the results from the polarization-dependent 
wavelength analysis, check the 
Polarization Dependent Wavelength box.

Note: These two options can also be selected when you set the test parameters. 
For more information, see Preparing the Test Setup on page 49. If you omit 
to check the boxes, you won’t be able to export the corresponding traces. 
For more information on exporting, see Exporting Data on page 94.

Center Wavelength: The PDL value is taken at the central wavelength 
for each port.
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Setting Up the DWDM Passive Component Test System
Configuring DUT Company/Customer Parameters
Operating Wavelength Range: The highest PDL value in the BW1 
range is taken.

Relative Range (CW)±X nm: allows you to indicate the highest PDL 
value in the relative range ± X  nm.

From X nm to Y nm: allows you to indicate the highest PDL value 
between X nm and Y nm.

Click OK to add the DUT to the list of available components to test.

Configuring DUT Company/Customer 
Parameters

Note: You must be working at the Supervisor level to access this window.

The Company/Customer Configuration window contains identification 
and system information including the name of the company (organization 
performing the tests) and the customer (organization for which the tests 
are performed).

All this information is saved in a database and is useful for documentation 
and traceability purposes.

To access the Company/Customer Configuration window:

From the Configuration menu, select Company/Customer 
Configuration.
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Setting Up the DWDM Passive Component Test System
Configuring DUT Company/Customer Parameters
Company Information: This section indicates the name of the 
company performing the tests. You can modify the information by 
clicking Modify.

Customer List: This section allows you to enter data about the 
different customers. You can add new customers to the database (click 
Add), modify a customer indicated in the list box (click Modify), or 
delete an existing customer (click Delete). When clicking Add or 
Modify, the following window appears where you can enter or modify 
customer information.
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Customizing the Channel List
Customizing the Channel List

Note: You must be working at the Supervisor level to use this feature.

This feature allows you to view and customize the channel list, which 
contains predefined ITU wavelengths. New wavelengths can also be added 
to this list. The DWDM Passive Component Test System displays the 
channel list when a choice of wavelength is required.

The number of digits displayed after the decimal point can be changed to 
better suit your needs.

You can access the Channel List window by selecting Channel List from 
the Options menu.

To modify the number of digits displayed after the decimal point:

Use the Decimal Places box to set the desired value.

Number of digits 
after decimal 
point
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Customizing the Channel List
To modify the ITU channel list display:

1. In the Channel Spacing box, select the space value (in GHz) between 
the channels of the DUT.

2. In the Start Wavelength and End Wavelength boxes, enter the values 
that will determine the wavelength range that will be displayed on the 
list.

3. Confirm your changes with Apply.

To add a new wavelength to the list:

1. Enter the new wavelength in the Wavelength text box. The number of 
decimals depends on the value set in the Decimal Places box.

2. Click Add. Your new channel will be added to the list.
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Customizing the Channel List
To delete wavelengths from the list:

If you want to delete a specific item, click the value you want to remove 
from the wavelength list and click Remove. 

OR

If you want to empty the list, click the Remove All button.

Once you are done with the changes, click OK to validate the new list or on 
Cancel to discard the modifications.
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Preparing the Test Setup
Preparing the Test Setup
Before performing a test, you have to specify the parameters to be used.

The application offers you two types of tests:

Generic: Useful to quickly test a DUT by using the default values 
provided. Some analysis can be done with this option, but no Pass/Fail 
status will be given.

Specified: Useful to perform a test using predefined parameters and 
Pass/Fail limits. When selecting this test, the DUT Identification group 
box is displayed (see Identifying the Current DUT on page 54).

You can specify the values for the scan parameters to be taken into 
account during tests. These values include:

The number of channels to be tested: By default, the application 
displays the total number of available power meter channels. However, 
if you do not intend to work with all of the available channels, EXFO 
recommends that you indicate the actual number of channels you are 
using. This will save some testing time and a lot of disk storage space.

The tested wavelength range (in nm): By default, the application 
displays the full range of the source in use. Changing this to a smaller 
range will save disk storage space and may also reduce testing time.
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Preparing the Test Setup
The scan resolution (in pm): This parameter determines the 
approximate scan resolution. The application will set the appropriate 
source sweep speed and power meter sampling rate.

The application allows you to indicate the test selection:

PDL: calculations, based on the Mueller Matrix four-state method, take 
into account the optical retardation of the polarization state adjuster 
(IQS-5150).

Simplified PDL: faster than standard PDL (calculations do not take into 
account the optical retardation of the polarization state adjuster), but 
adds an uncertainty of about 5 % of the DUT PDL.

ORL.

You can specify the IL analysis parameters, the PDL analysis parameters 
and whether the system must perform a continuous scan or not.

The DWDM Passive Component Test System performs PDL measurements 
as function of wavelength. It can also keep intermediate traces for export 
purposes.

The result table will be adjusted according to the options specified in the 
PDL Analysis group box.

In addition to standard IL results (DUT IL average values), you may 
need to get IL results obtained at the four states of polarization.

You may also need to get traces from the PDW analysis. The PDW 
analysis is made using proprietary algorithms (patent pending) and is 
based on calculations using the Mueller Matrix coefficients. Using data 
from the four scans performed for the PDL measurement, the DWDM 
Passive Component Test System analysis software internally calculates 
the transmission response for many states of polarization and 
generates the insertion loss curves for the extreme values.

Note: The test setup step is only available when you have already created a test.
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To set the test parameters:

1. Ensure that the IQS-12004B Setup window is open. For more 
information on selecting a step, see Accessing a Specific Test Step on 
page 34.

2. From the Test Type group box, select Generic or Specified test.

3. From the Scan Parameters group box, specify the required 
parameters.

3a. Indicate the number of power meter channels to use by typing the 
value in the Channel(s) entry box.

3b. Specify the wavelength range (in nanometers) that will be used 
for the analysis in the Analysis from X nm to Y nm entry boxes.

Note: Setting a smaller scan range will reduce the database size, the time 
required for the analysis and for the scan.

3c. Select the scan resolution value (in picometers) from the 
Resolution list.

Note: Resolution cannot be set to 5 pm when using the IQS-2600B source.

IMPORTANT
When testing “specified” devices, changing the wavelength range 
parameter will override the parameter stored in the DUT database.
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4. If you need the DWDM Passive Component Test System to perform 
successive scans, 

4a. Check the box from the Continuous Scan group box. 

4b. Enter the number of scans you want to perform in the 
corresponding text field.

5. From the Test Selection group box, check the PDL, Simplified PDL 
and/or ORL boxes according to the measurements you want to 
perform.

6. From the IL Analysis group box, specify the relative power levels (in 
dB) at which the bandwidth is calculated (for notch and bandpass 
filters).
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7. From the PDL Analysis group box, specify the required parameters.

For more information on the various parameters, see Configuring a 
DUT on page 42.

Note: If you omit to check the Keep IL traces for all states of polarization (4) 
box, you won’t be able to export these traces. For more information on 
exporting, see Exporting Data on page 94.

Note: If you omit to check the Polarization Dependent Wavelength box, you 
won’t be able to export these traces. For more information on exporting, see 
Exporting Data on page 94.

8. If you selected Specified for the test type, the DUT Identification group 
box is displayed. Use this section to select and identify the device that 
will be tested. For more information, see Identifying the Current DUT 
on page 54.

Note: At start-up, your access level is activated by default. For more information 
about access levels, see Working with Access Levels on page 59.
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Identifying the Current DUT 
The DUT Identification is used to select and identify the device that will be 
tested next. The DUT Identification group box is accessible from the 
IQS-12004B Setup window and by selecting the Specified test type.

Part Number: This list box is used to select the part number of the DUT. 
The available DUTs were previously created in the DUT Configuration 
window. For information on DUT creation, see Configuring a DUT on 
page 42.

Description: This text box shows the short description of the DUT 
corresponding to the selected part number.

Customer: This list box is used to select the name of the customer 
associated with the current DUT. For information on modifying the list 
of customers, see Configuring DUT Company/Customer Parameters on 
page 44.

Tested by: This text field allows you to identify the name of the person 
doing the current test.

Serial Number: This text field is used to identify the DUT with a serial 
number. The serial number is mandatory.

Batch: This text field allows you to specify a batch number.
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Two buttons are available on the right side of the window to enter and view 
additional information about the DUT.

Show Limits: This button will open the Optical Port Limits window 
(see figure below), where you can see different limits of the current 
DUT. These parameters were set in Supervisor level on the DUT 
Configuration window. For more details, see Definitions and 
Calculation Methods on page 405 or Configuring DUT Parameters for 
Pass/Fail Analysis on page 37.

Additional Comments: This button will open a text window, where 
you can enter additional comments about the current DUT.
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Modifying System Settings

Note: You must be working at the Supervisor level to use this feature.

The System Settings window allows you to define two saving options, set 
filtering options, and select a new database folder. To access this window, 
from the main window menu, select Options > Supervisor Options > 
System Settings. 

Save Raw Data: This is a troubleshooting tool that allows EXFO 
technical support to troubleshoot data analysis problem. This option is 
normally not selected as it uses a large storage space.

Save Results Curves (IL, PDL, ORL): This option is selected by 
default. If not selected, you will only be able to see the results table 
(not the trace) and the trace data will not be saved.
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Enable Auto-Range Filtering: This option is selected by default. When 
selected, the software signal processing identifies and filters out any 
invalid datapoints that sometimes occur at power meter autoranging 
scale changes. 

When not selected, no post process filtering is applied. A small 
improvement in testing time will be observed. When the filtering is not 
applied, data spikes between 0 and 0.030 dB may be observed at some 
scale changes. 

Use Simplified Method: This option is selected by default. It indicates 
that the PDL simplified method will be used for each test. Simplified 
PDL is faster than “standard” PDL (calculations do not take into 
account the optical retardation of the polarization state adjuster), but 
adds an uncertainty of about 5 % of the DUT PDL.

Folders: This feature allows you to specify paths for the different 
databases. 
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5 Operating the DWDM Passive 
Component Test System
Working with Access Levels

The IQS-12004B DWDM Passive Component Test System comprises two 
levels of operation: User and Supervisor. The level at which the application 
is working is shown in the title bar.

Note: When starting the application, the User level is always the default level of 
operation, even if you last exited the application at the Supervisor level.

User Level

At the User level, you can perform complete tests on passive components 
and create new database files. However, certain functions are disabled.

To switch from Supervisor level to User level, select Level of Operation, 
then User, from the Options menu. A check mark will appear in the menu.

Supervisor Level

The Supervisor level gives you access to all DWDM Passive Component 
Test System functions. As a Supervisor you can:

Configure the DUTs. For details about this feature, see Configuring DUT 
Parameters for Pass/Fail Analysis on page 37.

Modify system settings. For details about this feature, see Modifying 
System Settings on page 56.

Modify ITU channel list. For details about this feature, see Customizing 
the Channel List on page 46.

To switch from User level to Supervisor level:

1. From the main widow menu, select Options >Level of Operation > 
Supervisor.

2. Enter the requested password. The default password is VISUALIQ.
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It is also possible to directly log on at the Supervisor level when creating a 
new test database. 

To log on at the Supervisor level:

1. From the Welcome/New Test window, check the Supervisor box.

2. Press the Password button. The Supervisor Level window is 
displayed.

3. Type your password and press OK.

You can later change your password in the Options menu. For details, see 
Changing Supervisor Password on page 60.

Changing Supervisor Password

To change the password once you are at the Supervisor level:

1. From the main window menu, select Options > 
Supervisor Options> Change Password. The following window 
appears:

2. Enter the old password and then enter the new password twice.

Note: Passwords must be between six and ten characters long.

3. Click OK to save the new password.

IMPORTANT
Under Windows 2000, you must have Administrator rights to 
modify the supervisor password.
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Opening a New Test Database

To open a new test database:

1. From the Welcome/New Test window, select the New Test tab. 

IMPORTANT
To help you copy and move the database and also prevent data 
corruption, save your tests in several databases and keep the results 
database to a manageable size. 
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2. Select the icon for the type of test you want to perform: 

IL measures the insertion loss.

IL+ORL measures both the insertion loss and the optical 
return loss.

IL+PDL measures both the insertion loss and the 
polarization-dependent loss.

IL+ORL+PDL measures the insertion loss, the optical return loss, 
and the polarization-dependent loss in the same test.

Configure DUTs allows you to configure the optical ports and the 
DUT (see Configuring an Optical Port on page 39 and Configuring a 
DUT on page 42). This option is enabled only if you have selected 
the Supervisor level of operation and provided a valid password.

You can later change the types of test you want to perform in the Setup 
window, under Test Selection. 

Note: Certain tests may not be available if the required modules are not present. 
If this is the case, the icons will be grayed out.

3. If you want to work at the Supervisor level, enter a password in the 
Supervisor box. For more information, see Working with Access Levels 
on page 59. As a supervisor, you can modify system settings (see 
Modifying System Settings on page 56).
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4. Press New. The Open New window is displayed. 

Give a name to the new database and click Open. The database opens 
and you are brought to the IQS-12004B Setup window.

Note: To proceed directly, you can double-click the icon for the type of test you 
want to perform. You can also access this function by selecting New 
Database from the File menu. 

If new hardware components were installed on the system, message 
windows will appear indicating that a new system calibration and a new 
ORL calibration will have to be performed. For details, see Calibrating the 
System on page 73.

Database files can be stored in any directory, either on a local drive or 
network drive. The database files must have the .MDB extension, which 
is the standard Microsoft Access database file format.

IMPORTANT
If you use the name of an already-existing test for a new database, 
the data related to this test will be lost (the file will be overwritten). 
If you want the new data to be appended to the existing database, 
see Opening an Existing Test Database on page 64.

IMPORTANT
It is important to wait 30 minutes for the system to warm up. If this 
warmup period is not respected, results may be inaccurate.
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Opening an Existing Test Database

To open an existing test database file with already defined 
settings:

1. From the Welcome/New Test window, select Open Existing Test. 

2. Select the database you want to use. If the database does not appear in 
the list, click More Files to find the desired database file.

3. Click Open. The database opens and you are brought to the  
IQS-12004B Setup window. 

Note: You can double-click the test database file to proceed directly. You can also 
access this function by selecting Open Database from the File menu. 

IMPORTANT
The new data will be appended to the existing database. If you only 
want to view the results of an already-existent database, see 
Opening an Existing Test Database on page 64.
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Viewing a Recent Test
To view a recent test database file:

1. From the Welcome/New Test window, select View Recent Test.

2. Select the database that you want to consult. The default folder is 
IQS\MAESTRO\IQS_DWDMTS\Userfile. If the desired database does not 
appear in the list, click More Files to find it.

3. click View. The database opens and you are brought to the 
IQS-12004B Database Browser window, which contains information 
about previous tests (see Using the Database Browser on page 109).

Note: You can double-click the database file to proceed directly. You can also 
access this function by selecting View Database from the File menu. 

Hiding the Welcome/New Test Window
You can deactivate the automatic display of the Welcome/New Test 
window by checking the Don’t show this dialog in the future box. When 
this option is selected, you will be brought directly to the DWDM Passive 
Component Test System main window. This option can be disabled in the 
System Settings window (see Modifying System Settings on page 56).
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Cleaning and Connecting Optical Fibers

To connect the fiber-optic cable to the port:

1. Clean the fiber ends as follows:

1a. Gently wipe the fiber end with a lint-free swab dipped in isopropyl 
alcohol.

1b. Use compressed air to dry completely.

1c. Visually inspect the fiber end to ensure its cleanliness.

2. Carefully align the connector and port to prevent the fiber end from 
touching the outside of the port or rubbing against other surfaces.

If your connector features a key, ensure that it is fully fitted into the 
port’s corresponding notch.

3. Push the connector in so that the fiber-optic cable is firmly in place, 
thus ensuring adequate contact.

If your connector features a screwsleeve, tighten the connector 
enough to firmly maintain the fiber in place. Do not overtighten, as this 
will damage the fiber and the port.

Note: If your fiber-optic cable is not properly aligned and/or connected, you will 
notice heavy loss and reflection.

IMPORTANT
To ensure maximum power and to avoid erroneous readings:

Always clean fiber ends as explained below before inserting 
them into the port. EXFO is not responsible for damage or 
errors caused by bad fiber cleaning or handling.

Ensure that your patchcord has appropriate connectors. Joining 
mismatched connectors will damage the ferrules.
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Connecting DUT and Modules
Once the reference measurements have been completed, you need to 
connect the DUT to the launch fiber and to the power meters. Normally, 
the application brings you to this step automatically. If necessary, you can 
go directly to the DUT Connection step. For information on accessing a 
step, see Accessing a Specific Test Step on page 34.

For information on reference measurements, see Calibrating the System 
on page 73 and Performing Reference Measurements on page 82.

Connect the DUT input port to the start fiber and the DUT output ports to 
the power meters, as indicated on the screen.

WARNING
Never stare into the beam or view directly with optical instruments. 
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You can click List or press F12 to see a detailed list of required connections 
(as shown below). This list shows you which DUT output port must be 
connected to which port on the power meters. Basically, channel 1 of the 
device is connected to channel 1 of the first power meter, channel 2 to the 
second channel of the first power meter, and so on.

Once all connections have been made, click OK to start the measurement. 
The system will sweep the source, transfer the data, and analyze the results 
in accordance with the parameters selected in the Setup window.

IMPORTANT
Before running any test, ensure that all the connectors and 
fiber-optic adapters (FOAs) to be used are clean, and that all 
fiber-optic light source warmup periods have been respected.
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Starting the ORL Measurement Scan
Once the reference measurement is complete and if the ORL 
measurement has been selected, you will be prompted to prepare for the 
ORL measurement. 

If the device you are testing is not terminated with low-reflection APC 
connectors, you will have to provide some sort of temporary low-reflection 
termination. One method is to mandrel wrap the output fibers (see figure 
below). Another option would be to use an index matching material.

Once all connections and preparations have been made, click OK in the 
main window to activate the software and start the ORL measurement 
scan.

Note: You can abort the ORL measurement scan at any time by clicking the Stop 
button or pressing F2.

Once the measurement is done, you are brought directly to the next step.
DWDM Passive Component Test System 69



Operating the DWDM Passive Component Test System
Testing Another Component
Testing Another Component
When a test is complete, you have the possibility to begin a new test. Click 
OK. This will bring you back to the IQS-12004B Setup window. Restart the 
procedure with new parameters, as explained in Preparing the Test Setup 
on page 49.

Sharing the Power Meters and WRM with an 
External Application

You can use the power meters and the Wavelength Reference Meter with 
an external application without exiting the system application. You can also 
set the source to a specific wavelength and modify the polarization state of 
the IQS-5150 Polarization State Adjuster.

Note: This feature is only available after a power optimization is performed (i.e., 
after a reference or calibration.) Otherwise, the option will be grayed out.

To use the power meters and WRM with an external application:

1. From the main window menu, select Options > Alignment. The 
system deallocates the power meters and the WRM.

2. If necessary, set a wavelength for the source. Click Apply to confirm 
your changes.

3. If necessary, adjust the polarization state to your needs.

4. Click Close to return to the main application. The power meters and 
WRM are automatically reinitialized allowing you to proceed with the 
system as you would normally.

2 3
70 IQS-12004B



Operating the DWDM Passive Component Test System
Monitoring Modules in Local Mode
Monitoring Modules in Local Mode
The DWDM Passive Component Test System allows you to locally monitor 
the power meters and the Wavelength Reference Meter without exiting the 
application. You can also set the source to a specific wavelength and 
modify the polarization state of the IQS-5150 Polarization State Adjuster.

Note: This feature is only available after a power optimization is performed
(i.e., after a reference or calibration.) 
Otherwise, the option will be grayed out.

To monitor the power meters and WRM:

1. From the main window menu, select Options >Local control.

2. If necessary, set a wavelength for the source. Click Apply to confirm 
your changes.

3. If necessary, adjust the polarization state to your needs.

4. To display the monitoring zone, click Show monitors. You can hide the 
zone by clicking Hide monitors.

5. If necessary, use the Power unit box to adjust the displayed unit.

6. When you want to come back to the DWDM Passive Component Test 
System application, click Close. You can then proceed with the system 
as you would normally.
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Viewing System Information
It is possible to view the description and serial number of modules used in 
the system as well as enter comments about the system setup.

To view system information:

1. From the main window menu, select Help > System Info.

2. If desired, enter comments below the list of modules.

3. Press the Print button if you want to print the displayed information.
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Component Test System
Calibrating the System

After selecting the setup parameters, the main window is displayed 
(see figure below). Normally, the application brings you to this step 
automatically. If necessary, you can go directly to the Calibration step. For 
information on accessing a step, see Accessing a Specific Test Step on 
page 34.

Note: The system has been calibrated at the factory and upon installation. 
Recommended recalibration procedures are explained in the following 
pages.

To perform a system calibration, click OK as indicated on the screen.
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The Calibration window appears (see figure below). In this window, you 
can independently select the calibration options you want by checking the 
appropriate boxes.

Detector Null: Check this option to perform an electrical offset nulling 
of the power meters. To avoid disconnecting the rigid patchcord to 
perform the nulling, select Turn Source Off.

Wavelength Response: Check this option to correct variations in 
sensitivity and response of the different power meters.

Return Loss: Check this option to perform the return loss calibration.
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Nulling Electrical Offsets

The offset nulling process provides a zero-power reference measurement, 
thus eliminating the effects of electronic offsets and dark current due to 
detectors.

Temperature and humidity variations affect the performance of electronic 
circuits and optical detectors. For this reason, EXFO recommends 
performing a nulling of the electrical offsets whenever environmental 
conditions change.

The IQS-12004B DWDM Passive Component Test System uses both external 
optical power meters and internal optical power meters inside the 
IQS-9401 WRM.

Protective caps should be placed on the external power meters. The WRM 
can be blacked out by placing protective caps on both the input and output 
or by placing a protective cap only on the output if the Turn Source Off 
option is selected.

This operation ensures accuracy of the power readings by taking a 
measurement while a protective cap is put on the power meter detector.

IMPORTANT
Light must not reach the detector when nulling offsets.
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A nulling of the electrical offsets should be done:

At the initial installation after the system has reached a stable operating 
temperature (approximately 30 minutes). 

If there is a significant change in environmental conditions. 

EXFO also recommends that a nulling be performed prior to the 
wavelength response calibration and/or before the return loss calibration.

To perform a nulling: 

1. Put protective caps on power meter detectors as well as on the input 
and output of the WRM, as shown on the screen.

2. Click OK to perform the measurement.

OR
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the source will be turned off (as shown on the screen) and you won’t 
have to perform an electrical offset nulling of the power meters if you 
have selected the Turn Source Off option in the calibration window.

When the detector null measurement is complete, the Nulling window 
appears and provides you with a Pass or Fail indication. In the case of a 
Failed response, you have the possibility to restart the nulling by pressing 
the Restart Nulling button.
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Wavelength Response Calibration

The wavelength response calibration is a full-range sweep with a launch 
jumper connected in sequence to each of the external power meters. It is a 
series of measurements starting with the first channel of the first power 
meter and ending at the last channel of the last power meter. This series of 
measurements allows the system software to correct any variations in 
sensitivity and response of the different power meters. 

The calibration data is saved to a file and is associated with the module 
serial numbers. If a new module is added to the system, it will be 
automatically detected and you will be forced to perform a new 
calibration. 

A wavelength response calibration must be done in the following cases:

Power meter(s) is replaced.

Power meters are added to the system.

The Source or WRM or PSA is replaced.

A PSA is added to the system.
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To perform the wavelength response calibration:

1. Connect the output port of the Wavelength Reference Module to 
channel 1 of the power meter, as indicated on the screen.

Click Scan. 

Connect the WRM to all remaining channels in the system, as 
indicated on the screen.

When the wavelength response measurement has been 
completed, a green check mark will appear in the Status column 
field, indicating that the measurement has been successfully 
completed for the current power meter.

2. Once the measurements have been completed for all power meters, 
click Close to exit the window and proceed to the next step.
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Return Loss Calibration

The return loss calibration is performed in two steps (ORL Calibration and 
ORL Calibration Zero) using a reflection reference jumper supplied with 
the IQS-12004B DWDM Passive Component Test System. This reflection 
reference is connected to the output of the WRM and provides a known 
optical reflection. 

During the first step, the system will scan the full tuning range. The second 
step of the ORL calibration is a zero reflection scan (again across the 
complete tuning range) of the reference jumper. Based on the two scans, 
the ORL calibration factors are calculated and stored into a system 
calibration file.

It will be necessary to repeat the return loss calibration if any of the 
modules (Source, WRM, or PSA) are replaced. One way of verifying the 
ORL measurements is to measure the ORL of the reflection reference. The 
result should be 14.7 dB ± the uncertainty specified in the specification 
table. 

To perform the return loss calibration:

1. Connect the reflection reference jumper, as shown in the figure below.

2. Click OK.
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3. Mandrel the reflection reference jumper, as shown in figure below.

4. Click OK.

WARNING
Use of controls or adjustments or performance of procedures other than 
those specified herein may result in hazardous radiation exposure.
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Performing Reference Measurements
Once the calibration is complete, you will have to perform an Insertion 
Loss/PDL reference as well as a Return Loss Zero reference. Normally, the 
application brings you to this step automatically. If necessary, you can go 
directly to the Reference step. For information on accessing a step, see 
Accessing a Specific Test Step on page 34.

Note: The IQS-12004B DWDM Passive Component Test System test system 
automatically prompts you to perform a reference measurement (see 
procedure below) at start-up. However, to obtain good results, EXFO 
recommends to also perform a reference measurement when the test 
system is used non-stop during a long period of time or when there are 
important variations in environmental conditions. 

IL/PDL Reference Measurement

An IL/PDL reference is performed to compensate for any loss or spectral 
non-uniformity of the launch fiber connection to the WRM output port.

During this step, a complete sweep on the first channel is performed.

Note: An IL/PDL reference measurement is required each time the system is 
turned on, and is recommended whenever there is a significant change in 
environmental conditions.
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To perform the IL/PDL reference measurement:

1. Clean the connectors and connect the modules as indicated on 
the screen. For more information, see Maintenance on page 213 and 
Connecting Optical Fibers on page 66.

2. Select Insertion Loss/PDL in the Reference window and press OK.

3. Connect the output of the Wavelength Reference Module to channel 1 
of the first power meter (the location of the first parameter is shown on 
the screen) using the desired launch cable, as indicated on the screen.

4. Click Scan to start the operation. 

5. When the IL/PDL reference measurement has been completed, a 
green check mark will appear in the Status column field, indicating 
that the reference has been successfully completed.

6. Click Close to proceed to the next step.

IMPORTANT
Before running any reference check, ensure that all the connectors 
and fiber-optic adapters (FOAs) to be used are clean, and that the 
warmup periods have been respected.
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Return Loss Zero Reference Measurement

The Return Loss Zero measurement provides a zero reflection reference to 
the WRM return loss detector. This reference will be used to compensate 
for internal WRM parasitic reflections as well as parasitic reflections 
originating at the WRM output/launch fiber connector.

Note: A Return Loss Zero reference measurement is required each time the 
system is turned on, and is recommended whenever there is a significant 
change in environmental conditions.

To perform the Return Loss Zero reference measurement:

1. Clean the connectors and connect the modules as indicated on 
the screen. For more information, see Maintenance on page 213 and 
Connecting Optical Fibers on page 66.

2. Select Return Loss Zero in the IQS-12004B Reference window and 
press OK.
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3. Connect the launch fiber, as indicated on the screen.

4. Mandrel the launch fiber (i.e., wrap the fiber a minimum of five turns 
around the mandrel tool).

5. Click OK to start the operation. 

WARNING
Never look directly into a live fiber and ensure that your eyes are 
protected at all times.
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7 Interpreting the DWDM 
Passive Component Test 
System Results
Optimizing Performance

The following section gives you important information on how to get 
optimum performance from your DWDM Passive Component Test System.

Spectral Errors

The IQS-12004B DWDM Passive Component Test System uses a 
temperature-stabilized Fabry-Perot interferometer and high-precision 
absolute wavelength reference component to ensure wavelength accuracy 
of the spectral measurements. To ensure that the system is operating to its 
published specifications, it is important to respect the recommended 
30-minute warmup period and the specified operating environment.

The system is calibrated at EXFO and verified with the NIST SRM 2519 HCN 
absorption cell. EXFO recommends a yearly recalibration of the IQS-9401 
Wavelength Reference Module. 
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Optimizing Performance
IL/PDL Errors

There are numerous possible sources of errors for the insertion loss 
measurement. Some of them are inherent to system and test procedures, 
while others are related to operation and fiber handling. Understanding 
these sources of error will help you to optimize the accuracy of your loss 
measurements.

Environmental stability

To ensure optimum results, it is important to respect the 
recommended 30-minute warmup period before performing any 
calibration, reference, or null measurement. 

Source power stability

The IQS-9401 has an internal detector that is always measuring the 
optical power at the output of the WRM. This reference power is used 
along with the calibrated coupling ratio of the output coupler to correct 
variations in the source power. Therefore the effect of any instabilities 
in the source output power have been minimized.

Connector repeatability

It is well known that connector repeatability is a significant source of 
error when testing the IL of any connectorized component. There is no 
practical way of completely eliminating these errors. However, if all 
connectors are of good quality and adequately cleaned, the errors are 
minimized. Where it is important to measure the IL of the device 
alone, you should use fusion splices on the launch side of the DUT.
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Different connector types

Often it will be necessary to test components with different connector 
types. To do this, you will have to change the launch fiber (or to use a 
hybrid adapter) and you will also have to change the fiber-optic 
adapters (FOAs) on the IQS power meters. In this situation, it will be 
necessary to perform a new reference measurement and, for truly 
optimum results, repeat the spectral response calibration. This is 
because different FOAs have slightly different alignment characteristics 
(manufacturing tolerances), and this will contribute to an increase in 
measurement uncertainty. This also applies when switching from APC 
to PC connector types.

Return Loss Errors

Most of the factors affecting IL and PDL also affect the return loss accuracy. 
There are, however, some additional factors that should be considered.

Power budget

A return loss measurement is generally a very low power 
measurement. In order to have good accuracy when measuring weak 
reflections, it is important to have as much power as possible. One way 
of improving the ORL sensitivity and accuracy is to bypass the optional 
IQS-5150 PSA. This will give an additional 5 to 8 dB sensitivity as well as 
better accuracy and resolution.

Calibration reference

The calibration reference supplied with the DWDM Passive 
Component Test System is used as an absolute reflection reference 
based on the glass-to-air interface reflection of 4% (–14.7 dB). When 
performing measurements, a different launch cable is used. The 
insertion loss of the WRM output connector/launch fiber connector will 
not be exactly the same as the insertion loss of the WRM output 
connector/reference fiber connector. This difference contributes 
directly to the ORL measurement error. For this reason, it is important 
to use launch fiber with a good quality connector. 

≈
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Viewing Test Results
Viewing Test Results
To view the results of the current device tested, click OK as indicated on 
the screen. Normally, the application brings you to this step automatically. 
If necessary, you can go directly to the View Results step. For information 
on accessing a step, see Accessing a Specific Test Step on page 34.

If you wish to view the results of an already existing test, see Using the 
Database Browser on page 109.
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Viewing Test Results
The IQS-12004B View Results window will appear, as shown in the 
following figure.

Unsatisfactory results are highlighted in red (dark in the illustration above).

Current DUT 
identification

Global Pass/Fail 
status
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Viewing Test Results
The Results tab contains a summary of the actual measurements 
performed on the DUT, as shown below.

The data shown in this table is calculated in accordance with the 
definitions in Definitions and Calculation Methods on page 405.

The Limits tab displays the limits entered as acceptable values in the 
IQS-12004B Optical Ports-Configuration dialog box.
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Viewing Test Results
The Crosstalk tab provides a summary table of the measured crosstalk 
values between the DUT output channels, as shown below. For 
example, the crosstalk from channel 1 to channel 2 is 25.66 dB.

Also, you can perform other operations with your data.

Click Text Export to export the data to a text file. For details about this 
feature, see Exporting Data below.

Click Show Graph to view and print the insertion loss, the PDL and the 
ORL curves, as explained in Viewing the Results Graph on page 97.

Once you are done viewing the results, click Close to leave the View 
Results window and move to the next step.

To port

From port
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Exporting Data
As explained in Opening a New Test Database on page 61, results are 
automatically saved into the active database file after each DUT has been 
tested. You can convert the current database record into a text file and 
open it with any word processor or spreadsheet program. Data can then be 
easily viewed, analyzed, and processed.

To export data:

1. Click Test Export located at the bottom of the View Results window. 
The Export window appears.

2. Select the export parameters and click Export: 

Tables: exports the results of the measurement scan.

Traces (IL/PDL/ORL): exports all the data points of the 
measurement scan, which allows you to reproduce the curves of 
the scan in a spreadsheet, for example.

Traces (IL @ 4 SOP, ILmin and ILmax): The Traces (IL/PDL/ORL) 
option, presented above, allow you to export the “standard” IL 
results (corresponding to the DUT IL average values). However, 
you may need to get detailed IL results, obtained at the four states 
of polarization., the minimum IL trace, as well as the maximum IL 
trace. select the Traces (IL @ 4 SOP, ILmin and ILmax) option to 
export detailed information.

Note: These complete traces are only available for exporting if you have selected 
the corresponding option at time of test setup. For information, see 
Preparing the Test Setup on page 49.
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Traces (PDW, min and max): You may also need to get traces 
from the PDW analysis. The PDW analysis is made using 
proprietary algorithms (patent pending) and is based on 
calculations using the Mueller Matrix coefficients. Using data from 
the four scans performed for the PDL measurement, the DWDM 
Passive Component Test System analysis software internally 
calculates the transmission response for many states of 
polarization and generates the insertion loss curves for the 
extreme values. Select Traces (PDW, min and max) to export 
detailed PDW information.

Note: These traces are only available for exporting if you have selected the 
corresponding option at time of test setup. For information, see Preparing 
the Test Setup on page 49.

Delimiter: indicates which delimiter you want to separate 
columns of data i.e., a tab, a space, a semicolon or a comma.

Header: select this parameter if you want information to appear in 
the header.

3. The Save As window appears. Enter the name of the new file. 
By default, the file will be named with the serial number given in the 
Setup step (see Identifying the Current DUT on page 54), it will be given 
the .TXT extension, and it will be saved in the 
C:\IQS\Maestro\IQS_DWDMTS folder.

4. Click Save. A window confirms the success (or failure) of the export 
operation and indicates where the file was saved.
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Exporting Data
5. Open a spreadsheet or word processor application to view the file. The 
file is a plain text file, as shown in the following examples. The 
columns (fields) are separated using the previously selected delimiter.
96 IQS-12004B



Interpreting the DWDM Passive Component Test System Results
Viewing the Results Graph
Viewing the Results Graph
When you click Show Graph from the View Results window, the following 
window appears.

To enlarge or reduce the desired area with the zoom icon:

1. Place the cursor over the zoom icon. The cursor changes.

2. Drag and drop the zoom icon to the center of the area to enlarge.

3. Double-click the zoom icon with the left button to zoom in or with the 
right button to zoom out.

The graph displays the IL, PDL, and ORL measurements. You can 
independently select the types of measurement you want to view by 
checking the appropriate boxes in the Display box. In figure shown above, 
only the IL measurement is displayed.

Note: IL and ORL are displayed using the same scale, and PDL is displayed on a 
separate scale. In order to obtain a bandpass orientation, IL is displayed as 
a negative value. In order to use the same scale, ORL is also displayed as a 
negative value.

Zoom
icon
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Viewing the Results Graph
Markers

To perform a point-by-point analysis on a specific interval, select the 
Markers tab.

To view markers on the graph:

1. Check Display Markers to show the A and B markers on the graph.

2. Select the channel for which the values will be displayed in the Apply 
On list box.

3. Move the markers on the graph with your mouse, or enter precise 
wavelength values in the A and B text boxes.

Loss values at marker positions and loss variation between the 
markers are shown for the selected channel.
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Ranges

To define the graph scaling and visible ranges, select the Ranges tab. Click 
Use Default Ranges to return to the default values shown below at any 
time.

Note: The default wavelength range is determined by the Analysis Range selected 
in the Setup window.

Configuration

To save the parameters defined for ranges, curves, and graph options, 
select the Configuration tab.
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Viewing the Results Graph
Curves

To modify the appearance of the curves, such as the color and the type of 
lines, click Curves.

The following options are available in the Curves window:

Color: Click Color to select trace colors.

Visible: Click Visible to indicate whether or not the trace is shown.

Line Type: Click Line Type to select different line types for a trace.

Symbol: Click Symbol to add symbols to the trace.

Center Wave: Click Center Wave to display the central wavelength 
markers.

Clicking the top row changes all the values, and clicking a specific box 
changes only that value.
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Options

To access the graph options, click Options.

The Graph Options window contains the following tabs:

Colors: Select the Colors tab to modify the color of the graph 
components such as the background, the grid, the title as well as the 
X and Y axes.

Grid: Select the Grid tab to modify the type of lines for the X and Y 
axes.
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Viewing the Results Graph
Maximize/Minimize Graph

To increase the size of the display area or to return to the display area’s 
original size, click the Maximize/Minimize Graph button.

Print Graph

To print the graph as displayed, click Print Graph.

Close

To close the View Graph window, click Close.
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Printing Test Results
Once you have viewed the results, they can now be printed. Normally, the 
application brings you to this step automatically. If necessary, you can go 
directly to the Print Data Results step. For information on accessing a step, 
see Accessing a Specific Test Step on page 34.

If you want to print the results from an already existing test, see Using the 
Database Browser on page 109.

To print a report of the results:

1. Click OK as indicated on the screen.
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Printing Test Results
The Print Results window appears, allowing you to select the type of 
information you want to print.

2. Select the correct printer in the Name list box of the Printer section. 
If your printer is not in the list, you can add it from the Windows 
Control Panel.

3. In the Report Type section, choose whether you want a standard or a 
custom report by selecting the corresponding option button. 

The Options section will only be enabled if you select Standard 
Report. In that case, check the appropriate boxes to include the 
desired information in the report.

The Customize Report button will only be enabled if you select 
Custom Report. Clicking this button will display the Custom Report 
window, which contains two tabs: Results and Graph. For details, see 
Customizing Printed Results on page 105, and Customizing Printed 
Graph on page 106.

Note: By default, the standard report includes only a data table. Select the 
appropriate options to include additional information.

4. Click OK to print the report or click Cancel to simply go back to the 
main window. In both cases, you will be brought to the next step.

Identification of all 
IQS modules used

Crosstalk matrix

DWDM spectra 
graph
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Customizing Printed Results 

On the Results tab, you can select which information will appear on the 
report.

The middle buttons (Add All, —>, <—, Remove All) are used to move 
a particular field from one box to the other.

Check the appropriate boxes from the Other results section to add 
information to the report.

Fields
not included
in the report

Fields 
included in 
the report
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Printing Test Results
Customizing Printed Graph

The Graphs tab allows you to specify if and how the graph will be printed.

Check Print Graph to include the graph in the report.

Give the axis ranges in nm for the X axis, in dB for the IL/ORL Y axis, 
in dB for the PDL Y axis.
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Organizing Tests
The IQS-12004B DWDM Passive Component Test System has an utility for 
organizing test files. This utility ensures that the database and all associated 
files are copied.

The Test Organizer feature is accessible from the File menu. It allows you 
to copy (click Copy to Folder) or move (click Move to Folder) a selected 
database file to a new folder, or to rename (click Rename) or delete (click 
Delete) a selected file.

IMPORTANT
Do not to copy or move database files without using this utility for 
it may destroy test results.
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Running Windows Explorer from the 
Application

For file management, you can run Windows Explorer directly from the 
IQS-12004B DWDM Passive Component Test System.

To use Windows Explorer, select Windows Explorer from the Run menu.

Clearing Database Files from the List
When opening an existing test database or viewing a recent test database 
file, click Clear List if you want to clear the list of recently opened files. 

Note: Clearing the list does not delete the files.
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8 Using the Database Browser
The system Database Browser allows you to view and print the contents of 
different databases and to export data without the need of any hardware 
module. It is automatically installed on your testing system. However, the 
Database Browser as well as the IQS-12004B DWDM Passive Component 
Test System software can also be installed on another PC, which allows 
you to analyze data, print reports, etc. 

For more information on the IQS-12004B DWDM Passive Component Test 
System software installation, see Installing the IQS-12004B DWDM Passive 
Component Test System Software on page 28. 

Opening the Database Browser
To open the database browser:

1. Select Database Browser from the Run menu, or select View 
Database from the File menu. The View Test window is displayed.

2. Select the database you want to consult in the dialog box.

3. Click View. The database opens and the main window is filled with 
information pertaining to previous tests. The path of the currently 
opened database is shown in the title bar.

Note: If the database does not appear in the list, click More Files to find the 
desired database file.

Each line corresponds to a DUT test. The first column identifies the DUT 
test result:  for a failure,  for a success, and ? when no Pass/Fail 
analysis was done. You can resize a column width by moving the separator 
in the column title.
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Browsing the Database
Use the vertical scroll bar to navigate between records in the open 
database. If you cannot see all the columns, scroll to the right using the 
horizontal scroll bar.

Viewing Test Results

Note: This command is disabled (grayed out) if no database file is opened.

Select View Results from the View menu, or click Results from the toolbar. 
The following window appears:

For details about the elements in this window, see Viewing Test Results on 
page 90.

Click Close to return to the main window.
110 IQS-12004B



Using the Database Browser
Printing a Report
Printing a Report

Note: This command is disabled (grayed out) if no database file is opened.

To print a report:

1. Select Print Report from the File menu, or click Print of the toolbar. 
The following window appears:

2. Select the print settings you want. For details about the different 
parameters, see Printing Test Results on page 103.

3. Click OK to print the report or Cancel to simply go back to the main 
window.

Typing Items to Find
This feature allows you to find information displayed on the spreadsheet 
such as the serial number, the part number, the data tested and the 
customer.

Exiting the Database Browser
To exit the system Database Browser, select Close from the File menu.
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9 Referencing the System with 
MultiPath Testing Option

This section presents the procedures to perform reference and calibration 
on your system when working with the MultiPath Testing Option. This is 
particularly useful if you develop your own MPT application (without using 
the provided LabVIEW application).

All the procedures presented in the current section are included in the 
LabVIEW application provided with the MPT option. If you intend to use the 
provided application, see Testing Multiple DUTs with the LabVIEW 
Application on page 117.

Nulling Electrical Offsets
The offset nulling process provides a zero-power reference measurement, 
thus eliminating the effects of electronic offsets and dark current due to 
detectors.

Temperature and humidity variations affect the performance of electronic 
circuits and optical detectors. For this reason, EXFO recommends 
performing a nulling of the electrical offsets whenever environmental 
conditions change.

A nulling should be performed during the initial installation, after the 
system has reached a stable operating temperature (approximately 
30 minutes). It should be repeated if there is a significant change in 
environmental conditions. EXFO also recommends that a detector null 
measurement be performed, prior to the wavelength response calibration 
and/or before the return loss calibration. For more information, see Nulling 
Electrical Offsets on page 75.

IMPORTANT
Light must not reach the detector when nulling offsets.
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Calibrating the System Wavelength Response
To perform a null measurement:

1. Put protective caps on power meter detectors as well as on the input 
and output ports of the WRM.

2. Perform the null measurement.

OR

1. Connect the rigid and semi-rigid patchcords to the appropriate 
modules (source, polarization state adjuster, wavelength reference 
module and switch). See To work with the MultiPath Testing Option, 
you will have to add a switch to your standard IQS-12004B DWDM 
Passive Component Test System to benefit from its inherent features. on 
page 26 for more information.

2. Put protective caps on power meter detectors.

3. Turn the source off.

4. Perform the null measurement.

Calibrating the System Wavelength Response
This operation allows to correct any variations in the response and 
sensitivity of the different power meters.

To perform a wavelength response calibration:

1. Connect output port 1 of the switch to channel 1 of the power meter.

2. Perform the wavelength response calibration.

3. Repeat the previous steps with all of the remaining power meter 
channels.
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Calibrating Your System for ORL Testing
This operation measures ORL in the system before testing DUTs. The 
results obtained will be used to calculate the ORL specific to the DUTs.

To perform an ORL calibration:

1. Connect an ORL reference test jumper to output port 1 of the switch.

2. Perform an ORL calibration scan.

3. Mandrel the ORL reference test jumper.

4. Perform an ORL zero measurement.

5. Repeat steps 1 to 4 for all of the switch ports.

Optimizing Power
This operation allows to adjust the power from the IQS-5150 to its optimum 
level.

To optimize power:

1. Connect the patchcords to the appropriate modules (source, 
polarization state adjuster, wavelength reference module and switch) . 

2. Connect output port 1 of the switch to channel 1 of the power meter.

3. Perform the power optimization.
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Performing Reference Measurements
An IL reference is performed to compensate for any loss or spectral 
non-uniformity of the launch-fiber connection to the WRM output port.

To perform an IL reference:

1. Connect output port 1 of the switch to channel 1 of the power meter.

2. Perform an IL reference measurement.

3. Repeat the above steps for each of the remaining switch output ports 
by connecting the switch port to channel 1 of the power meter.

An IL/PDL reference is performed to compensate for any loss or spectral 
non-uniformity of the launch fiber connection to the WRM output port.

To perform an IL/PDL reference:

Note: References are valid as long as rigid and semi-rigid patchcords do not 
move.

1. Connect output port 1 of the switch to channel 1 of the power meter.

2. Perform an IL/PDL reference measurement.

3. Repeat the above steps for each of the remaining switch output ports 
by connecting the switch port to channel 1 of the power meter.

The return-loss zero measurement provides a zero-reflection reference to 
the WRM return loss detector. This reference will be used to compensate 
for internal WRM parasitic reflections as well as parasitic reflections 
originating at the WRM output/launch-fiber connector.

To perform an ORL zero-reference measurement:

1. Connect the launch fiber to output port 1 of the switch.

2. Mandrel the launch fiber.

3. Perform the measurement.

4. Repeat the preceding steps for each switch port.
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10 Testing Multiple DUTs with the 
LabVIEW Application

The MultiPath Testing Option comes with a “prebuilt” application and with 
a series of VIs and COM functions you can use to develop your own MPT 
application. 

If you choose to build your own application and you need information on 
referencing the system, see Referencing the System with MultiPath Testing 
Option on page 113.

The LabVIEW application provided with the MultiPath Testing Option 
allows you to:

Reference and calibrate the system

Referencing and calibrating the system are necessary in order to 
ensure optimum accuracy. References are saved to a file for future 
tests. References are valid as long as rigid and semi-rigid patchcords 
do not move, and no new power optimization is performed. Power 
optimization deletes all the previous references, so they will have to be 
taken again. Referencing and calibrating include:

performing a null measurement

optimizing power

calibrating the wavelength response of the system

calibrating the system for return loss (ORL) testing

performing reference measurements for IL, PDL and ORL.

Define the connectivity of the devices to be tested (DUT), save 
connectivities and reload them.

Configure tests.

Perform tests on the defined DUTs sequentially. 

View test results, export them and print them.
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Starting a New Test
Starting a New Test
In order to perform calibrations, references and tests, you must first create 
a new test database. From the File menu, select New. The following dialog 
box is displayed.

To create a test database:

1. Ensure that the path appearing in the entry box is appropriate. If not, 
use the browse button (the one with a folder icon) to specify the folder 
you want.

2. To specify a name for your new test, you can directly type it in the entry 
zone or use the browse button. If you use the name of an 
already-existing test, the data related to this test will be lost.

3. If you want to perform a test in real mode, make sure the switch 
appearing in the Switch Selection box is appropriate. If necessary, use 
the up and down arrows to select the switch that will suit your needs. 

If the Switch Selection box only displays None, make sure that

the switch has been added to the system 

it is properly connected (EXFO switch) 

the GPIB has been correctly configured (external switch)

When the switch is set to None, the system can only be used in 
simulation mode.

If you want to perform a test in simulation mode, click Simulator. All 
the necessary hardware will be simulated to start IL, PDL and ORL 
tests.

Note: The hardware section is only available when the modules have not been 
initialized.

4. Click OK.
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Opening an Existing Test Database
Opening an Existing Test Database
Previous tests can be loaded for on-screen viewing, printing and exporting.

To open an existing test database:

1. Select View from the File menu of the main window.

2. Select the test to open. Click Open.

3. The information is automatically loaded into the main window.

Note: The DUT Connectivity and Acquisition Settings tabs are not available in 
view mode. Also, System menu and System Info from the Help menu are 
not available. To view the DUT connectivity, use the export tool (see 
Exporting Test Results on page 136) or the graph settings tool (see 
Adjusting Result Settings on page 134).
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Setting Up Device (DUT) Connectivity Configuration
Setting Up Device (DUT) Connectivity 
Configuration

The DUT Connectivity tab of the main window has been designed to 
specify switch port numbers and power meter channels to which the 
devices under test are connected. It is also possible to save a connectivity 
and to reload an existing one.

The window can be divided into two main parts:

A connectivity definition section that allows to identify each device and 
to specify how it is connected in the system.

An open/save section that allows the saving and the reloading of 
connection plans.
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Setting Up Device (DUT) Connectivity Configuration
To set up a connectivity configuration:

1. If the DUT Connectivity tab is grayed out, that means no test has been 
created since the application was started. To enable the tab, start a 
new test. For more information, see Starting a New Test on page 118.

2. With the help of the up/down arrows, select the appropriate number of 
switch ports and power meter channels.

3. In the S/N text box, enter the serial number or a description of the 
device to be tested.

4. If you want the device to become a reference, click Reference. Once 
the definition will be sent to the grid, DUTs having been defined as a 
reference will be indicated by a 1.

5. Click Add to transfer the information to the connectivity grid.

Note: You can remove items from the grid by clicking Delete. Rows are deleted 
one at a time from the bottom of the grid to the top.

6. Repeat steps 2 to 5 for each DUT that must be added. 

Note: When there are no more available switch ports (In) or power meter 
channels (Out) i.e. when their number equals zero, you won’t be able to 
add anymore DUTs to the connectivity grid.
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Configuring Test Parameters
Although connectivity configurations do not need to be saved to disk in 
order to be used in the current test session, you may find it useful to store it 
for future tests.

To save the current connectivity configuration:

1. Click Save.

2. From the dialog box, specify the name of the connectivity and click 
Save. The name of the new connectivity file is now displayed in the 
Configuration File box, at the bottom of the tab.

To reload a DUT connectivity configuration:

1. Click Open.

2. From the dialog box, select the connectivity file that you want to use 
(file with a .dut extension) and click Open. The file content has been 
automatically loaded onto the grid.

Configuring Test Parameters
The Acquisition Settings tab has been designed to specify all the 
necessary parameters for the system to perform a test.

To configure test parameters:

1. If the Acquisition Settings tab is grayed out, that means no test has 
been created since the application was started. To enable the tab, start 
a new test. For more information, see Starting a New Test on page 118.

2. From the Measurement Selection zone, select the types of tests you 
want to perform.

3. Indicate the appropriate values in dB for bandwidth analysis. For 
central wavelength, select BW1, BW2 or BW3 from the list. For more 
information on bandwidth and central wavelength, see Definitions and 
Calculation Methods on page 405.
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Configuring Test Parameters
4. From the Acquisition Mode section, select the type of acquisition that 
best suits your needs.

A sequence is a set of acquisitions performed in the order in which the 
DUTs were added when setting up the DUTs’ connectivity.

Select Single if you want the measurements to be taken only once.

Select Continuous if you want the system to perform successive 
sequences. Specify the number of sequences you want by using the 
up/down arrows or by typing the value in the text box.

Select Periodic if you want the system to perform a series of 
sequences separated by a time interval. Specify the number of minutes 
between sequences. Also indicate the number of sequences to 
perform during the test.

5. Specify the Acquisition Range by entering a start value and a stop 
value in nanometers.

6. In the Acquisition Type section, you can specify a resolution in 
picometers.

7. By default, only analysis traces are saved. If you also want the data 
traces to be saved, click Save All Data Curves.

Note: Saving all data curves will dramatically increase used space on the 
computer disk.
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Nulling Electrical Offsets
This feature allows you to perform an electrical offset nulling of the power 
meters. For more information, see Nulling Electrical Offsets on page 75.

To null the electrical offsets:

1. If the System menu is grayed out, that means no test has been created 
since the application was started. Consequently, no nulling can be 
performed until you start a new test. For more information, see Starting 
a New Test on page 118.

2. Select Nulling from the System menu of the main window.

3. Put protective caps on power meter detectors as well as on the input 
and output of the IQS-9401 WRM as described at the top of the dialog 
box.

4. During a nulling, no light should reach the detectors. To avoid 
disconnecting the rigid patchcords, click Turn Source Off. The source 
and the EDFA will be turned off as soon as you press Start. Once the 
nulling is complete, the source is automatically turned on. 

5. Click Start to start the null measurement. The Instruction box displays 
Nulling in progress. 

6. When the operation has been completed, the Instruction box content 
changes to Nulling completed. Click Close to return to the main 
window.
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Calibrating the System Wavelength Response
Calibrating the System Wavelength Response
This feature allows you to correct variations in the response and sensitivity 
of the different power meters. If you need more information on wavelength 
response calibration, see Wavelength Response Calibration on page 78.

To calibrate the system wavelength response, select Wavelength 
Response Calibration from the System menu of the main window.

The dialog box can be divided into three main parts:

A monitoring zone that allows you to verify the power read on the 
power meter, in dBm.

A connection information section that indicates between which switch 
port and which power meter channel the fiber should be connected.

A section that displays useful instructions about wavelength response 
calibration.

Power meter monitoring 
zone

Connection information

Calibration 
instructions
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Calibrating the System Wavelength Response
To perform a wavelength response calibration:

1. If the System menu is grayed out, that means no test has been created 
since the application was started. Consequently, no calibration can be 
performed until you start a new test. For more information, see Starting 
a New Test on page 118.

2. Select Wavelength Response Calibration from the System menu of 
the main window.

3. Connect start fiber to the specified switch port and power meter 
channel. 

4. When you are satisfied with the value displayed in the Power Meter 
Monitor box, click Start.

5. Repeat steps 3 and 4 for each power meter channel. The connection 
information section provides you with the number of the switch port 
and the number of the power meter channel indicating where the 
patchcord must be connected.

6. When you are done with wavelength response calibration, simply click 
Close to return to the main window.

Note: The zone labeled Instructions guides you through the whole wavelength 
response calibration process.
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Calibrating your System for ORL Testing
Calibrating your System for ORL Testing
The current section gives you the information you need to perform an ORL 
calibration. This operation measures ORL in the system before testing 
DUTs. The results obtained will be used to calculate the ORL specific to the 
DUTs.

If you need more details about ORL calibration, see Return Loss 
Calibration on page 80.

From the System menu of the main window, select Return Loss 
Calibration. The following dialog box is displayed.

The dialog box can be divided into three main parts:

A monitoring zone that allows you to verify the power read from the 
WRM, in dBm.

A connection information section that indicates which switch port the 
reference test jumper should be connected to.

A section that displays useful instructions about ORL calibration.

WRM monitoring zone

Connection information

Calibration 
instructions
DWDM Passive Component Test System 127



Testing Multiple DUTs with the LabVIEW Application
Calibrating your System for ORL Testing
To perform an ORL calibration:

1. If the System menu is grayed out, that means no test has been created 
since the application was started. Consequently, no calibration can be 
performed until you start a new test. For more information, see Starting 
a New Test on page 118.

2. Select Return Loss Calibration from the System menu of the main 
window.

3. Connect an ORL reference test jumper to the specified port. 

4. When you are satisfied with the displayed value in the WRM 
monitoring box, click Start. 

5. Mandrel the reference test jumper as specified in the calibration 
instructions section and click Start.

6. Repeat steps 3 to 5 for each switch port. The connection information 
section provides you with the number of the switch port on which 
calibration must be performed.

7. When you are done with ORL calibration, simply click Close to return 
to the main window.

Note: The zone labeled Instructions guides you through the whole ORL 
calibration process.
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Performing Reference Measurements
Performing Reference Measurements
Once the calibration is complete, you will have to perform reference 
measurements. More detailed information about references can be found 
in Performing Reference Measurements on page 82.

The dialog box can be divided into four main parts:

A section that specifies the types of reference measurements that can 
be performed on the system: IL, IL/PDL, ORL

A monitoring zone that allows you to verify the power read from the 
power meter, in dBm

A connection information section that indicates to which switch port 
and to which power meter channel the fiber should be connected

A section that displays useful instructions about reference 
measurements

Power meter monitoring 
zone

Connection information

Instructions

Types of
references
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Performing Reference Measurements
Note: When choosing a type of reference, take into account that a reference 
measurement must have been previously taken for the type of the tests you 
will perform. For instance, if an IL/PDL reference measurement has been 
previously taken, you will be able to perform IL tests. However, with such a 
reference measurement, ORL tests will not be possible.

To perform reference measurements:

1. If the System menu is grayed out, that means no test has been created 
since the application was started. Consequently, no references can be 
performed until you start a new test. For more information, see Starting 
a New Test on page 118.

2. Select References from the System menu of the main window.

3. Select the reference type you need.

4. Connect start fiber to the specified switch port and power meter 
channel. 

5. When you are satisfied with the value displayed in the power meter 
monitoring box, click Start.

6. Repeat steps 4 and 5 for each switch port. The connection information 
section provides you with the number of the switch port and the 
number of the power meter channel to which the patchcord must be 
connected.

Note: You only need to reference the switch ports that you plan to use, starting 
sequentially at channel 1. 

7. Repeat the above procedure for each reference type you need.

8. When you are done with reference measurements, simply click Close 
to return to the main window.

Note: The zone labeled Instructions guides you through the whole reference 
measurement process.
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Performing a Test
Performing a Test
In the acquisition window, data is presented both in a graph and in a grid. 
In the grid, the information is given for all the Out ports of the current 
sequence. Depending on the type of the selected graph, certain items will 
differ.

If the selected graph corresponds to an acquisition trace (IL trace, PDL 
trace or ORL trace), the X axis will represent wavelength values and 
the Y axis, dB values. The grid will show the greatest value among all 
the values that have been measured for a particular test type.

If the selected graph corresponds to an analysis curve, the X axis will 
present absolute time values and the Y axis, will present dB values, 
except for a Central Wavelength curve for which the Y axis will present 
values in nm. The grid will show all the values that have been 
measured for a particular test type, at a given time.

Note: A change in the graph type will be effective on the next acquisition only.

There are three buttons to control the execution of the test:

Start: Allows you to start the acquisition process. Once the test has 
started, all the menus and buttons become disabled except for the 
Pause and Stop buttons. At the end of the test, menus and buttons 
become enabled.

Pause: Allows you to momentarily stop the test. When a test is paused, 
it is possible to adjust graph settings and to export the results. Simply 
click Resume to restart the test. Pausing the test is only possible 
between sequences.

Stop: Allows you to stop completely the test. Stopping the test is only 
possible between sequences.
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Monitoring Modules in Local Mode
Local Mode gives a general overview of the system. It can be used anytime 
except when a test is running. 

If the System menu is grayed out, that means no test has been created 
since the application was started. Consequently, it is impossible to monitor 
modules in local mode until you start a new test. For more information, see 
Starting a New Test on page 118.

To access this mode, select Local Mode from the System menu.

The window contains:

A section that allows you to set the wavelength. The minimum and the 
maximum values are determined by the supported range of the source 
itself.

A section that allows you to set the switch port.

A section that allows you to set the polarization state.

Power 
read on 
power 
meters 
channels
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Monitoring Modules in Local Mode
Note: The first time you work with the system, the polarization state appears as 
“Unknown State”. Use the Optimize Power button to get the system to 
determine a valid polarization state (“Linear Horizontal”). Although it is 
possible to optimize power at any time except when a test is running, be 
aware that optimizing will result in the deletion of all the references that 
were taken previously.

As soon as a valid state is displayed, you can modify it using the up and 
down arrows if the one presented does not suit your needs.

A display zone that allows you to see the output power of the WRM 
channels and of all the power meters, in dBm.

Note: For the WRM, channel 1 (Ch #1) corresponds to the power reference and 
channel 4 (Ch #4) to the value read on the ORL detector.

When you are done with the settings, simply click Apply so the 
modifications will be taken into account. Click Close to return to the main 
window.
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Viewing System Information
Viewing System Information
To view all relevant information about the system modules (identification, 
serial number, slot position), select System Info from the Help menu.

If the System Info option is grayed out, that means no test has been 
created since the application was started. Consequently, it is impossible to 
consult modules’ information until you start a new test. For more 
information, see Starting a New Test on page 118.

You can print the information on the default printer by clicking Print.

Adjusting Result Settings
When you click Result Settings from the Acquisition tab, the following 
dialog box is displayed.

There are two possible graph types: Analysis and Acquisition. If you select 
Analysis, a graph showing analysis results will present dB values (or nm 
values for central wavelength) corresponding to absolute time values. If 
you select Acquisition, a graph displaying data traces will include dB 
values corresponding to all of the wavelengths swept during the displayed 
acquisition.
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Adjusting Result Settings
To set up an Analysis graph:

1. Select the DUT, the In port and the Out port for whose results you want 
to view in a graph. 

2. Select Analysis. 

3. Select the desired curve type from the provided list.

4. Confirm by clicking Apply.

To set up an Acquisition graph:

1. Select the DUT, the In port and the Out port whose results you want to 
view in a graph. 

2. Select Acquisition. 

3. Select the desired trace type (IL, PDL, ORL). 

4. Specify the sequence results you want to see by indicating the values 
in the Sequence From and Sequence To boxes. 

5. Confirm by clicking Apply.
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Adjusting Result Settings
Exporting Test Results

You may want to have the tests results exported to a text file for further 
analysis. The export feature creates such a file with the information that 
you choose to include. 

When you click Export from the Acquisition tab, the following dialog box 
is displayed.

Note: The DUT connectivity grid acts as a reminder to guide you in the selection of 
data to be exported to a text file.

To export data to a text file:

1. Select the DUT for which you want the results.

2. Select the In port and the Out port.

3. Select the sequences of results you want to export by indicating a value 
in the Sequence From and Sequence To boxes.

4. Choose between analysis results and trace data results by clicking the 
corresponding button. 

If you select Analysis, dB values (or nm values for central wavelength) 
corresponding to absolute time values will be exported.

If you select Traces, dB values corresponding to all of the wavelengths 
swept during the displayed acquisition will be exported.

5. If you want column headers to be added to the file content, 
click With Header.

6. In the corresponding entry box, type a path and a filename for the file 
you want to export. Click Export. A message will be displayed as soon 
as the export will be completed.

7. Click Close to exit the export tool.
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Adjusting Result Settings
Printing Test Results

When you click Print from the File menu, the following window is 
displayed.

Information that will be sent to the printer corresponds exactly to the 
results that are displayed on the screen (graph and/or grid).

To print test results:

1. Select Graph and/or Grid, depending on your needs.

2. Use the Comments box to add any comments.

3. Specify the number of copies.

4. Click Print to send the document to the default printer.
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Modifying the Supplied MPT Application
The source code for the supplied LabVIEW application is available should 
you want to modify it according to your needs. The source code can be 
found in the Iqs12004Mpt\Src folder. It is divided in two main parts: 

The code for user interfaces is located in the Main folder. In this folder, 
each of the subfolders corresponds to a particular user interface.

The code to access COM objects is located in the COMAccess folder. In 
this folder, you will find code samples using some of the COM objects 
offered with the Acq12004B dll. For more information, see Automating 
or Remotely Controlling the System on page 167, Referencing the 
System with MultiPath Testing Option on page 113 and COM Objects 
Reference on page 269.
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11 Using the Wavelength 
Calibration Software

The Wavelength Calibration software uses a Hydrogen Cyanide (H13C14N) 
absorption cell with 100 torr of pressure. Considered as a calibration 
reference, it covers the region from 1530 nm to 1560 nm and uses 16 very 
precise lines to perform the calibration.

This software performs scans using the H13C14N cell as a DUT and 
compares the measured spectral values with the certified spectral values. 
The software then analyses the average deviation and calculates a 
correction factor to be applied to the calibration of the IQS-9401 
Wavelength Reference Module (WRM).

Overview of the Application
The application's interface is divided into several steps; each step must be 
performed correctly before gaining access to the next step. Because the 
application is based on a Wizard (i.e. Next and Back buttons are used to 
move from window to window), the Next button is not available until the 
step has been completed. 

Simply follow the Wizard to determine which step to perform: the step to 
perform and that is in progress will be displayed in bold; and a green 
checkpoint will appear to the left of the steps already completed.

The Stop button is available only during certain steps, which are 
Wavelength Response, Reference and Acquisition. A progress bar as well 
a message will always be present above this control indicating the 
operation presently in progress.

If necessary, online help is available by clicking Help, then Online Manual. 
In addition, the Quit button is accessible at all times.

To start the application:

from the Start menu, select Programs >EXFO >IQS-12004B >Tools > 
IQS-12004B Wavelength Calibration.
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Initializing the Modules
The following window appears, allowing you to proceed with the 
Initialization step.

When the Initialization button is selected, all modules present in the 
system will be initialized. Once initialization has been successfully 
performed, you will be able to access the next step, Preparing 
Calibration.

When the Tools button is selected, only the IQS-9401 WRM will be used. 
This step has two functions: 

To save a copy of the calibration file in the directory of your choice.

To replace the current calibration in the IQS-9401 WRM module with a 
new one, i.e. the Factory Default or one from a previous calibration 
file.
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Preparing the Calibration
The second step, Preparing Calibration, is divided into three sub-steps:

Detector Null

Wavelength Response

Reference

These three steps must be successfully completed before gaining access to 
the next step. A description of each of these sub-steps is provided in the 
following window.

The Show Monitor button is used to show the power readings of each 
IQS-1600 Power Meter and IQS-9401 WRM, in real time. The window can 
be left open during the entire procedure, as it is not accessible during 
Acquisition. Also, the Stop button is accessible only while Wavelength 
Response and Reference testing are being performed.
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Nulling Electrical Offsets

The offset nulling process provides a zero-power reference measurement, 
thus eliminating the effects of electronic offsets and dark current due to 
detectors.

Temperature and humidity variations affect the performance of electronic 
circuits and optical detectors. For this reason, EXFO recommends 
performing a nulling of the electrical offsets whenever environmental 
conditions change.

The nulling is performed on all channels of the IQS-1600 Power Meters as 
well as those on the IQS-9401 WRM. It is important to put protective caps 
on all channels on these modules. Using the Turn Source Off option 
avoids having to disconnect rigid patchcords; when used, you must wait at 
least 30 minutes after the source is turned on to allow it to warm up.

Wavelength Response

The wavelength response is the system's wavelength calibration. 

If it has already been performed (by the IQS-12004B DWDM Passive 
Component Test System system), this sub-step can be skipped. Therefore, 
the same calibration measurements will be used and the message 
Not required will appear.

However, if it has not already been performed, the IQS-9401 WRM output 
must be connected to the first channel of the first IQS-1600 Power Meter, as 
indicated to the right of the Perform WR button. The Wavelength Response 
sub-step follows the order of the channels, from first to last. In addition, if a 
IQS-5150 Polarization State Adjuster is present in the system, the Optimize 
Power command will be performed prior to calibration.

IMPORTANT
Light must not reach the detector when nulling offsets.
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Reference

A power reference on the IQS-12004B DWDM Passive Component Test 
System must be performed once a Nulling or a Wavelength Response has 
been performed. The reference will be preceded by a power optimization, 
if the software detects the presence of an IQS-5150 PSA and if the 
Wavelength Response was not required. Once the reference has been 
taken, you will be able to access the next step, Acquisition.

Performing the Acquisition
During this step, different connections must be made, that is, the 
absorption cell must be connected to the output of the IQS-9401 WRM as 
well as positioning the output of the cell in the first channel of the first 
IQS-1600 Power Meter. You can enter the serial number of the NIST cell that 
you are using for the test in the Wavelength Reference Cell S/N box. 
A minimum of 20 scans is required, after which you can access the next 
step, Analysis. The Stop button may be used at any time.

NIST cell’s serial 
number 
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Analyzing the Results
The Analysis step analyses acquisitions taken, providing a result for 16 
lines; the average of these results determines the average deviation to be 
applied to all of the calibration constants on the IQS-9401 WRM. The first 
column of Results lists the wavelengths that have been certified in 
nanometers, and the second lists the deviation detected by the system, in 
picometers. The average deviation found is the value, in picometers, that 
will be applied to all calibration constants of the IQS-9401 WRM module. 

If the cell was not connected during the Acquisition procedure, no results 
will be available (N/A) and an error message will be displayed. In addition, 
if one or several of the 16 lines were not detected on one or several of the 
20 acquisitions, the same error message will be displayed. If application of 
the average deviation is desired, the next step, Calibration Tools, will 
become available to perform it.
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Using Calibration Tools
There are two ways to access this step: 

By clicking Tools during the first step.

By carrying out the entire process.

Apply New: writes the new calibration constants found for the 
IQS-9401 WRM module and displays a calibration certificate. For more 
information on the calibration certificate, see Viewing and Printing a 
Calibration Certificate on page 146. However, if the whole process is 
not performed, you will not be able to access the Apply New button 
because no calibration constants have been found. 

Apply Old: Accessible even if the whole calibration process is not 
performed. It re-writes calibration constants, by applying an old 
calibration file or the Factory Default. 

Save Current: Accessible even if the whole calibration process is not 
performed. It allows you to save the current calibration constants to a 
binary file identified with the following format name: 
SerialNumber-Date-Hour.dat.
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Viewing and Printing a Calibration Certificate
Once the calibration is complete, you may find it useful to view and/or print 
calibration information.

To view a calibration report:

Click Apply New. The Calibration Report window is displayed.

Navigation controls 

Zoom options
Default printer button

Printer button
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Viewing and Printing a Calibration Certificate
To browse through the document:

Use the  and  buttons. You can also adjust the zoom factor with the 
 button.

To print the certificate:

Use the  button to send it to the default printer or the Print button to 
send it to a printer you will have selected.

To come back to the calibration tool:

Click Close.
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12 Using the Power Meter 
Linearity Verification Tool

Results’ accuracy is influenced by the linearity of the power meters used in 
your system. Ideally, the readings of a power meter should be accurate at 
each power level. 

The Power Meter Linearity Verification tool has been designed to detect 
changes in linearity, ensuring that you get the best possible results from 
your IQS-12004B DWDM Passive Component Test System.

If the linearity of a power meter seems inappropriate, please contact EXFO. 
For information, see Contacting the Technical Support Group on page 223.

The linearity verification is accomplished by comparing the values read 
from the power meter to be tested to the readings taken from a calibrated 
power meter, acting as a reference.

IMPORTANT
To optimize results’ accuracy, EXFO recommends that you perform a 
linearity verification every six months or at least once per year.
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Using the Power Meter Linearity Verification Tool
The following diagram illustrates the steps of a typical linearity verification 
sequence that can be performed with the tool.
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Starting and Exiting the Application
Starting and Exiting the Application
To start the application:

from the Start menu, select Programs >EXFO >IQS-12004B >Tools > 
IQS-12004B PM Linearity Verification.

The Instruments window is displayed.

Closing any application that is not currently being used is a good way to 
free up system memory.

To close the Power Meter Linearity Verification tool:

Click  (in the top right corner of the main window).

Click Exit located at the bottom of the function bar.

Results
graph

Results grid

Actual power

Instructions
guiding you

through
testing
process

Test
definition

controls

Non-editable test parameters

Function bar

Non-editable test parameters
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Connecting the Modules for Linearity Testing
With the Power Meter Linearity Verification tool, you can test one or many 
power meters. Since verification is performed on one power meter at a 
time, the connections remain the same, regardless of the number of 
modules to be verified. Only the connections for the device channels will 
change.

This tool is associated with the following EXFO’s calibration kits.

If you are using IQ modules,

If you are using IQS modules,

For more detailed information, please contact EXFO (see Contacting the 
Technical Support Group on page 223).

CAUTION
Never insert or remove a module while the controller or expansion 
unit is turned on. This will result in immediate and irreparable 
damage to both the module and unit.

IQ-3100
Variable Attenuator

IQ-9600
1x2 Coupler

IQ-1643T
Power Meter

Calibration kit: CKT-10 X X

Calibration kit: CKT-11 X X X

IQS-3100
Variable Attenuator

IQS-9600
1x2 Coupler

IQS-1643T
Power Meter

Calibration kit: CKT-20 X X

Calibration kit: CKT-21 X X X
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Connecting the Modules for Linearity Testing
The following diagram illustrates how to link the required modules.

Connect synchronization cables (the black ones) between: 

The IQS-9401 Wavelength Reference Module (WRM) and the power 
meter to be tested.

The power meter to be tested and the reference power meter.

You can use standard patchcords for optical connections. However, to 
ensure more stability during the verification, you may prefer to use the 
supplied semi-rigid patchcord to connect the optical source output port to 
the In port of the Wavelength Reference Module.

IQS-1643T
Power Meter

IQS-9600
1X2 Coupler

IQS-1643T
Power Meter

IQS-2600CT
(1550nm)

IQS-3100
Variable

Attenuator

IQS-9401
WRM

2

1

C

IN

OUT

IN

OUT

Synchronization 
cables

Calibrated power meter acting as a reference

Power meter(s) 
to be tested

1x2 coupler, distributing optical power to the 
DUT and the reference power meter
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Initializing Hardware
Once the required modules have been properly inserted into the system 
and properly connected, a hardware detection is necessary before being 
able to perform linearity verifications. 

To start the initialization, simply click Init from the Test panel.
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Nulling Electrical Offsets
The offset nulling process provides a zero-power reference measurement, 
thus eliminating the effects of electronic offsets and dark current due to 
detectors.

Temperature and humidity variations affect the performance of electronic 
circuits and optical detectors. For this reason, EXFO recommends 
performing a nulling of the electrical offsets whenever environmental 
conditions change.

This operation allows to perform an electrical zero measurement on both 
external (IQS-1643/1643T) and internal (IQS-9401 WRM) power meters. 
Null measurement ensures accuracy of the power readings by taking a 
measurement while protective caps are put on all power meters’ 
detectors. A correction factor is determined and applied to any future 
measurement.

Note: You don’t have to disconnect any patchcord except the DUT when 
performing a null measurement. Once the nulling is started, the source will 
automatically stop emitting.

IMPORTANT
Light must not reach the detector when nulling offsets.
DWDM Passive Component Test System 155



Using the Power Meter Linearity Verification Tool
Nulling Electrical Offsets
To perform a nulling:

1. Put protective caps on power meter detectors as described in the 
Instructions zone.

2. Click Nulling to start the null measurement. The nulling is performed 
on all power meters at the same time. 

When the operation is complete, the Start button becomes enabled 
and the Instructions zone indicates that the tool is ready for linearity 
verification.

Note: Once the hardware initialization is complete, you can perform a nulling at 
any moment, except during an acquisition.
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Selecting the DUT and Reference Power Meter
Selecting the DUT and Reference Power Meter
In order to perform a linearity verification, you need to specify which 
power meter has to be tested (DUT) and which power meter will act as a 
reference.

Note: You must have performed the hardware initialization and the nulling 
before being able to select power meters.

To select the DUT, use the up/down arrows next to the Power meter: 
box from the DUT panel.

To select the reference power meter, use the up/down arrows next to 
the Reference Power Meter: box from the Settings panel.

IMPORTANT
Any power meter can be used as a reference power meter. However, 
to avoid erroneous results, make sure that the module you intend 
to use as a reference has been properly calibrated.

Power meter
to be tested

Calibrated power meter acting as a reference
DWDM Passive Component Test System 157



Using the Power Meter Linearity Verification Tool
Setting Up the Acquisition Parameters
Setting Up the Acquisition Parameters
The linearity verification is made by comparing results obtained when 
attenuating the power level on a power meter to be tested and a reference 
power meter.

The power direction can be decreasing, increasing or both (a specific trace 
will be displayed and values will be added to the results grid for each of the 
power directions). 

If you select both directions, the decreasing values will be displayed first. 
The increasing values will be added just after.

Power direction

First power value in 
dBm

(for a specific 
acquisition)

Last power value in 
dBm

(for a specific 
acquisition)

Attenuation

Decreasing Max power valuea

a. Power value obtained when variable attenuator is set to the lowest (attenuation) value supported

Min power valueb 

b. Minimum power threshold allowed by the application

Increases

Increasing Min power valueb Max power valuea Decreases

Actual power

Minimum power threshold (non-editable)
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Note: Since the maximum power value is not equal to 0 dBm, the last power 
value displayed on the graph and in the grid will be less than the minimum 
power value. However, values under –55 dBm are not taken into account 
when determining channel status.
E.g.:
maximum power = –5 dBm
minimum power allowed = –55 dBm
last power value displayed = –60 dBm

On each acquisition, attenuation will be increased and/or decreased of a 
value corresponding to the increment (in dB) that you will have specified 
during parameter setup.

To set up acquisition parameters: 

1. Ensure that the appropriate DUT and reference power meter are 
selected. For more information, see Selecting the DUT and Reference 
Power Meter on page 157.

2. Select the power direction: Decreasing and/or Increasing.

3. Select the attenuation increment by using the up/down arrows next to 
the Attenuation step box.

Attenuation 
increment

Power 
directions
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Verifying Linearity on a Specific Channel
Linearity must be verified on each channel of the power meter to be 
tested. After each acquisition, a linearity value is calculated:

reference power meter result – DUT result = linearity value

The channel status (Pass/Fail) will be determined by comparing the 
obtained value to the limit linearity (value appearing on the upper right of 
the Instrument function tab). 

The channel will be tagged as Pass if

otherwise, it will be identified as Fail.

IMPORTANT
Linearity values obtained when power is under –55 dBm are not 
taken into account when determining the channel status, due to 
the power meter specifications.

Current 
channel 
status

Pass/Fail 
criterion 
(non-editable)

obtained linearity permitted limit≤
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To verify linearity on a specific channel:

1. Ensure that the acquisition parameters are properly set. For more 
information, see Setting Up the Acquisition Parameters on page 158.

2. If necessary, select the channel number from which you want the 
verification to start, using the up/down arrows next to the Channels: 
box from the DUT panel.

Note: You don’t have to specify a channel for the reference power meter since 
channel 1 always acts as the reference channel.

IMPORTANT
Starting a new acquisition (on a new channel) will remove all 
previous data from memory and will overwrite the previous results 
file. 
To prevent unwanted data loss, specify a new results filename and 
save your report file before starting a new acquisition.

Entry zone

Browse button

DUT and reference power meter 
information block

Channel to
verify

Automatic report 
printing after test

Start 
button

Save report
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3. If you need to save the results for future use in a spreadsheet, specify a 
new filename. You can directly type it in the entry zone or use the 
browse button. If you use the name of an already-existing file, the data 
related to the previous test will be lost.

If you want information about the DUT and reference power meter to 
be added at the beginning of the file, choose Header from the Results 
File panel.

4. To be able to view and print a report with the data that will be obtained 
for the new channel, choose Save from the Report panel.

Note: It is also possible to save a report from the Reports function tab. However, 
this operation must be made before verifying another channel.

The saved file will automatically be named in the following format:

5. Connect the patchcord between the coupler and the channel to be 
tested.

6. Use the Start button from the Test panel to start the verification. The 
results will be displayed both in a graph and in a grid. 

If both increasing and decreasing power directions were chosen, the 
tool will take all the measurements for decreasing and then all the 
measurements for increasing.

7. Repeat steps 1 to 6 for each channel of the DUT.

0128007-39_Increase_Ch1.rp

Power 
direction

Serial number

Report file 
extension

Channel number
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Viewing and Printing Test Results
The Power Meter Linearity Verification tool offers two ways of using test 
results:

In an external spreadsheet (using the generated .txt file).

In the supplied report tool.

In both cases, test results include:

DUT power in dBm.

Reference power in dB.

DUT power in dB.

Linearity in %.

Linearity in dB.

Page 
display 
mode
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To view a test report from the Power Meter Linearity Verification 
tool:

1. Select the Report function tab.

2. If the desired report is not already displayed, choose Open from the 
File panel.

You can use  and  to browse the document. 

You can also adjust the page display using the up/down arrows next to the 
page display mode box.

If necessary, the report file can be saved by using the Save button.

To print a test report:

1. If necessary, select the Report function tab.

2. If the desired report is not already displayed, choose Open from the 
File panel.

3. Use the Print button to send the report to the default printer. An error 
message is displayed if no printer has been installed on the system.

Note: If you want the data report to be automatically printed at the end of the 
test, go to the Instrument function tab and select Print from the Report 
panel.
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Viewing Online User Guide
You can read the user guide online with Acrobat Reader.

To view the user guide, use the Help button at the bottom of the function 
bar.
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Getting Technical Support Information
The About function tab provides useful information such as application 
version, phone numbers and active Internet links to EXFO’s Technical 
Support Group. Use these links to send an information request by e-mail or 
to access EXFO’s web site. 
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13 Automating or Remotely 
Controlling the System

The IQS-12004B DWDM Passive Component Test System gives you the 
opportunity to develop your own applications using either SCPI commands 
(GPIB control) or COM objects.

The provided SCPI commands give access to the standard DWDM Passive 
Component Test System features. The Acq12004B dll provides the 
necessary COM objects to access either the standard DWDM Passive 
Component Test System or the multipath testing option features.

In order to be able to tests including IL, ORL, and PDL measurements with 
the standard DWDM Passive Component Test System or the MultiPath 
Testing Option, there are a number of required steps and procedures to 
follow. 
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A typical test sequence would be similar to the flow chart below.

Each time a new test sequence is started, the reference step is highly 
recommended.

Each step is further explained in the following pages.

Calibrate system
IL/PDL
ORL

Reference system
IL/PDL
ORL

Test DUT

Optimize power

Initialize hardware

Null power meter

Select input port

Measure/analyze

Retrieve data

C
yc

lin
g 

us
in

g 
th

e 
sw

it
ch

Test DUT

Retrieve results

Standard IQS-12004B 
DWDM Passive 
Component Test System 
(one DUT at a time)

MultiPath Testing 
option (possibility of 
several DUTs at a time)
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Initializing the Hardware
Perform this step each time you start the application. If modules are not 
initialized, the system cannot take any measurements and therefore 
provide results. 

The minimum hardware components required are:

Tunable laser source (IQS-2600B or IQS-2600CT).

Wavelength reference module (IQS-9401).

Power meter (IQS-1643T), one or more.

If you want to use the MultiPath Testing option, will also need a switch 
(either the IQS-9100, or a GPIB-controlled switch. Check with EXFO to 
see if a specific model is supported.).

This hardware configuration will allow you to perform IL and ORL 
measurements. Optional hardware components:

Polarization State Adjuster (IQS-5150), which allows PDL 
measurements.

Switch if you do not intend to work with the MultiPath Testing option.

The COM method associated with this step is InitHardware (see page 287).

The SCPI command associated with this step is INITialization:INITialize 
(see page 233).
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Nulling Electrical Offsets
To obtain the best possible results, it is recommended to perform a nulling 
of the power meters and wavelength reference module. During this 
operation, no light should reach the detectors. For more information, see 
Nulling Electrical Offsets on page 124 and Nulling Electrical Offsets on 
page 75.

The COM method associated with this step is Nulling (see page 287).

The SCPI command associated with this step is CALibrationNULLing (see 
page 245).

Optimizing the Power
This step is required to ensure that we have the maximum dynamic range 
when the IQS-5150 module is present. If this step is not performed, power 
may not come out of the IQS-5150 module and, therefore, the system will 
not be able to calibrate properly and provide any valid measurements.

The COM method associated with this step is OptimizePower 
(see page 288).

The SCPI command associated with this step is 
PolarizationStateAdjuster:MAXimum (see page 263).
170 IQS-12004B



Automating or Remotely Controlling the System
Calibrating the System
Calibrating the System
During calibration step, you can perform:

Wavelength response (IL/PDL) calibration

Return Loss (ORL) calibration

For more information on the calibration of the standard IQS-12004B DWDM 
Passive Component Test System, see Calibrating the System on page 73.

In multipath testing, the wavelength response is taken by connecting each 
detector to switch port 1 during these steps.

IQ-2600

or 
IQS-2600CT

Source

IQS-5150

Polarization 
State 
Adjuster 
(optional)

IQS-9401

Wavelength 
Reference 
Module

IQS-9100

Switch

IQS-1643T

Power Meter
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For more information on calibration with the MultiPath Testing option, see 
Calibrating the System Wavelength Response on page 125 and Calibrating 
your System for ORL Testing on page 127.

The COM methods associated with this step are CalWr (see page 278), 
CalOrlRtj (see page 277), CalOrlMandrelRtj (see page 277).

The SCPI commands associated with this step are 
CALibration:WavelengthResponse:ACQuisition (see page 244), 
CALibration:ORLRtj (see page 246), CALibration:ORLMandrelrtj (see page 
248).
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Referencing the System
If you are working with the standard DWDM Passive Component Test 
System, each time the system is turned on, a reference measurement 
has to be performed.

This reference measurement takes into account any power fluctuation 
that occurred since the system was last used (e.g., connection and 
reconnection of rigid and semi-rigid patch cords, power optimization). 

If you are working with the multipath option, you do not have to 
perform a reference measurement each time the system is turned on.

The reference measurement takes into account any power fluctuation 
that occurred since certain operations were performed on the system 
(e.g., connection and reconnection of rigid and semi-rigid patch cords, 
power optimization).

Note: To obtain good results, EXFO recommends that you to regularly perform 
reference measurements. EXFO also recommends to perform a reference 
measurement when the test system is used non-stop during a long period 
of time or when there are important variations in environmental 
conditions.

For more information on referencing of the standard IQS-12004B DWDM 
Passive Component Test System, see Performing Reference Measurements 
on page 82.
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In multipath testing, reference scans are performed by connecting each 
switch port to detector 1 of the power meter during this step.

Note: To ensure better results, EXFO recommends that you use a different 
patchcord for each switch port. This will avoid disconnecting the 
patchcords from the switch once the reference is complete.

For more information on referencing the system with the MultiPath Testing 
option, see Performing Reference Measurements on page 129.

The COM methods associated with this step are RefIl (see page 278), 
RefIlPdl (see page 279), RefOrlMandrel (see page 279).

The SCPI commands associated with this step are REFerence:IL (see page 
249), REFerence:ILPDl (see page 250), REFerence:ORLM (see page 251).

IQ-2600

or  
IQS-2600CT

Source

IQS-5150

Polarization 
State 
Adjuster 
(optional)

IQS-9401

Wavelength 
Reference 
Module

IQS-9100

Switch

IQS-1643T

Power Meter
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Testing the DUT
Once the previous steps have been successfully completed and the 
device(s) under test—DUT(s)—have been properly connected, the system 
is ready to perform IL, PDL, and ORL measurements of the DUT(s). 

Note: Only the MultiPath Testing option allows you to test more than a device at a 
time and devices having a variable number of In ports and Out ports.

For more information, see Connecting DUT and Modules on page 67 and 
Starting the ORL Measurement Scan on page 69. 

With the MultiPath Testing Option, the DUT(s) have to be connected 
between the power meter and the switch. 

The COM properties and methods associated with this step are Position 
(see page 341), AcqIlDut (see page 274), AcqIlPdlDut (see page 275), 
AcqOrlMandrelDut (see page 275).

The SCPI commands associated with this step are ACQuisition:IL (see page 
253), ACQuisition:ILPDl (see page 253), ACQuisition:ORL (see page 254).
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Retrieving Results
Once the measurements have been performed, it is possible to retrieve IL, 
PDL, ORL curves. These curves are returned in separate commands (one 
for the IL, one for the PDL, and one for the ORL).

With the provided COM objects, it is also possible to retrieve single-value 
results such as:

Flatness

Bandwidth

Central wavelength

IL, ORL, PDL

Polarization-dependent central wavelength

Polarization-dependent central bandwidth

Crosstalk

The availability of these single-value results depends on the DUT filter type 
(bandpass, notch or undefined).

Note: Single-value results cannot be retrieved using SCPI commands.

Controlling Instruments with GPIB
The GPIB communication protocol was designed to connect computers so 
that information could be transmitted between them. The GPIB interface 
developed for the IQS-12004B DWDM Passive Component Test System 
permits you to remotely control the DWDM Passive Component Test 
System modules. To do so, a GPIB controller card must be installed in your 
computer.
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Starting the GPIB Remote Application
The supplied GPIB remote application allows you to:

Set the GPIB parameters.

Open/close a GPIB connection.

View the GPIB commands received.

Edit, log and print information.

Monitor power meters.

To start the DWDM Passive Component Test System GPIB application, 
double-click the IQS-12004B GPIB icon on your desktop.

Note: The IQS-12004B DWDM Passive Component Test System and the 
IQS-12004B GPIB application cannot run at the same time. 

This remote application is further explained in the following pages.
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Modifying GPIB Parameters
To modify the default GPIB settings:

1. Select GPIB Settings from the Communication menu. The GPIB 
Settings window appears.

2. Enter the desired parameters and click OK to save the new settings. 

Note: GPIB Address and Board ID cannot be modified when the GPIB 
connection is opened. 

GPIB Address: The primary address assigned to the GPIB card 
(ranging from 0 to 30). A secondary address is automatically 
assigned and is set to 0. 

Board ID: The GPIB card identification name as set in the system 
properties. The available options are: GPIB 0, GPIB 1, GPIB 2, and 
GPIB 3.

EOS: The end-of-string code sent as the last byte of a data 
message. The available options are: Disable, CR (carriage return), 
LF (line feed), and CR/LF (carriage return-line feed combination). 

Time Out: The maximum time allowed for the system to reply to a 
command. If the system does not respond according to the time 
set, an error message appears. Available choices are: Disable as 
well as values in microseconds (μs), milliseconds (ms), and 
seconds (s).

All the parameters are saved in the system until a new GPIB connection is 
opened.
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Opening a GPIB Connection
Once the GPIB application is started, you will need to open a new 
connection.

To open a new connection, select Open Connection from the File menu. 
The IQS-12004B GPIB main window appears and the status bar displays 
Ready.
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When a GPIB command is sent to the DWDM Passive Component Test 
System, information about the command appears in the IQS-12004B GPIB 
main window.

The information contained in the different columns is explained below:

#: This column indicates the request number.

GPIB Calls: This column indicates the name of the command received 
and its parameters, if any.

Results: This column provides a description of the command. If an 
error occurred, the error number as well as a description of the error 
will be displayed in red.

Time: This column indicates the time when the command was 
received by the system.

ibsta: This column indicates the state of the GPIB card. For more 
information, refer to the GPIB card instructions manual NI-488.2 
Function Reference Manual for Windows, in the Status Word 
Conditions chapter. 
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iberr: This column indicates if an error occurred on the GPIB bus. For 
more information, refer to the GPIB card instructions manual NI-488.2 
Function Reference Manual for Windows, in the Error Codes and 
Solutions chapter.

ibcntl: This column indicates the number of characters in the 
command. For example, *IDN? contains 5 characters.

Closing a GPIB Connection
To close the connection, select Close Connection from the File menu. The 
status bar displays Disconnected.

Editing GPIB Information
To edit the information that appears in the GPIB main window:

1. Select the desired row(s) of information.

2. In the Edit menu, select Cut, Copy, or Delete whether you want to 
remove, copy or erase selected rows of information. 

To edit all the rows of information, choose Select All.

Note: You can also access the Edit menu by right clicking your mouse. 
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Logging GPIB Information
To save GPIB information in a log file:

1. Select Options from the Communication menu.

2. Check the Save to history file box.

3. If you want to change the default folder where the log file will be saved, 
click Browse and select the desired folder.

4. Click OK when you are done. 

Monitoring the Power Meter
To view the power of each wavelength reference module and 
power meter channels:

1. Select Power Meter IQS-1600 Monitor from the View menu. The 
Power Meter Monitor window may be accessed only when the 
modules are initialized.

2. Select the desired measurement unit in the list box (dBm or watt).

3. Click Close to exit the window.
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Printing GPIB Information
Once you have viewed the information on the IQS-12004B GPIB main 
window, it is possible to print a report.

To print a report:

1. Select Print from the File menu. The Print window appears. 

2. Select the correct printer in the Name list box.

3. In the Print range section, select All if you want to print all the 
information appearing in the main screen, or Selection if you want to 
print the rows of information you selected.

4. Click OK to print the report.
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GPIB Command Structure
The GPIB commands follow the guidelines determined by the Standard 
Commands for Programmable Instruments (SCPI) consortium. For 
example, the 

CONF:CHAN<wsp><number channels> command syntax

is used to change the number of channels to test in the IQS-12004B DWDM 
Passive Component Test System.

In this example,

CONF identifies that the command is part of the SCPI CONFiguration 
subset of commands.

CHAN is a keyword that define the function of the command.

<wsp> is included to indicate that a space is required (wsp stands for 
white space).

<number channels> is the command parameter.

Keywords must be separated by a colon. A typical command would be

CONF:CHAN 4

This command instructs the system to test four channels in one 
acquisition.
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To enter commands or queries you must use either the full word for the 
command, or the three- or four-letter shortcut. Commands are not 
case-sensitive, however spelling errors will cancel the command or query.

The command or query can be written using only shortcuts, only full 
words, or a combination of both.

Other command syntax elements are:

The comma, which is used to separate values in a command or query.

The semi-colon, which is used to separate commands or queries, 
when you send more than one at a time.

Note: It is recommended that you retrieve the response immediately after 
each query.
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GPIB General Commands—Quick Reference
The SCPI Manager recognizes the main commands identified in IEEE-488.2. 
The table below summarizes these commands. For more information 
about general commands, see General Commands on page 231.

Command Function

*CLS Clear last error

*ESE Not supported

*ESE? Not supported

*ESR? Not supported

*IDN? Identification query

*LOK Not supported

*OPC Not supported

*OPC? Operation complete query

*REM Not supported

*RST Not supported

*SRE Not supported

*SRE? Not supported

*STB? Not supported

*TRG Not supported

*TST? Not supported

*WAI Not supported
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GPIB Specific Commands—Quick Reference
The following table contains a summary of the IQS-12004B DWDM Passive 
Component Test System specific commands. If you need more information 
about these specific commands, see Specific Commands on page 233.

Command Parameter/Response Description

INIT INIT -- This command performs an 
initialization of all IQS modules.

INIT? (0 | 1) The response to this query indicates 
if an initialization of the modules 
has been performed.

SIMU <0 | 1> This command sets the system to 
simulation mode.

SIMU? (0 | 1) The response to this query indicates 
if the system is in simulation mode.

CONF AVAC? (999) The response to this query indicates 
the number of available channels in 
the system.

CHAN <999 > This command sets the number of 
channels to test.

CHAN? (999) The response to this query indicates 
the number of channels to test.

ACQT <1 | 2 | 3 | 4> This command sets the acquisition 
type.

ACQT? (1 | 2 | 3 | 4) The response to this query indicates 
the acquisition type.

CONF KIL <0 | 1> This command keeps IL curves for 
all SOP, when a PDL acquisition has 
been performed.

KIL? (0 | 1) The response to this query indicates 
if IL curves are kept for all SOP.
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ARF <0 | 1> This command sets the filtering 
mode.

ARF? (0 | 1) The response to this query indicates 
the filtering mode.

MINW? (9999.999) The response to this query indicates 
the minimum wavelength (in nm) 
available in the system.

MAXW? (9999.999) The response to this query indicates 
the maximum wavelength (in nm) 
available in the system.

STAR <9999.999> This command sets the position (in 
nm) where to start the acquisition.

STAR? (9999.999) The response to this query indicates 
the position (in nm) where to start 
the acquisition.

STOP <9999.999> This command sets the position (in 
nm) where to stop the acquisition.

CONF STOP? (9999.999) The response to this query indicates 
the position (in nm) where to stop 
the acquisition.

CAL WR CHAN <999> This command sets the active 
channel for the wavelength 
response calibration acquisition.

CHAN? (999) The response to this query indicates 
the active channel for the 
wavelength response calibration 
acquisition.

ACQ -- This command performs a 
wavelength response calibration on 
the active channel.

Command Parameter/Response Description
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ACQ? (0 | 1) The response to this query indicates 
if a wavelength response calibration 
has been performed.

NULL -- This command performs a nulling 
on the power meter and wavelength 
reference module channels.

ORLR -- This command performs an ORL 
calibration with a reference test 
jumper.

CAL ORLR? (0 | 1) The response to this query indicates 
if an ORL calibration with a 
reference test jumper has been 
performed.

STOP -- This command stops the current 
calibration acquisition.

ORLM -- This command performs an ORL 
calibration acquisition with mandrel 
and reference test jumper.

ORLM? (0 | 1) The response to this query indicates 
if an ORL calibration acquisition 
with mandrel and reference test 
jumper has been performed.

REF ORLM -- This command performs an ORL 
reference acquisition using a 
mandrel.

ORLM? (0 | 1) The response to this query indicates 
if an ORL reference using a mandrel 
has been performed.

STOP -- This command stops the current 
reference acquisition.

Command Parameter/Response Description
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IL -- This command performs an IL 
reference acquisition.

REF IL? (0 | 1) The response to this query indicates 
if an IL reference acquisition has 
been performed.

ILPD -- This command performs a PDL 
reference acquisition.

ILPD? (0 | 1) The response to this query indicates 
if a PDL reference acquisition has 
been performed.

TEST AVAT? (1 | 2 | 3 | 4 | 5 | 6) The response to this query indicates 
which test can be performed 
according to the modules detected, 
the calibration, and the reference.

CLR -- This command clears the last IL, 
PDL, and ORL results.

ACQ IL -- This command performs an IL 
acquisition on the DUT.

ILPD -- This command performs a PDL 
acquisition on the DUT.

ORL -- This command performs an ORL 
acquisition on the DUT.

SYNC <99999> This command performs a 
synchronized power acquisition on 
all IQS-1600 power meters.

ACQ STOP -- This command stops the current 
acquisition on the DUT.

STAT ERR? (Error Number, 
“Error description”)

The response to this query indicates 
the last error and provides a 
description.

Command Parameter/Response Description
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READ CURV IL? x(nm), y(dB) This query reads the IL results curve 
on a specified channel.

PDL? x(nm), y(dB) This query reads the PDL results 
curve on a specified channel.

ORL? x(nm), y(dB) This query reads the ORL results 
curve.

ILPD? x(nm), y(dB) The response to this query indicates 
the IL curve for a specific SOP, when 
a PDL acquisition has been 
performed.

SYNC? PowerPoints,Status The response to this query indicates 
the power synchronized acquisition 
result curve on a specified channel.

CHAN <999> This command sets the active 
channel to read curves and the 
power meter as well as the channel 
localization information.

READ CHAN? (999) The response to this query indicates 
the active channel.

CHLO? (Slot position, Power 
Meter Channel)

The response to this query indicates 
the localization information about 
specified channels.

PM? (9999.999) The response to this query indicates 
the power meter value (in dBm) for 
the specified channel.

WRM? (9999.999,9999.999) The response to this query indicates 
the value (in dBm) of the 
wavelength reference module.

SN? (ModuleName 
SlotPosition: Serial 
Number)

The response to this query indicates 
the serial number of each module 
initialized in the system.

Command Parameter/Response Description
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SOP <0 | 1 | 2 | 3 |> This command indicates on which 
SOP to take the IL curve, when a 
PDL acquisition has been 
performed.

SOP? (0 | 1 | 2 | 3 |) The response to this query indicates 
the current SOP when reading the 
IL during a PDL acquisition.

PSA MAX -- This command optimizes the 
power.

PSA MAX? (0 | 1) The response to this query indicates 
if the power has been optimized.

SOP <0 | 1 | 2 | 3 |> This command sets a new 
polarization state on the IQS-5150 
polarization state adjuster.

SOP? (0 | 1 | 2 | 3 |) The response to this query indicates 
the current polarization state of the 
IQS-5150 polarization state adjuster.

SOUR MINW? (9999.999) The response to this query indicates 
the minimum wavelength (in nm) 
of the current source.

MAXW? (9999.999) The response to this query indicates 
the maximum wavelength (in nm) 
of the current source.

ON <0 | 1> This command turns the source ON 
or OFF.

ON? (0 | 1) The response to this query indicates 
if the source was active.

STAB? (Time) The response to this query indicates 
(in seconds) how long the source 
has been turned on.

Command Parameter/Response Description
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WAVE <9999.999> This command sets the source 
wavelength in nm.

SOUR WAVE? (9999.999) The response to this query indicates 
the wavelength (in nm) of the 
current source.

Command Parameter/Response Description
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GPIB Error Messages Format
System-and device-specific errors are managed by the IQS-12004B GPIB 
application. The generic format for error messages is illustrated below.

As shown in the above figure, the message is a string that contains two 
parts: 

Error number

Error description

All error messages are stacked in an application buffer. Use the command 
STAT:ERR? to read the most recent message. 

The error message buffer is initialized when starting the IQS-12004B GPIB 
application or when executing the *CLS command.

Error number , “Error Description”
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SCPI Error Messages
The following table contains a list of error messages.

Note: For more information about error messages, refer to the GPIB card 
instructions manual NI-488.2 Function Reference Manual for Windows.

Error Number Description

1 Unable to initialize a hardware module.

2 Unable to detect a hardware module.

3 Unable to initialize the IQS-2600CT source module.

4 Unable to initialize the IQS-9401 wavelength 
reference module.

5 Unable to initialize the IQS-5150 polarization state 
adjuster module.

6 Unable to initialize the IQS-1600 power meter 
module(s).

7 Required modules are not available or not installed.

8 Module initialization has stopped.

9 Invalid IQS-9401 calibration.

10 Unable to perform a power meter nulling.

11 Invalid power meter number. Unable to perform the 
nulling.

12 Invalid nulling type.

15 Unable to start an acquisition at this time. An 
acquisition is already in progress.

16 Unable to perform this test because some modules 
are not selected or not installed.
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17 Unable to execute another command at this time. 
Please wait until the current command is complete.

18 An inappropriate channel value has been assigned.

20 Unable to use the modules because the module 
initialization has not been done. Please initialize the 
modules.

21 Unable to perform an acquisition because the ORL 
calibration with an RTJ has not been performed. 
Please perform an ORL calibration.

22 Unable to perform an acquisition because the ORL 
calibration with a mandreled RTJ has not been 
performed. Please perform a calibration of the ORL 
with a mandreled RTJ.

23 Unable to perform an acquisition because the 
wavelength response calibration has not been 
performed. Please perform a wavelength response 
calibration.

24 Unable to perform an acquisition because the IL 
reference has not been performed. Please performed 
an IL reference.

25 Unable to perform an acquisition because the IL/PDL 
reference has not been performed. Please performed 
an IL/PDL reference.

26 Unable to perform an acquisition because the ORL 
reference has not been performed. Please perform 
an ORL reference.

27 Unable to get a curve because the acquisition result 
curve is empty. Please perform an acquisition.

28 Unable to change the polarization state because the 
power has not been optimized. Please optimize the 
power.

Error Number Description
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30 Unable to perform an acquisition because the power 
at the WRM input is too low. Please check your 
connection.

31 Unable to perform an acquisition because the power 
for the reference is too low. Please check your 
connection.

32 Unable to perform an acquisition because the power 
for the calibration is too low. Please check your 
connection.

33 The acquisition has stopped.

34 Cannot find simulator data file.

35 An inappropriate number of acquisition channels has 
been assigned.

36 Invalid ORL result curve.

37 Unable to determine a sweep span that fits with the 
sweep time.

38 Invalid scan range. The acquisition has stopped.

39 Invalid acquisition type. The acquisition has stopped.

40 Power meter synchronization error. The acquisition 
has stopped.

41 The command is not supported by the current source 
module.

42 Missing calibration parameter.

43 Missing wavelength reference calibration.

44 Missing ORL calibration.

45 The database templates are missing in the path.

46 Invalid power meter value.

47 Invalid power meter value (under range).

Error Number Description
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48 Invalid power meter value (over range).

49 The sweep cannot be performed. The laser source is 
not turned on.

52 Not available in simulator mode.

53 Number of acquisition points must be between 1 and 
32 000.

513 Invalid parameter.

514 Wrong function was called.

515 Invalid number of channels.

516 No module is initialized.

517 Unable to open the log file.

518 Error when closing the log file.

532 System error.

533 GPIB board has to be controller in charge (CIC) to 
function properly.

534 No listeners on the GPIB.

535 GPIB board not correctly addressed.

536 Invalid argument when the function is called.

537 GPIB board is not CIC, as required.

538 I/O operation aborted (Time Out).

539 GPIB board not installed.

540 Direct memory access (DMA) error.

542 Asynchronous I/O in progress.

543 Cannot operate.

544 File system error.

Error Number Description
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546 GPIB bus error.

547 Serial poll status byte queue overflow.

548 SRQ stuck in ON position.

552 Problem in table.

554 Invalid end of string terminator.

555 Unable to access the registry.

556 An IQS-12004B GPIB application is already running. 

Error Number Description
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Configuring Your DWDM Passive Component 
Test System as a GPIB Controller

At time of purchase, your IQS-12004B controller unit is configured to be 
used as a GPIB device. However, it is possible to configure it as a GPIB 
controller.

Note: The following procedure is based on Windows 2000.

To configure your IQS-12004B controller unit as a GPIB controller:

1. Uninstall the GPIB card as follows:

1a. On the Windows taskbar, click Start and select 
Settings > Control Panel.

1b. From the Control Panel, double-click the Add/Remove 
Hardware icon.

1c. From the welcome step, click Next.

1d. From the Choose a Hardware Task step, select the 
Uninstall/Unplug a device option and click Next.

IMPORTANT
Do not remove the GPIB card from the IQS-12004B controller unit.
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1e. From the Choose a Removal Task step, choose Uninstall a 
device. Click Next.

1f. From the Installed Devices on Your Computer list, choose 
PCI-GPIB. Click Next.
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1g. From the Uninstall a Device step, choose Yes, I want to uninstall 
this device. Click Next.

1h. From the Completing the Add/Remove Hardware Wizard step, 
click Finish to close the wizard. All corresponding hardware is 
removed automatically.
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2. Remove the NI-Device 1.3 Standard software as follows:

2a. From the Control Panel, double-click the Add/Remove Programs 
icon.

2b. Select the Change or Remove Programs function tab.

2c. From the list of currently installed programs, select NI-Device 1.3 
Standard and click Remove.

3. Install the NI-488.2 1.70 software as follows:

3a. Insert the installation CD-ROM in the drive.

3b. On the Windows taskbar, click Start and select Run.

3c. Use the Browse button to find the GPIB Controller folder on the 
CD-ROM, then select setup.exe.

3d. Click OK to start the installation. The installation is relatively 
straightforward: click Next until you reach the end (Finish).
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4. Restart the IQS-12004B controller unit. Once the unit has restarted, the 
following dialog box appears.

5. Test the GPIB card as follows:

5a. Check the Do not show at Windows startup box located at the 
bottom of the dialog box.

5b. Click Verify your hardware and software installation. The 
NI-488.2 Troubleshooting wizard is automatically started.

5c. Tests take about 15 seconds to complete. Wait until the Status 
field displays “passed”, and then close all windows.

The IQS-12004B controller unit can now be used as a GPIB controller.
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COM Objects
The IQS-12004B DWDM Passive Component Test System (standard) and 
the MultiPath Testing Option were developed using Microsoft Component 
Object Model (COM). COM defines a common way to access and create 
software components and services.

COM promotes the integration and the reuse of software components, as 
well as interoperability. In order to interoperate, components developed 
in different languages must adhere to a binary structure specified 
by Microsoft. 

OLE and ActiveX are based on COM. Also, programming languages such as 
C, C++, Smalltalk, Pascal, Ada, Java, and LabVIEW can create and use 
COM components. 

COM Installation

COM is installed during the IQS-12004B DWDM Passive Component Test 
System installation.

COM Example

To view how COM commands work, refer to the example provided in the 
IQS\Maestro\IQS_DWDMTS\Sample folder.
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COM Objects Overview

Except for the Switch properties and methods that are only functional with 
the MultiPath Testing Option, all properties and methods offered work with 
the standard IQS-12004B DWDM Passive Component Test System and the 
option.

The figures shown on the following pages present the entry point to use as 
well as the objects structure according to the type of programming 
language.

IMPORTANT
The provided COM objects were designed to be both used with 
programming languages that support object creation with multiple 
interfaces and with languages, like LabVIEW, that do not. 
Depending on the type of programming language you intend to 
use, you will choose the corresponding “entry point” and set of 
COM objects.
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Detailed information about the offered properties and methods can be 
found in appendix COM Objects Reference on page 269.

Programming languages not 
supporting object creation with 
multiple interfaces

IMeasure

IResults

IDwdmAcq

clsDescModule

clsChannel

Event

ISwitch

IModules

Acq12004B

ITestParameters

Object acting 
as an entry 
point

IAnalysis

Interface References

ChannelResult

BandPass

BandPassResult

Notch

NotchResult

Undefined

Available Enumerations
Only available 
with MultiPath 
Testing Option
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IQS-12004B DWDM Passive Component Test 
System (Standard) COM Error Messages

Error Number Description

ErrAcqBefore Unable to get a curve because the acquisition result curve is 
empty. Please perform an acquisition.

ErrAcqChannel An inappropriate number of acquisition channels has been 
assigned.

ErrAcqRun Unable to start an acquisition at this time. An acquisition is 
already in progress.

ErrAcqStopped The acquisition has stopped.

ErrAcqType Invalid acquisition type. The acquisition has stopped.

ErrCalOrlMandrelRtjBefore Unable to perform an acquisition because the ORL 
calibration with a mandreled RTJ has not been performed. 
Please perform a calibration of the ORL with a mandreled 
RTJ.

ErrCalOrlRtjBefore Unable to perform an acquisition because the ORL 
calibration with an RTJ has not been performed. Please 
perform an ORL calibration.

ErrCalWrBefore Unable to perform an acquisition because the wavelength 
response calibration has not been performed. Please 
perform a wavelength response calibration.

ErrCalWrm Invalid IQS-9401 calibration.

ErrChannelNumber An inappropriate channel value has been assigned.

ErrCommandNot
SupportedBySource

The command is not supported by the current source 
module.

ErrDetection Unable to detect hardware module.

ErrHardNotCompatible Unable to perform this test because some modules are not 
selected or not installed.
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ErrInit Unable to initialize a hardware module.

ErrInitBefore Unable to use modules because the module initialization 
has not been done. Please initialize modules.

ErrInitPm Unable to initialize the IQS-1600 Power Meter module(s).

ErrInitPsa Unable to initialize the IQS-5150 Polarization State Adjuster 
module.

ErrInitSource Unable to initialize theIQS-2600CT source module.

ErrInitStopped Module initialization has stopped.

ErrInitWrm Unable to initialize the IQS-9401 Wavelength Reference 
Module.

ErrInprogress Unable to execute another command at this time. Please 
wait until the current command is complete.

ErrInvalidIlCurvePolState The IL curve is not available for this polarization state.

ErrMissingCalibration
Parameter

Missing calibration parameter.

ErrMissingDBTemplate The database templates are missing in the specified path.

ErrMissingORLCalibration Missing ORL calibration.

ErrMissingWRCalibration Missing wavelength reference calibration.

ErrNoHardware Some required modules are not available or not installed.

ErrNotAvailableIn
SimulatorMode

Not available in simulator mode.

ErrNulling Unable to perform a power meter nulling.

ErrNullingIndex Invalid power meter number to perform the nulling.

ErrNullingType Invalid nulling type.

ErrNumberOfAcquisition
Points

Number of acquisition points must be between 1 and 
32 000.

Error Number Description
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ErrOptimizeBefore Unable to change the polarization state because the power 
optimization has not been performed. Please optimize the 
power.

ErrOrlResultCurve Invalid ORL result curve.

ErrPmValue Invalid power meter value.

ErrPmValueOver Invalid power meter value (over range).

ErrPmValueUnder Invalid power meter value (under range).

ErrPowerMin_PM Unable to perform an acquisition because the power at the 
power meter input is too low. Please check your 
connection.

ErrPowerMin_Wrm Unable to perform an acquisition because the power at the 
WRM input is too low. Please check your connection.

ErrPrevInstance A previous object instance is already running. Only one 
instance can run on each computer.

ErrRefIlBefore Unable to perform an acquisition because the IL reference 
has not been taken. Please take IL reference.

ErrRefOrlMandrelBefore Unable to perform an acquisition because the ORL 
reference has not been taken. Please take ORL reference.

ErrScanRange Invalid scan range. The acquisition has stopped.

ErrSimData Cannot find simulator data file.

ErrSourceNotEnabled The sweep cannot be performed. The laser source is turned 
on.

ErrSweepSpan Unable to determine a sweep span that fits with the sweep 
time.

ErrSynchro Power meter synchronization error. The acquisition has 
stopped.

Error Number Description
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MultiPath Testing Option COM Error Messages

Error 
Number Description

ErrDetection Unable to initialize the switch because the 
detection has not been performed. Please 
perform switch detection.

ErrNoHardware Some required modules are not available or 
have not been installed.

ErrMissingDBTemplate The database templates are missing in the 
specified path.

ErrMptoNotInstalled Inappropriate version of IQS-DWDMTS. Please 
install MultiPath Testing Option to use Switch 
interface.

ErrInvalidSwPort An inappropriate switch port value has been 
assigned.

ErrEmptyTrace Unable to compute curve because some input 
traces are empty.

ErrNumberRefExtTrace An inappropriate number of reference 
channels has been assigned (Reference at t=0 
is not the same as t=x).

ErrDoAnalysisBefore Unable to proceed with polarization 
dependency analysis because the standard 
analysis has not been performed. Please 
perform standard analysis before.
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14 Maintenance
To help ensure long, trouble-free operation:

Always clean fiber-optic connectors before using them.

Keep the unit free of dust.

Clean the unit casing and front panel with a cloth slightly dampened 
with water.

Store unit at room temperature in a clean and dry area. Keep the unit 
out of direct sunlight.

Avoid high humidity or significant temperature fluctuations.

Avoid unnecessary shocks and vibrations.

If any liquids are spilled on or into the unit, turn off the power 
immediately and let the unit dry completely.

WARNING
Use of controls, adjustments, and procedures for operation and 
maintenance other than those specified herein may result in 
hazardous radiation exposure.
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Cleaning Fixed Connectors
Regular cleaning of connectors will help maintain optimum performance. 
Do not try to disassemble the unit. Doing so would break the connector.

To clean fixed connectors:

1. Fold a lint-free wiping cloth in four to form a square.

2. Moisten the center of the lint-free wiping cloth with only one drop of 
isopropyl alcohol.

3. Gently wipe the connector threads three times with the folded and 
moistened section of the wiping cloth.

4. With a dry lint-free wiping cloth, gently wipe the same surfaces three 
times with a rotating movement.

5. Throw out the wiping cloths after one use.

6. Moisten a cleaning tip (2.5 mm tip) with only one drop of isopropyl 
alcohol.

IMPORTANT
Alcohol may leave traces if used abundantly. Avoid contact between 
the tip of the bottle and the wiping cloth, and do not use bottles 
that distribute too much alcohol at a time.

IMPORTANT
Isopropyl alcohol takes approximately ten seconds to evaporate. 
Since isopropyl alcohol is not absolutely pure, evaporation will 
leave microscopic residue. Make sure you dry the surfaces before 
evaporation occurs.
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7. Slowly insert the cleaning tip into the connector until it reaches the 
ferrule inside (a slow clockwise rotating movement may help).

8. Gently turn the cleaning tip one full turn.

9. Continue to turn as you withdraw the cleaning tip.

10. Repeat steps 7 to 9, but this time with a dry cleaning tip (2.5 mm tip 
provided by EXFO).

Note: Make sure you don’t touch the soft end of the cleaning tip and verify the 
cleanliness of the cotton tip.

11. Throw out the cleaning tips after one use.

IMPORTANT
Alcohol may leave traces if used abundantly. Avoid contact between 
the tip of the bottle and the cleaning tip, and do not use bottles 
that distribute too much alcohol at a time.

7
8

9
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Cleaning EUI Connectors
Regular cleaning of EUI connectors will help maintain optimum 
performance. There is no need to disassemble the unit.

To clean EUI connectors:

1. Remove the EUI from the instrument to expose the connector 
baseplate and ferrule.

2. Moisten a 2.5 mm cleaning tip with one drop of isopropyl alcohol 
(alcohol may leave traces if used abundantly).

3. Slowly insert the cleaning tip into the EUI adapter until it comes out on 
the other side (a slow clockwise rotating movement may help).

4. Gently turn the cleaning tip one full turn, then continue to turn as you 
withdraw it.

IMPORTANT
If any damage occurs to internal connectors, the module casing will 
have to be opened and a new calibration will be required.

Push

Turn

Pull

3

4 5
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5. Repeat steps 3 to 4 with a dry cleaning tip.

Note: Make sure you don’t touch the soft end of the cleaning tip.

6. Clean the ferrule in the connector port as follows:

6a. Deposit one drop of isopropyl alcohol on a lint-free wiping cloth.

6b. Gently wipe the connector and ferrule.

6c. With a dry lint-free wiping cloth, gently wipe the same surfaces to 
ensure that the connector and ferrule are perfectly dry.

6d. Verify connector surface with a portable fiber-optic microscope 
(e.g., EXFO’s FOMS) or fiber inspection probe (e.g., EXFO’s FIP).

7. Put the EUI back onto the instrument (push and turn clockwise).

8. Throw out cleaning tips and wiping cloths after one use.

IMPORTANT
Isopropyl alcohol may leave residues if used abundantly or left to 
evaporate (about 10 seconds).

Avoid contact between the tip of the bottle and the wiping cloth, 
and dry the surface quickly.

WARNING
Verifying the surface of the connector WHILE THE UNIT IS ACTIVE 
WILL result in permanent eye damage.
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Cleaning Detector Ports
Regular cleaning of detectors will help maintain measurement accuracy.

To clean detector ports:

1. Remove the protective cap and adapter (FOA) from the detector.

2. If the detector is dusty, blow dry with compressed air.

3. Being careful not to touch the soft end of the swab, moisten a cleaning 
tip with only one drop of isopropyl alcohol.

4. While applying light pressure (to avoid breaking the detector window), 
gently rotate the cleaning tip on the detector window.

5. Repeat step 4 with a dry cleaning tip or blow dry with compressed air.

6. Discard the cleaning tips after one use.

Cleaning Fiber Ends
To ensure optimum performance and avoid erroneous acquisitions, the 
fiber-optic cable end should be cleaned at all times. 

To clean the fiber end:

1. Gently wipe the end with a lint-free swab dipped in isopropyl alcohol.

2. Dry using clean compressed air.

IMPORTANT
Always cover detectors with protective caps when unit is not in use.

IMPORTANT
Alcohol may leave traces if used abundantly. Do not use bottles that 
distribute too much alcohol at a time.
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Recalibrating the Unit
Manufacturing and service center calibrations are based on the 
ISO/IEC 17025 Standard, which states that calibration documents must not 
contain a recommended calibration interval, unless this has been 
previously agreed upon with the customer.

Validity of specifications depends on operating conditions. For example, 
the calibration validity period can be longer or shorter depending on the 
intensity of use, environmental conditions and unit maintenance. You 
should determine the adequate calibration interval for your unit according 
to your accuracy requirements.

Under normal use, EXFO recommends calibrating your unit every year.

Disposing of Old CKT Modules
Your DWDM Passive Component Test System uses a wavelength-reference 
absorbtion cell (CKT module), which contains Hydrogen Cyanide 
(H13C14N). If you ever need to dispose of CKT modules, be very careful.

WARNING
Since CKT modules contain Hydrogen Cyanide, do NOT dispose of 
old modules in municipal waste. Follow all applicable laws and 
regulations governing disposal.
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Recycling and Disposal 
(Applies to European Union Only)

Unless otherwise noted in a separate agreement between EXFO and a 
customer, distributor or commercial partner, EXFO will cover costs 
related to the collection, treatment, recovery and disposal of 
end-of-lifecycle waste generated by electronic equipment introduced 
after August 13, 2005 to an European Union member state with 
legislation regarding Directive 2002/96/EC.

Except for reasons of safety or environmental benefit, equipment 
manufactured by EXFO, under its brand name, is generally designed to 
facilitate dismantling and reclamation.

For complete recycling/disposal procedures and contact information, visit 
the EXFO Web site at www.exfo.com/recycle.

Recycle or dispose of your product (including electric and 
electronic accessories) properly, in accordance with local 
regulations. Do not dispose of it in ordinary garbage receptacles.

This equipment was sold after August 13, 2005 (as identified by 
the black rectangle).
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15 Troubleshooting
Viewing the Online User Guide 

If you have Acrobat Reader (version 5 or above) installed on your system, 
you can read the user guides online.

To view the user guide from the DWDM Passive Component Test 
System software:

Select Online Manual from the Help menu.

To view the user guide from the provided LabVIEW application:

Select Help Topics from the Help menu of the LabVIEW application.

If Acrobat Reader is not installed on your system, you can download a free 
copy from the Adobe Web site at http://www.adobe.com.

Note: EXFO does not provide support for Adobe Acrobat Reader.

Consulting the About Window of the LabVIEW 
Application

The About window, available from the Help menu, provides useful 
information such as application version, EXFO’s address, Internet and 
phone technical support references.
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Finding Information on the EXFO Web Site
The EXFO Web site provides answers to frequently asked questions (FAQs) 
regarding the use of your IQS-12004B DWDM Passive Component Test 
System.

To access FAQs:

1. Type http://www.exfo.com in your Internet browser.

2. Click the Support tab.

3. Click FAQs and follow the on-screen instructions. You will be given a 
list of questions pertaining to your subject.

The EXFO Web site also provides the product’s most recent technical 
specifications.
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Contacting the Technical Support Group
To obtain after-sales service or technical support for this product, contact 
EXFO at one of the following numbers. The Technical Support Group is 
available to take your calls from Monday to Friday, 7:30 a.m. to 8:00 p.m. 
(Eastern Time in North America).

To accelerate the process, please have information such as the name and 
the serial number (see the product identification label—an example is 
shown below), as well as a description of your problem, close at hand.

Technical Support Group
400 Godin Avenue
Quebec (Quebec) G1M 2K2
CANADA

1 866 683-0155 (USA and Canada)
Tel.: 1 418 683-5498
Fax: 1 418 683-9224
support@exfo.com 

Ver.

Mfg.
date

P/N

S/N

Made in Canada QST442B
465 Godin Avenue
Vanier (Quebec)  G1M 3G7 CANADA

**************** A

January 2020542392-3D

IQS-12004B-MM-MM-PP-MM-MM-XX-YY-ZZ
Source option

Polarization option

Number of expansion units

Number of channels

GPIB/Slave/Master MultiPath Testing (MPT) option

Rackmount kit (MPT)

Switch model (MPT)
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Transportation
Transportation
Maintain a temperature range within specifications when transporting the 
unit. Transportation damage can occur from improper handling. The 
following steps are recommended to minimize the possibility of damage:

Pack the unit in its original packing material when shipping.

Avoid high humidity or large temperature fluctuations.

Keep the unit out of direct sunlight.

Avoid unnecessary shocks and vibrations.
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16 Warranty
General Information

EXFO Electro-Optical Engineering Inc. (EXFO) warrants this equipment 
against defects in material and workmanship for a period oftwo years from 
the date of original shipment. EXFO also warrants that this equipment will 
meet applicable specifications under normal use.

During the warranty period, EXFO will, at its discretion, repair, replace, 
or issue credit for any defective product, as well as verify and adjust the 
product free of charge should the equipment need to be repaired or if the 
original calibration is erroneous. If the equipment is sent back for 
verification of calibration during the warranty period and found to meet all 
published specifications, EXFO will charge standard calibration fees.

THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES EXPRESSED, 
IMPLIED, OR STATUTORY, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. IN NO EVENT SHALL EXFO BE LIABLE FOR 
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES.

IMPORTANT
The warranty can become null and void if:

unit has been tampered with, repaired, or worked upon by 
unauthorized individuals or non-EXFO personnel.

warranty sticker has been removed.

case screws, other than those specified in this guide, have been 
removed.

case has been opened, other than as explained in this guide.

unit serial number has been altered, erased, or removed.

unit has been misused, neglected, or damaged by accident.
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Warranty
Liability
Liability
EXFO shall not be liable for damages resulting from the use of the product, 
nor shall be responsible for any failure in the performance of other items to 
which the product is connected or the operation of any system of which 
the product may be a part.

EXFO shall not be liable for damages resulting from improper usage or 
unauthorized modification of the product, its accompanying accessories 
and software.

Exclusions
EXFO reserves the right to make changes in the design or construction of 
any of its products at any time without incurring obligation to make any 
changes whatsoever on units purchased. Accessories, including but not 
limited to fuses, pilot lamps, batteries and universal interfaces (EUI) used 
with EXFO products are not covered by this warranty.

This warranty excludes failure resulting from: improper use or installation, 
normal wear and tear, accident, abuse, neglect, fire, water, lightning or 
other acts of nature, causes external to the product or other factors beyond 
EXFO’s control.

Certification
EXFO certifies that this equipment met its published specifications at the 
time of shipment from the factory.

IMPORTANT
EXFO will charge a fee for replacing optical connectors that were 
damaged due to misuse or bad cleaning.
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Warranty
Service and Repairs
Service and Repairs
EXFO commits to providing product service and repair for five years 
following the date of purchase.

To send any equipment for service or repair:

1. Call one of EXFO’s authorized service centers (see EXFO Service 
Centers Worldwide on page 228). Support personnel will determine if 
the equipment requires service, repair, or calibration.

2. If equipment must be returned to EXFO or an authorized service 
center, support personnel will issue a Return Merchandise 
Authorization (RMA) number and provide an address for return.

3. If possible, back up your data before sending the unit for repair.

4. Pack the equipment in its original shipping material. Be sure to include 
a statement or report fully detailing the defect and the conditions under 
which it was observed.

5. Return the equipment, prepaid, to the address given to you by support 
personnel. Be sure to write the RMA number on the shipping slip. EXFO 
will refuse and return any package that does not bear an RMA number.

Note: A test setup fee will apply to any returned unit that, after test, is found to 
meet the applicable specifications.

After repair, the equipment will be returned with a repair report. If the 
equipment is not under warranty, you will be invoiced for the cost 
appearing on this report. EXFO will pay return-to-customer shipping costs 
for equipment under warranty. Shipping insurance is at your expense.

Routine recalibration is not included in any of the warranty plans. Since 
calibrations/verifications are not covered by the basic or extended 
warranties, you may elect to purchase FlexCare Calibration/Verification 
Packages for a definite period of time. Contact an authorized service center 
(see EXFO Service Centers Worldwide on page 228).
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Warranty
EXFO Service Centers Worldwide
EXFO Service Centers Worldwide
If your product requires servicing, contact your nearest authorized service 
center.

EXFO Headquarters Service Center
400 Godin Avenue
Quebec (Quebec) G1M 2K2
CANADA

1 866 683-0155 (USA and Canada)
Tel.: 1 418 683-5498
Fax: 1 418 683-9224
quebec.service@exfo.com 

EXFO Europe Service Center
Omega Enterprise Park, Electron Way
Chandlers Ford, Hampshire S053 4SE
ENGLAND

Tel.: +44 2380 246810
Fax: +44 2380 246801
europe.service@exfo.com 

EXFO China Service Center/
Beijing OSIC
Beijing New Century Hotel
Office Tower, Room 1754-1755
No. 6 Southern Capital Gym Road
Beijing 100044
P. R. CHINA

Tel.: +86 (10) 6849 2738
Fax: +86 (10) 6849 2662
beijing.service@exfo.com 
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A Technical Specifications

IQS-12004B DWDM Passive Component Test 
System

IMPORTANT
The following technical specifications can change without notice. 
The information presented in this section is provided as a reference 
only. To obtain this product’s most recent technical specifications, 
visit the EXFO Web site at www.exfo.com.

SPECIFICATIONS

Specifications a

IQS-2600CT
Testing time b < 18 s for 1 channel

< 25 s for 40 channels
Sampling resolution c 0.005 nm, 0.01 nm, 0.02 nm, and 0.04 nm
Wavelength uncertainty d ± 0.005 nm 
Wavelength repeatability d (2s) ± 0.001 nm
Wavelength range 1511 nm to 1611 nm
Loss measurement uncertainty e, f ± 0.05 dB (0 to 50 dB loss)
Loss measurement repeatability e, f ± 0.01 dB (0 to 50 dB loss)
Loss measurement range f 0 to 75 dB
Loss measurement resolution 0.001 dB
Optical rejection ratio g > 60 dB
PDL measurement resolution 0.001 dB
PDL uncertainty f, h 1520 nm to 1570 nm    ± (0.02 dB + 5 % of PDL DUT)

1511 nm to 1611 nm    ± (0.03 dB + 5 % of PDL DUT)
PDL range 0 to 10 dB
ORL uncertainty i ± 0.5 dB  (0 to 45 dB) 

± 1 dB (45 to 50 dB)
ORL range i 0 to 65 dB
Number of channels j > 80
Operating temperature 23 °C  ±  3 °C
Storage temperature –10 °C to 50 °C
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Technical Specifications
IQS-12004B MultiPath Testing Option
IQS-12004B MultiPath Testing Option

Specifications1

Loss measurement uncertainty2, 3, 5 ± 0.06 dB 
Loss measurement repeatability2, 3, 6 ± 0.04 dB 
PDL uncertainty2, 4, 5 ± (0.05 dB + 5 % of DUT PDL)
PDL repeatability2, 4, 6 ± (0.025 dB + 3 % of DUT PDL)
ORL uncertainty2, 5, 7 ± 1 dB (0 dB to 45 dB)

± 2 dB (45 dB to 50 dB)
ORL repeatability2, 3, 6 ± 0.3 dB (0 dB to 45 dB)
ORL range2 0 dB to 55 dB
Operating temperature Any stable temperature at ± 1 °C

in the range 20 °C to 30 °C
All other specifications Please refer to IQS-12004B data sheet

Standard Accessories
Instruction manual, installation software CD 
and interconnecting patchcords

Optional Accessories
Switch module with launch fibers
Rackmount kit
Video monitor

Notes:
1. All specifications are typical, after 60-minute warmup and testing a low 

loss components using the recommended EXFO accessories and EXFO 
low PDL switch.

2. Using a semi-rigid patchcord between the IQS-9401 and the switch.
3. Valid for spectrally uniform component. Does not include uncertainties 

due to connector or connector adapter.
4. Valid for spectrally uniform component terminated with a non-angled 

connector. Does not include uncertainties due to connector or 
connector adapter.

5. For first 100 cycles, within 100 hours after calibration and reference.
6. For 100 consecutive cycles within 100 hours.
7. Calibrated using a UPC connector with 14.7 dB of return loss.
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B SCPI Commands Reference
This section presents all SCPI commands supported by your IQS-12004B 
DWDM Passive Component Test System.

General Commands
The SCPI Manager recognizes all of the common commands identified as 
mandatory by IEEE-488.2. These commands are fully explained on the 
following pages.

Note: The expression <wsp> stands for white space in certain GPIB commands 
syntax.

*CLS
Description This command clears the last error of the application buffer. 

Syntax *CLS

Note If you get “STAT:ERR?” after having sent this command, you will 
read “0, No Error”.

*IDN?
Description This query reads the IQS system identification string.

Syntax *IDN?

Response “EXFO  IQS-12004B GPIB x.x.x.x”, where x.x.x.x is the current 
product version
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SCPI Commands Reference
General Commands
*OPC?
Description The response to this query indicates if the last operation was 

complete (whether or not it is successfully complete, it will 
return “1”). 

Syntax *OPC?

Response “1” - Operation is complete

“0” - Operation is not complete
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SCPI Commands Reference
Specific Commands
Specific Commands

INITialization:INITialize
Description This command performs an initialization of all IQS modules.

Syntax INIT:INIT

Parameter None

Response None

Example INIT:INIT

Note When INIT:SIMU = 1, the object simulator is used to develop 
without IQS modules. 

This is a blocking function i.e., In progress appears in the 
status bar and you must wait before sending a new command.

INITialization:INITialize?
Description The response to this query indicates if an initialization of the 

modules has been performed.

Syntax INIT:INIT?

Parameter None

Response A boolean response representing the state of initialization.

“1” - The system is initialized. 

“0” - The system is not initialized.

Example INIT:INIT?
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SCPI Commands Reference
Specific Commands
INITialization:SIMUlation
Description This commands sets the system to simulation mode.

Syntax INIT:SIMU<wsp><simulation>

Parameter The <simulation> parameter is a boolean value indicating if it 
is in simulation mode:

“1” - Sets the system to simulation mode

“0” - Sets the system to normal mode

Response None

Example INIT:SIMU 1

INITialization:SIMUlation?
Description The response to this query indicates if the system was in 

simulation mode.

Syntax INIT:SIMU?

Parameter None

Response A boolean value representing the state of the system:

“1” - The system is in simulation mode

“0” - The system is in normal mode

Example INIT:SIMU?
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SCPI Commands Reference
Specific Commands
CONFiguration:AVAilableChannel?
Description The response to this query indicates the number of available 

channels in the system.

Syntax CONF:AVAC?

Parameter None

Response The number of available channels in “999” format.

Example CONF:AVAC?

CONFiguration:CHANnel
Description This command sets the number of channels to test.

Syntax CONF:CHAN<wsp><number channel>

Parameter The <number channel> value refers to the number of channels 
to test in the system.

Response None

Example CONF:CHAN 3
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SCPI Commands Reference
Specific Commands
CONFiguration:CHANnel?
Description The response to this query indicates the number of channels to 

test.

Syntax CONF:CHAN?

Parameter None

Response The number of channels is represented by the “999” format.

Example CONF:CHAN?

CONFiguration:ACQuisitionType
Description This command sets the acquisition type.

Syntax CONF:ACQT<wsp><acquisition type>

Parameter The <acquisition type> parameter value indicates:

“1” - Resolution of 5 pm (only for the IQS-2600CT)

“2” - Resolution of 10 pm

“3” - Resolution of 20 pm

“4” - Resolution of 40 pm

Response None

Example CONF:ACQT 2
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SCPI Commands Reference
Specific Commands
CONFiguration:ACQuisitionType?
Description The response to this query indicates the acquisition type.

Syntax CONF:ACQT?

Parameter None

Response A value representing the selected acquisition type:

“1” - Resolution of 5 pm (only for the IQS-2600CT)

“2” - Resolution of 10 pm

“3” - Resolution of 20 pm

“4” - Resolution of 40 pm

Example CONF:ACQT?
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SCPI Commands Reference
Specific Commands
CONFiguration:KeepIL
Description This command keeps insertion loss curves for all states of 

polarization (4), when a PDL acquisition has been performed.

Syntax CONF:KIL<wsp><KeepIL>

Parameter The <KeepIL> parameter is a boolean value indicating if the IL 
curve is kept for all SOP:

“1” - Keep IL for all SOP

“0” - Do not keep IL for all SOP

Response None

Example CONF:KIL1

See also READ:SOP, READ:CURV:ILPD?

Note Default: 0

This command requires a lot of memory space as there are four 
more curves by channel.

CONFiguration:KeepIL?
Description The response to this query indicates if insertion loss curves are 

kept for all states of polarization.

Syntax CONF:KIL?

Parameter None

Response A value representing if the IL is kept for all SOP:

“1” - The IL is kept for all SOP

“0” - The IL is not kept for all SOP

See also READ:SOP?, READ:CURV:ILPD?
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SCPI Commands Reference
Specific Commands
CONFiguration:AutoRangeFiltering
Description This command sets the filtering mode.

Syntax CONF:ARF<wsp><filtering>

Parameter The <filtering> parameter is a boolean value indicating if it is in 
filtering mode:

“1” - Sets the system to filtering mode

“0” - Does not set the system to filtering mode

Response None

Example CONF:ARF 1

Note It is highly recommended to set the system to filtering mode.

CONFiguration:AutoRangeFiltering?
Description The response to this query indicates the filtering mode.

Syntax CONF:ARF?

Parameter None

Response A value representing the selected filtering mode:

“1” - The system is in filtering mode

“0” - The system is not in filtering mode

Example CONF:ARF?
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SCPI Commands Reference
Specific Commands
CONFiguration:MINimumWavelength?
Description The response to this query indicates the minimum wavelength 

available in the system.

Syntax CONF:MINW?

Parameter None

Response The minimum wavelength in the 9999.999 nm format.

Example CONF:MINW?

CONFiguration:MAXimumWavelength?
Description The response to this query indicates the maximum wavelength 

available in the system.

Syntax CONF:MAXW?

Parameter None

Response The maximum wavelength in the 9999.999 nm format.

Example CONF:MAXW?
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SCPI Commands Reference
Specific Commands
CONFiguration:STARt
Description This command sets the position where to start the acquisition.

Syntax CONF:STAR<wsp><wavelength>

Parameter The <wavelength> parameter value indicates the wavelength 
using the 9999.999 nm format.

Response None

Example CONF:STAR 1520.500

CONFiguration:STARt?
Description The response to this query indicates the position where to start 

the acquisition.

Syntax CONF:STAR?

Parameter None

Response Wavelength in 9999.999 nm format.

Example CONF:STAR?
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SCPI Commands Reference
Specific Commands
CONFiguration:STOP
Description This command sets the position where to stop the acquisition.

Syntax CONF:STOP<wsp><wavelength>

Parameter The <wavelength> parameter value indicates the wavelength 
using the 9999.999 nm format.

Response None

Example CONF:STOP 1569.000

CONFiguration:STOP?
Description The response to this query indicates the position where to stop 

the acquisition.

Syntax CONF:STOP?

Parameter None

Response Wavelength in 9999.999 nm format.

Example CONF:STOP?
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SCPI Commands Reference
Specific Commands
CALibration:WavelengthResponse:CHANnel
Description This command sets the active channel for the wavelength 

response calibration acquisition.

Syntax CAL:WR:CHAN<wsp><channel number>

Parameter The <channel number> parameter value indicates the active 
channel number in “999” format.

Response None

Example CAL:WR:CHAN 2

CALibration:WavelengthResponse:CHANnel?
Description The response to this query indicates the active channel for the 

wavelength response calibration acquisition.

Syntax CAL:WR:CHAN?

Parameter None

Response Active channel number in “999” format.

Example CAL:WR:CHAN?
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SCPI Commands Reference
Specific Commands
CALibration:WavelengthResponse:ACQuisition
Description This command performs a wavelength response calibration on 

the active channel.

Syntax CAL:WR:ACQ

Parameter None

Response None

Example CAL:WR:ACQ

CALibration:WavelengthResponse:ACQuisition?
Description The response to this query indicates if a wavelength response 

calibration has been performed.

Syntax CAL:WR:ACQ?

Parameter None

Response A boolean response indicates the state of the wavelength 
response calibration acquisition:

“1” - The acquisition is performed

“0” - The acquisition is not performed

Example CAL:WR:ACQ?
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SCPI Commands Reference
Specific Commands
CALibration:NULLing
Description This command performs a nulling on the power meter and 

wavelength reference module channels.

Syntax CAL:NULL

Parameter None

Response None

Example CAL:NULL
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SCPI Commands Reference
Specific Commands
CALibration:ORLRtj
Description This command performs an ORL calibration with a reference 

test jumper.

Syntax CAL:ORLR

Parameter None

Response None

Example CAL:ORLR

CALibration:ORLRtj?
Description The response to this query indicates if an ORL calibration with a 

reference test jumper has been performed.

Syntax CAL:ORLR?

Parameter None

Response A boolean response representing the state of the ORL 
calibration performed with the RTJ.

“1” - The ORL calibration with the RTJ is performed.

“0” - The ORL calibration with the RTJ is not performed

Example CAL:ORLR?
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SCPI Commands Reference
Specific Commands
CALibration:STOP
Description This command stops the current calibration acquisition.

Syntax CAL:STOP

Parameter None

Response None

Example CAL:STOP

Note Applies to all calibration acquisition (i.e., WR, ORLR, ORLM), 
but not to nulling.
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SCPI Commands Reference
Specific Commands
CALibration:ORLMandrelrtj
Description This command performs an ORL calibration with a mandrel 

and reference test jumper.

Syntax CAL:ORLM

Parameter None

Response None

Example CAL:ORLM

CALibration:ORLMandrelrtj?
Description The response to this query indicates if an ORL calibration with a 

mandrel and reference test jumper has been performed.

Syntax CAL:ORLM?

Parameter None

Response A boolean response representing the state of the ORL mandrel 
RTJ calibration acquisition:

“1” - The ORL mandrel RTJ calibration is performed

“0” - The ORL mandrel RTJ calibration is not performed

Example CAL:ORLM?
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Specific Commands
REFerence:IL
Description This command performs an IL reference acquisition.

Syntax REF:IL

Parameter None

Response None

Example REF:IL

REFerence:IL?
Description The response to this query indicates if an IL reference 

acquisition has been performed.

Syntax REF:IL?

Parameter None

Response A boolean response representing the state of the IL reference 
acquisition:

“1” - The IL reference acquisition is performed

“0” - The IL reference acquisition is not performed

Example REF:IL?
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SCPI Commands Reference
Specific Commands
REFerence:ILPDl
Description This command performs an IL/PDL reference acquisition.

Syntax REF:ILPD

Parameter None

Response None

Example REF:ILPD

REFerence:ILPDl?
Description The response to this query indicates if an IL/PDL reference 

acquisition has been performed.

Syntax REF:ILPD?

Parameter None

Response A boolean response representing the state of the IL/PDL 
reference acquisition:

“1” - The IL/PDL reference acquisition is performed

“0” - The IL/PDL reference acquisition is not performed

Example REF:PD?
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SCPI Commands Reference
Specific Commands
REFerence:ORLM
Description This command performs an ORL reference acquisition using a 

mandrel.

Syntax REF:ORLM

Parameter None

Response None

Example REF:ORLM

REFerence:ORLM?
Description The response to this query indicates if an ORL reference using a 

mandrel has been performed.

Syntax REF:ORLM?

Parameter None

Response A boolean response representing the state of the ORL reference 
acquisition using a mandrel:

“1” - The ORL reference acquisition using a mandrel is 
performed

“0” - The ORL reference acquisition using a mandrel is not 
performed

Example REF:ORLM?
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Specific Commands
REFerence:STOP
Description This command stops the current reference acquisition.

Syntax REF:STOP

Parameter None

Response None

Example REF:STOP

Note Applies to all reference acquisitions (i.e., IL, PDL, and ORL).

TEST:AVAilableTests?
Description The response to this query indicates which tests can be 

performed according to the modules detected, the calibration, 
and the reference.

Syntax TEST:AVAT?

Parameter None

Response A value representing the available tests:

“1” - None

“2” - IL

“3” - ORL

“4” - IL/ORL

“5” - IL/PDL

“6” - IL/ORL/PDL

Example TEST:AVAT?
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Specific Commands
TEST:CLeaR
Description This command clears the last IL, PDL, and ORL results.

Syntax TEST:CLR

Parameter None

Response None

Example TEST:CLR

ACQuisition:IL
Description This command performs an IL acquisition on a DUT.

Syntax ACQ:IL

Parameter None

Response None

Example ACQ:IL

ACQuisition:ILPDl
Description This command performs an IL/PDL acquisition on a DUT.

Syntax ACQ:ILPD

Parameter None

Response None

Example ACQ:ILPD
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Specific Commands
ACQuisition:ORL
Description This command performs an ORL acquisition on a DUT.

Syntax ACQ:ORL

Parameter None

Response None

Example ACQ:ORL

ACQuisition:SYNChronized
Description This command performs a synchronized power acquisition on 

all IQS-1600 power meters.

Syntax ACQ:SYNC<wsp><NumberPoints>

Parameter The <NumberPoints> parameter indicates the number of 
points to take for the acquisition.

Response None

Example ACQ:SYNC 25000

Note A maximum of 32 000 points is allowed.

See also READ:CURV:SYNC?
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Specific Commands
ACQuisition:STOP
Description This command stops the current acquisition on a DUT.

Syntax ACQ:STOP

Parameter None

Response None

Example ACQ:STOP
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SCPI Commands Reference
Specific Commands
STATus:ERRor?
Description The response to this query indicates the last error and provides 

a description.

Syntax STAT:ERR?

Parameter None

Response A string representing:

Error Number,”Error description”

Example STAT:ERR?

Note See also SCPI Error Messages on page 195.

READ:CURVe:IL?
Description The response to this query indicates the IL results curve on a 

specified channel.

Syntax READ:CURV:IL?

Parameter None

Response A string response representing all points of the IL acquisition 
using the “x (nm), y (dB)” format. 

Example READ:CURV:IL?

See also READ:CHAN?
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Specific Commands
READ:CURVe:PDL?
Description The response to this query indicates the PDL results curve on a 

specified channel.

Syntax READ:CURV:PDL?

Parameter None

Response A string response representing all points of the PDL acquisition 
using the “x (nm), y (dB)” format.

Example READ:CURV:PDL?

See also READ:CHAN?

READ:CURVe:ORL?
Description The response to this query indicates the ORL results curve.

Syntax READ:CURV:ORL?

Parameter None

Response A string response representing all points of the ORL acquisition 
using the “x (nm), y (dB)” format.

Example READ:CURV:ORL?
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Specific Commands
READ:CURVe:ILPDl?
Description The response to this query indicates the IL curve for a specific 

state of polarization, when a PDL acquisition has been 
performed.

Syntax READ:CURV:ILPD?

Parameter None

Response A string response representing all points of the IL curve using 
the “x (nm), y (dB)” format. 

Example READ:CURV:ILPD?

Note Available only for the last PDL acquisition, with CONF:KIL=1

See also READ:CHAN?, READ:SOP?, CONF:KIL?

READ:CURVe:SYNChronized?
Description The response to this query indicates the power synchronized 

acquisition result curve on a specified channel.

Syntax READ:CURV:SYNC?

Parameter None

Response A string response representing all points of the power 
synchronized acquisition using “PowerPoints (dB), Status” 
format.

Example READ:CURV:SYNC?

See also ACQ:SYNC
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Specific Commands
READ:CHANnel?
Description The response to this query indicates the active channel.

Syntax READ:CHAN?

Parameter None

Response Active channel number in the “999” format.

Example READ:CHAN?

READ:CHannelLOcalization?
Description The response to this query indicates the localization 

information about the specified channels.

Syntax READ:CHLO?

Parameter None

Response A string response in the “Slot Position,Power Meter Channel” 
format. For example:

- Slot position: (1-3)

- Power meter channel: 2 (range: 1-4)

Example READ:CHLO?
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Specific Commands
READ:PowerMeter?
Description The response to this query indicates the power meter value for 

the specified channel.

Syntax READ:PM?

Parameter None

Response A power measurement in the 9999.999 dBm format for the 
specified channel.

Example READ:PM?

Note This is a blocking function i.e., In progress appears in the 
status bar and you must wait before sending a new command.
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Specific Commands
READ:WavelengthReferenceModule?
Description The response to this query indicates the power of both 

channels on the wavelength reference module.

Syntax READ:WRM?

Parameter None

Response A string in the “Reference channel, ORL channel” dBm format, 
i.e., “9999.999,9999.999” dBm format.

Example READ:WRM?

Note This is a blocking function i.e., In progress appears in the 
status bar and you must wait before sending a new command.

READ:SerialNumber?
Description The response to this query indicates the serial number of each 

modules initialized in the system.

Syntax READ:SN?

Parameter None

Response A string in the “ModuleName SlotPosition: Serial Number” 
format.

Example READ:SN?

Note Each module description is separated by a comma.
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Specific Commands
READ:StateOfPolarization
Description This command indicates on which state of polarization to take 

the IL curve, when a PDL acquisition has been performed.

Syntax READ:SOP<wsp><StateOfPolarization>

Parameter The <StateOfPolarization> parameter value can be 0, 1, 2, or 3.

Response None

Example READ:SOP 2

See also CONF:KIL, READ:CURV:ILPD?

READ:StateOfPolarization?
Description The response to this query indicates the current state of 

polarization when reading the IL during a PDL acquisition.

Syntax READ:SOP?

Parameter None

Response A string response representing the current state of polarization, 
i.e., 0, 1, 2, or 3. 

Example READ:SOP?

See also CONF:KIL? READ:CURV:ILPD?
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Specific Commands
PolarizationStateAdjuster:MAXimum
Description This command optimizes the power.

Syntax PSA:MAX

Parameter None

Response None

Example PSA:MAX

PolarizationStateAdjuster:MAXimum?
Description The response to this query indicates if the power was 

optimized.

Syntax PSA:MAX?

Parameter None

Response A boolean response representing the state of the PSA:

“1” - The power is optimized

“0” - The power is not optimized

Example PSA:MAX?
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Specific Commands
PolarizationStateAdjuster:StateOfPolarization
Description This command sets a new polarization state on the IQS-5150 

polarization state adjuster.

Syntax PSA:SOP<wsp><StateOfPolarization>

Parameter The <StateOfPolarization> parameter value is a new state of 
polarization. It can be:

0, 1, 2, or 3

Response None

Example  PSA:SOP 2

PolarizationStateAdjuster:StateOfPolarization?
Description The response to this query indicates the current polarization 

state on the IQS-5150 polarization state adjuster.

Syntax PSA:SOP?

Parameter None

Response A string response representing the current state of polarization. 
It can be:

0, 1, 2, or 3

Example  PSA:SOP?
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Specific Commands
SOURce:MINimumWavelength?
Description The response to this query indicates the minimum wavelength 

of the current source.

Syntax SOUR:MINW?

Parameter None

Response Minimum wavelength in 9999.999 nm format.

Example SOUR:MINW?

SOURce:MAXimumWavelength?
Description The response to this query indicates the maximum wavelength 

of the current source.

Syntax SOUR:MAXW?

Parameter None

Response Maximum wavelength in 9999.999 nm format.

Example SOUR:MAXW?
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Specific Commands
SOURce:ON
Description This command turns the source ON or OFF.

Syntax SOUR:ON<wsp><state>

Parameter The <state> parameter is a boolean value indicating the new 
state of the source:

“1” - Sets the source to ON

“0” - Sets the source to OFF

Response None

Example SOUR:ON 1

Note This is a blocking function i.e., In progress appears in the 
status bar and you must wait before sending a new command.

SOURce:ON?
Description The response to this query indicates if the source was active.

Syntax SOUR:ON?

Parameter None

Response A boolean value representing the current state of the source:

“1” - The source is ON

“0” - The source is OFF

Example SOUR:ON?
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Specific Commands
SOURce:STABilization?
Description The response to this query indicates how long the source has 

been turned on.

Syntax SOUR:STAB?

Parameter None

Response A string value indicating since when the source is ON using the 
“9999.999” seconds format.

Example SOUR:STAB?
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Specific Commands
SOURce:WAVElength
Description This command sets the source wavelength.

Syntax SOUR:WAVE<wsp><wavelength>

Parameter The <wavelength> parameter value indicating the wavelength 
in “9999.999” nm format.

Response None

Example SOUR:WAVE 1520.050

Note This is a blocking function i.e., In progress appears in the 
status bar and you must wait before sending a new command.

SOURce:WAVElength?
Description The response to this query indicates the wavelength of the 

current source.

Syntax SOUR:WAVE?

Parameter None

Response Wavelength in 9999.999 nm format.

Example SOUR:WAVE?
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C COM Objects Reference
This section presents all COM methods and properties supported by your 
IQS-12004B DWDM Passive Component Test System and/or MultiPath 
Testing Option. 

The information is grouped by interfaces according to following diagram:

Measures Interface (see page 274)

Results Interface (see page 304)

DwdmAcq (see page 270)

clsDescModule Object (see page 314)

clsChannel Object (see page 317)

Event (see page 318)

Switch Interface (see page 335)

Modules Interface (see page 286)

Acq12004B

TestParameters Interface (see page 309)

Analysis Interface (see page 347)

ChannelResult (see page 363)

BandPass (see page 367)

BandPassResult (see page 372)

Notch (see page 386)

NotchResult (see page 393)

Undefined (see page 399)

Available Enumerations (see page 328)
Only available 
with MultiPath 
Testing Option
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DWDMAcq Interface—Properties
For more information see COM Objects Overview on page 206.

For each interface, you will find:

A section with the available methods (when applicable).

A section with the available properties (when applicable).

In each section (methods or properties), the objects are presented by 
alphabetical order. The corresponding interface name is always displayed 
in the method (or property) header.

DWDMAcq Interface—Properties

DWDMAcq EnableWaitingEvent
Description This command enables or disables the waiting event.

Syntax object.EnableWaitingEvent

Parameters Byval Boolean

Response Boolean

Access Get/Let

Measures

Description

AcqIlDut

This command performs an IL measurement on the DUT.

Interface name Method /property name
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DWDMAcq Interface—Properties
DWDMAcq RawDataPath
Description This command indicates the path where to save the binary data 

file. For more information, see Modifying System Settings on 
page 56.

Syntax object.RawDataPath

Parameters Byval String

Response String

Access Get/Let

DWDMAcq SaveRawData
Description This command saves the binary data file. 

For more information, see Modifying System Settings on 
page 56.

Syntax object.SaveRawData

Parameters Byval Boolean

Response Boolean

Access Get/Let
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DWDMAcq Interface—Properties
DWDMAcq State
Description The response to this query indicates the current object state 

according to EState. For more information on EState, see Public 
Enum EState on page 334.

Syntax object.State

Parameters None

Response Enumeration: EState

Access Get

DWDMAcq ComponentVersion
Description The response to this query indicates the version of the 

component.

Syntax object.ComponentVersion

Parameters None

Response String

Access Get
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DWDMAcq Interface—Properties
DWDMAcq PdlSimplifiedMethod
Description This property returns or sets a value that determines if the 

simplified PDL method is used. For more information on 
simplified PDL, see Modifying System Settings on page 56.

Syntax object.PdlSimplifiedMethod = [Boolean]

The following table presents the possible settings for the 
Boolean value.

Parameters A Boolean value.

Response A Boolean value.

Access Get/Let

Setting Description

True The simplified PDL method will be used.

False (Default). The simplified PDL method will not 
be used.
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Measures Interface—Methods
Measures Interface—Methods

Note: With FireEvent = True, the object raises an event at the end of the process. 
With FireEvent = False, no event occurs.

Measures AcqIlDut
Description This command performs an IL measurement on the DUT.

Syntax object.AcqllDut(FireEvent)

Parameters Byval Boolean FireEvent

Response None

Possible error ErrInitBefore, ErrCalWrBefore, ErrRefIlBefore, ErrInProgress, 
ErrAcqType, ErrAcqStopped, ErrScanRange, 
ErrSourceNotEnabled. For more information, see IQS-12004B 
DWDM Passive Component Test System (Standard) COM Error 
Messages on page 208.
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Measures Interface—Methods
Measures AcqIlPdlDut
Description This command performs an IL/PDL measurement on the DUT.

Syntax object.AcqllPdlDut(FireEvent)

Parameters Byval Boolean FireEvent

Response None

Possible error ErrInitBefore, ErrHardNotCompatible, ErrCalWrBefore, 
ErrRefIlPdlBefore, ErrInProgress, ErrAcqType, ErrAcqStopped, 
ErrScanRange, ErrSourceNotEnabled. For more information, 
see IQS-12004B DWDM Passive Component Test System 
(Standard) COM Error Messages on page 208.

Note Available only with the IQS-5150 polarization state adjuster.

Measures AcqOrlMandrelDut
Description This command performs an ORL measurement on the DUT.

Syntax object.AcqOrlMandrelDut(FireEvent)

Parameters Byval Boolean FireEvent

Response None

Possible error ErrInitBefore, ErrCalOrlRtjBefore, ErrCalOrlMandrelRtjBefore, 
ErrRefOrlMandrelBefore, ErrInProgress, ErrAcqType, 
ErrAcqStopped, ErrScanRange, ErrSourceNotEnabled. For more 
information, see IQS-12004B DWDM Passive Component Test 
System (Standard) COM Error Messages on page 208.
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Measures Interface—Methods
Measures AcqPowerSynchronized
Description This command performs a synchronized power acquisition on 

all IQS-1600 power meters.

Syntax object.AcqPowerSynchronized (NumberOfPorts, 
NumberOfAcquisitionPoints, FireEvent)

Parameters Byval Long NumberOfPorts

Byval Double NumberOfAcquisitionPoints

Byval Boolean FireEvent

Response None

Possible error ErrInitBefore, ErrHardNotCompatible, ErrCalWrBefore, 
ErrRefIlPdlBefore, ErrInProgress, ErrAcqType, 
ErrNumberOfAcquisitionPoints, 
ErrNotAvailableInSimulatorMode, ErrAcqStopped, 
ErrScanRange, ErrSourceNotEnabled. For more information, 
see IQS-12004B DWDM Passive Component Test System 
(Standard) COM Error Messages on page 208.

Note The maximum number of points is 32 000.
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Measures Interface—Methods
Measures CalOrlMandrelRtj
Description This command performs an ORL calibration using a mandreled 

reflection reference jumper (zero measurement).

Syntax object.CalOrlMandrelRtj(FireEvent)

Parameters Byval Boolean FireEvent

Response None

Possible error ErrInitBefore, ErrInProgress, ErrAcqType, ErrAcqStopped, 
ErrScanRange, ErrSourceNotEnabled. For more information, 
see IQS-12004B DWDM Passive Component Test System 
(Standard) COM Error Messages on page 208.

Measures CalOrlRtj
Description This command performs an ORL calibration using a reflection 

reference jumper.

Syntax object.CalOrlRtj(FireEvent)

Parameters Byval Boolean FireEvent

Response None

Possible error ErrInitBefore, ErrInProgress, ErrAcqType, ErrAcqStopped, 
ErrScanRange, ErrSourceNotEnabled. For more information, 
see IQS-12004B DWDM Passive Component Test System 
(Standard) COM Error Messages on page 208.
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Measures Interface—Methods
Measures CalWr
Description This command performs a wavelength response calibration on 

the power meter channel.

ChannelToCalibrate represents the number of channels to 
calibrate, as indicated on the channel localization list. 

Syntax object.CalWr(ChannelToCalibrate, FireEvent)

Parameters Byval Long ChannelToCalibrate, Byval Boolean FireEvent

Response None

Possible error ErrInitBefore, ErrInProgress, ErrChannelNumber, ErrAcqType, 
ErrAcqStopped, ErrScanRange, ErrSourceNotEnabled. For more 
information, see IQS-12004B DWDM Passive Component Test 
System (Standard) COM Error Messages on page 208.

See also ChannelLocalisation (see page 291)

Measures RefIl
Description This command performs an IL reference measurement.

Syntax object.RefIl(FireEvent)

Parameters Byval Boolean FireEvent

Response None

Possible error ErrInitBefore, ErrCalWrBefore, InProgress, ErrAcqType, 
ErrAcqStopped, ErrScanRange, ErrSourceNotEnabled. For more 
information, see IQS-12004B DWDM Passive Component Test 
System (Standard) COM Error Messages on page 208.
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Measures Interface—Methods
Measures RefIlPdl
Description This command performs an IL/PDL reference measurement.

Syntax object.RefIlPdl(FireEvent)

Parameters Byval Boolean FireEvent

Response None

Possible error ErrInitBefore, ErrCalWrBefore, InProgress, ErrAcqType, 
ErrAcqStopped, ErrScanRange, ErrOptimizeBefore, 
ErrSourceNotEnabled. For more information, see IQS-12004B 
DWDM Passive Component Test System (Standard) COM Error 
Messages on page 208.

Note Use only the IQS-5150 polarization state adjuster.

Measures RefOrlMandrel
Description This command performs an ORL reference measurement by 

mandreling the launch fiber.

Syntax object.RefOrlMandrel(FireEvent)

Parameters Byval Boolean FireEvent

Response None

Possible error ErrInitBefore, ErrCalOrlRtjBefore, ErrCalOrlMandrelRtjBefore, 
ErrInProgress, ErrAcqType, ErrAcqStopped, ErrScanRange, 
ErrSourceNotEnabled. For more information, see IQS-12004B 
DWDM Passive Component Test System (Standard) COM Error 
Messages on page 208.
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Measures Interface—Properties
Measures Interface—Properties

Measures StopAcq
Description This command stops the current measurement scan.

Syntax object.StopAcq

Parameters None

Response None

Measures AcqIlDutDone
Description The response to this query indicates if an IL measurement has 

been performed on the DUT.

Syntax object.AcqIlDutDone

Parameters None

Response Boolean 

Access Get
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Measures Interface—Properties
Measures AcqIlPdlDutDone
Description The response to this query indicates if an IL/PDL measurement 

has been performed on the DUT.

Syntax object.AcqllPdlDutDone

Parameters None

Response Boolean 

Access Get

Measures AcqOrlMandrelDutDone
Description The response to this query indicates if an ORL measurement 

has been performed on the DUT.

Syntax object.AcqOrlMandrelDutDone

Parameters None

Response Boolean 

Access Get
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Measures Interface—Properties
Measures CalOrlMandrelRtjDone
Description The response to this query indicates if an ORL calibration using 

a mandreled reflection reference jumper has been performed.

Syntax object.CalOrlMandrelRtjDone

Parameters None

Response Boolean 

Access Get

Measures CalOrlRtjDone
Description The response to this query indicates if an ORL calibration using 

a reflection reference jumper has been performed.

Syntax object.CalOrlRtjDone

Parameters None

Response Boolean 

Access Get
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Measures Interface—Properties
Measures CalWrDone
Description The response to this query indicates if a wavelength response 

calibration has been performed on a channel. When the 
channel = 0, the property returns a global status. This global 
status is true only if a wavelength response calibration is 
performed on all channels.

Syntax object.CalWrDone(Channel)

Parameters Byval Long Channel

Response Boolean

Access Get
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Measures Interface—Properties
Measures RefIlDone
Description The response to this query indicates if an IL reference 

measurement has been performed.

Syntax object.RefIlDone

Parameters None

Response Boolean 

Access Get

Measures RefIlPdlDone
Description The response to this query indicates if an IL/PDL reference 

measurement has been performed.

Syntax object.RefIlPdlDone

Parameters None

Response Boolean 

Access Get
284 IQS-12004B



COM Objects Reference
Measures Interface—Properties
Measures RefOrlMandrelDone
Description The response to this query indicates if an ORL reference 

measurement using a mandreled launch fiber has been 
performed.

Syntax object.RefOrlMandrelDone

Parameters None

Response Boolean 

Access Get
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Modules Interface—Methods
Modules Interface—Methods

Modules GetAllPmData
Description The response to this query indicates the power meter values 

and status for a specified power meter. 

Syntax object.GetAllPmData(PmNumber, adSample, adStatus)

Parameters ByVal PmNumber As Long, ByRef adSample() As Double, ByRef 
adStatus() As EPowerStatus

For more information on EPowerStatus, seePublic Enum 
EPowerStatus on page 333.

Note Unit = Watt

The status specifies the validity of the sample. If status is 0, the 
sample is valid.

Modules HidePowerMeterMonitor
Description This command hides a window which indicates power meter 

values.

Syntax object.HidePowerMeterMonitor

Parameters None

Response None
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Modules Interface—Methods
Modules InitHardware
Description This command performs an initialization of all IQS modules.

When Simulator is set to True, the simulator mode is enabled, 
allowing you to develop applications with virtual IQS modules.

Syntax object.InitHardware(FireEvent, [Simulator])

Parameters Byval Boolean FireEvent, Byval Boolean Simulator (Optional)

Response None

Modules Nulling
Description This command can either perform a nulling on all power 

meters and wavelength reference modules, on one power 
meter, or on the wavelength reference module.

For nulling one power meter, use PmNumber to identify the 
desired power meter.

Syntax object.Nulling(NullingType, FireEvent, [PmNumber])

Parameters ByVal NullingType As ENullingType, Byval Boolean FireEvent, 
Optional ByVal PmNumber As Long

For more information on ENullingType, see Public Enum 
ENullingType on page 332.

Response None

Possible error ErrInitBefore, ErrInProgress, ErrNullingtype, ErrNulling, 
ErrNullingIndex. For more information, see IQS-12004B DWDM 
Passive Component Test System (Standard) COM Error 
Messages on page 208.
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Modules Interface—Methods
Modules OptimizePower
Description This command optimizes the power.

Syntax object.OptimizePower

Parameters None

Response None

Possible error ErrInitBefore, ErrHardNotCompatible, ErrInProgress. For more 
information, see IQS-12004B DWDM Passive Component Test 
System (Standard) COM Error Messages on page 208.

Note Use only with the IQS-5150 polarization state adjuster.
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Modules Interface—Methods
Modules OptimizePowerDone
Description The response to this query indicates if the power was 

optimized.

Syntax object.OptimizePowerDone(FireEvent)

Parameters Byval Boolean FireEvent

Response Boolean

Access Get

Modules ShowPowerMeterMonitor
Description This command displays a window which indicates power 

meter values.

Syntax object.ShowPowerMeterMonitor

Parameters None

Response None
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Modules Interface—Properties
Modules Interface—Properties

Modules AvailableHardware
Description The response to this query indicates the objects containing 

information on detected IQS module(s).

Syntax object.AvailableHardware

Parameters None

Response Module collection

Access Get

Example Object.AvailableHardware(1).ModuleName

Object.AvailableHardware(1).SerialNumber

Object.AvailableHardware(1).Slot

See also clsDescModule (see clsDescModule Object—Properties on 
page 314)
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Modules Interface—Properties
Modules ChannelLocalisation
Description The response to this query indicates the channels containing 

localization information.

Syntax object.ChannelLocalisation

Parameters None

Response Collection of Module clsChannel

Access Get

Example object.ChannelLocalisation(1).PMChannel

object.ChannelLocalisation(1).PMNumber

object.ChannelLocalisation(1).DescModule.slot

See also clsChannel (see clsChannel Object—Properties on page 317)
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Modules Interface—Properties
Modules FormatedPowerAcq
Description The response to this query indicates the power meter value for 

the specified channel, according to the source wavelength and 
polarization state. 

Syntax object.FormatedPowerAcq(Channel, NbDecimal)

Parameters Byval Long Channel, Byval NoDecimal as EDecimalFormat

For more information on EDecimalFormat, see Public Enum 
EDecimalFormat on page 329.

Response String

Access Get

Possible error ErrInitBefore, ErrInProgress, ErrChannelNumber, ErrPmValue, 
ErrPmValueOver, ErrPmValueUnder. For more information, see 
IQS-12004B DWDM Passive Component Test System (Standard) 
COM Error Messages on page 208.

Note Unit=dBm
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Modules Interface—Properties
Modules FormatedWrmPowerAcq
Description The response to this query indicates the wavelength reference 

module value for the specified channel (1-4), according to the 
source wavelength and polarization state. 

Syntax object.FormatedWrmPowerAcq(WrmChannel,NbDecimal)

Parameters Byval Long WrmChannel, Byval NoDecimal as EDecimalFormat

For more information on EDecimalFormat, see Public Enum 
EDecimalFormat on page 329.

Response String

Access Get

Possible error ErrInitBefore, ErrInProgress, ErrChannelNumber, ErrPmValue, 
ErrPmValueOver, ErrPmValueUnder. For more information, see 
IQS-12004B DWDM Passive Component Test System (Standard) 
COM Error Messages on page 208.

Note Unit=dBm

Modules InitDate
Description The response to this query indicates the initialization date.

Syntax object.InitDate

Parameters None

Response Date

Access Get
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Modules Interface—Properties
Modules InitDone
Description The response to this query indicates if an initialization of the 

modules has been performed.

Syntax object.InitDone

Parameters None

Response Boolean

Access Get

Modules MinPowerForCal
Description This command indicates the minimum power required to 

validate the input of the IQS-1600 power meter modules. This 
value is used to verify the connection during calibration.

Syntax object.MinPowerForCal

Parameters Double

Response Double

Access Get/Let

Note Unit=Watt
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Modules Interface—Properties
Modules MinPowerForRef
Description This command indicates the minimum power required to 

validate the input of the IQS-1600 power meter modules. This 
value is used to verify the connection during the reference 
measurement.

Syntax object.MinPowerForRef

Parameters Double

Response Double

Access Get/Let

Note Unit=Watt

Modules MinPowerInWrm
Description This command indicates the minimum power required to 

validate the input of the IQS-9401 wavelength reference 
module. This value is used to verify the connection.

Syntax object.MinPowerInWrm

Parameters Double

Response Double

Access Get/Let

Note Unit=Watt
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Modules Interface—Properties
Modules NullingDone
Description The response to this query indicates if a nulling has been 

performed. 

Syntax object.NullingDone(NullingType, [PmNumber])

Parameters NullingType (ENullingType), Optional PmNumber As Long

For more information on ENullingType, see Public Enum 
ENullingType on page 332.

Response Boolean

Access Get

Modules PolarizationState
Description This command indicates the polarization state of the IQS-5150 

polarization state adjuster module.

Syntax object.PolarizationState

Parameters EPolarizationState

For more information, see EPolarizationState on page 332.

Response EPolarizationState

Access Get/Let

Possible error ErrInitBefore, ErrInProgress, ErrOptimizeBefore. For more 
information, see IQS-12004B DWDM Passive Component Test 
System (Standard) COM Error Messages on page 208.
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Modules Interface—Properties
Modules PossibleTestWithHard
Description The response to this query indicates the tests that can be 

performed with the modules detected.

Syntax object.PossibleTestWithHard

Parameters None

Response Enumeration EPossibleTestWithHard

For more information, see Public Enum EPossibleTestWithHard 
on page 333.

Access Get

Note Depending on the modules detected, you can perform and IL, 
an IL/ORL, or an IL/PDL/ORL measurement.

Modules PowerAcq
Description The response to this query indicates the power meter value of 

the specified channel, according to the source wavelength and 
polarization state.

Syntax object.PowerAcq(Channel)

Parameters Byval Long Channel

Response Double

Access Get

Possible error ErrInitBefore, ErrInProgress, ErrChannelNumber, ErrPmValue, 
ErrPmValueOver, ErrPmValueUnder. For more information, see 
IQS-12004B DWDM Passive Component Test System (Standard) 
COM Error Messages on page 208.

Note Unit=Watt
DWDM Passive Component Test System 297



COM Objects Reference
Modules Interface—Properties
Modules PowerMeterMonitorHeight
Description This command indicates the height of the monitor window. 

Syntax object.PowerMeterMonitorHeight

Parameters Double

Response Double

Access Get/Let

Note Unit = Twipa

a. A twip is a unit of screen measurement that equals 1/20 of a printer’s point. There are 567 twips to
a centimeter and 1440 twips to an inch.

Modules PowerMeterMonitorLeftPosition
Description This command indicates the monitor window position on the 

left. 

Syntax object.PowerMeterMonitorLeftPosition

Parameters Double

Response Double

Access Get/Let

Note Unit=Twipa

a. A twip is a unit of screen measurement that equals 1/20 of a printer’s point. There are
567 twips to a centimeter and 1440 twips to an inch.
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Modules Interface—Properties
Modules PowerMeterMonitorTopPosition
Description This command indicates the monitor window position at the 

top. 

Syntax object.PowerMeterMonitorTopPosition

Parameters Double

Response Double

Access Get/Let

Note Unit=Twipa

a. A twip is a unit of screen measurement that equals 1/20 of a printer’s point. There are
567 twips to a centimeter and 1440 twips to an inch.

Modules PowerMeterMonitorWidth
Description This command indicates the width of the monitor window.

Syntax object.PowerMeterMonitorWidth

Parameters Double

Response Double

Access Get/Let

Note Unit=Twipa

a. A twip is a unit of screen measurement that equals 1/20 of a printer’s point. There are 567
twips to a centimeter and 1440 twips to an inch.
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Modules Interface—Properties
Modules SourceActive
Description This command turns the source ON or OFF, or indicates if the 

source is active or not.

Syntax object.SourceActive

Parameters Boolean

Response Boolean

Access Get/Let

Possible error ErrInitBefore. For more information, see IQS-12004B DWDM 
Passive Component Test System (Standard) COM Error 
Messages on page 208.
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Modules Interface—Properties
Modules SourceMaxWavelength
Description The response to this query indicates the source maximum 

wavelength.

Syntax object.SourceMaxWavelength

Parameters None

Response Double

Access Get

Possible error ErrInitBefore. For more information, see IQS-12004B DWDM 
Passive Component Test System (Standard) COM Error 
Messages on page 208.

Note Unit=nm

Modules SourceMinWavelength
Description The response to this query indicates the source minimum 

wavelength.

Syntax object.SourceMinWavelength

Parameters None

Response Double

Access Get

Possible error ErrInitBefore. For more information, see IQS-12004B DWDM 
Passive Component Test System (Standard) COM Error 
Messages on page 208.

Note Unit=nm
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Modules Interface—Properties
Modules SourceStabilisationTime
Description The response to this query indicates the time between the 

source activation and the use of this function.

Syntax object.SourceStabilisationTime

Parameters None

Response Double

Access Get

Possible error ErrInitBefore. For more information, see IQS-12004B DWDM 
Passive Component Test System (Standard) COM Error 
Messages on page 208.

Note Unit=Second

Modules SourceWavelength
Description This command indicates the source wavelength.

Syntax object.SourceWavelength

Parameters Byval Double Wavelength

Response Double

Access Get/Let

Possible error ErrInitBefore. For more information, see IQS-12004B DWDM 
Passive Component Test System (Standard) COM Error 
Messages on page 208.

Note Unit=nm
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Modules Interface—Properties
Modules WrmPowerAcq
Description The response to this query indicates the wavelength reference 

module power value of the specified channel. 

Syntax object.WrmPowerAcq(Channel)

Parameters Byval Long Channel

Response Double

Access Get

Possible error ErrInitBefore, ErrInProgress, ErrChannelNumber, ErrPmValue, 
ErrPmValueOver, ErrPmValueUnder. For more information, see 
IQS-12004B DWDM Passive Component Test System (Standard) 
COM Error Messages on page 208.

Note Unit=Watt
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Results Interface—Methods

Results Interface—Properties

Results ClearResults
Description This command clears the last IL, PDL, and ORL results.

Syntax object.ClearResults

Parameters None

Response None

Results IlCurve
Description The response to this query indicates the IL result curve for the 

channel (x (nm), y (dB)).

Syntax object.IlCurve(Channel)

Parameters Byval Long Channel 

Response Variant (array of double: x, y)

Access Get

Possible error ErrAcqBefore, ErrInProgress, ErrChannelNumber. For more 
information, see IQS-12004B DWDM Passive Component Test 
System (Standard) COM Error Messages on page 208.

Note Wavelength unit=nm

Power unit=dB
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Results OrlCurve
Description The response to this query indicates the ORL result curve for 

the channel (x (nm), y (dB)).

Syntax object.OrlCurve(Channel)

Parameters Byval Long Channel 

Response Variant (array of double: x, y)

Access Get

Possible error ErrAcqBefore, ErrInProgress, ErrChannelNumber. For more 
information, see IQS-12004B DWDM Passive Component Test 
System (Standard) COM Error Messages on page 208.

Note Wavelength unit=nm

Power unit=dB
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Results PdlCurve
Description The response to this query indicates the PDL result curve for the 

channel (x (nm), y (dB)).

Syntax object.PdlCurve(Channel)

Parameters Byval Long Channel 

Response Variant (array of double: x, y)

Access Get

Possible error ErrAcqBefore, ErrInProgress, ErrChannelNumber. For more 
information, see IQS-12004B DWDM Passive Component Test 
System (Standard) COM Error Messages on page 208.

Note Wavelength unit=nm

Power unit=dB
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Results IlCurveForPolarization
Description The response to this query indicates the insertion loss curve for 

a specific state of polarization, when a PDL acquisition has 
been performed.

Syntax object.IlCurveForPolarization(Channel, EPolarizationState)

Parameters Byval Long Channel

EPolarizationState

For more information on EPolarizationState, see 
EPolarizationState on page 332.

Response Variant (array of double: x, y)

Access Get

Possible error ErrInvalidIlCurvePolState

Note Wavelength unit=nm

Power unit=dB

Available only for the last PDL acquisition.

KeepIlForAllPolarization=True
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Results SynchronizedPower
Description The response to this query indicates the power synchronized 

acquisition result curve on a specified channel.

Syntax object.SynchronizedPower(Channel, adSample, adStatus)

Parameters Byval Long Channel 

Byref Double adSample()

Byref Module1600Lib.EPowerStatus adStatus()

For more information on EPowerStatus, see Public Enum 
EPowerStatus on page 333.

Response None

Access Get

Possible error ErrAcqBefore, ErrInProgress, ErrChannelNumber. For more 
information, see IQS-12004B DWDM Passive Component Test 
System (Standard) COM Error Messages on page 208.

Note adSample() = dB
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Test Parameters AcqType
Description This command indicates the type of acquisition.

Syntax object.AcqType

Parameters Long: Enum EAcqType

For more information, see Public Enum EAcqType on page 328.

Response Enumeration EAcqType

For more information, see Public Enum EAcqType on page 328.

Access Get/Let

Test Parameters AnalysisRangeMax
Description This command indicates the maximum analysis range.

Syntax object.AnalysisRangeMax

Parameters None

Response A Double value

Access Get

Note Unit=nm
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Test Parameters AnalysisRangeMin
Description The response to this query indicates the minimum analysis 

range.

Syntax object.AnalysisRangeMin

Parameters None

Response A Double value

Access Get

Note Unit=nm

Test Parameters AnalysisRangeStart
Description This command indicates the value to start the acquisition.

Syntax object.AnalysisRangeStart

Parameters Byval Double

Response Double

Access Get/Let

Note Unit=nm
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Test Parameters AnalysisRangeStop
Description This command indicates the value to stop the acquisition.

Syntax object.AnalysisRangeStop

Parameters Byval Double

Response Double

Access Get/Let

Note Unit=nm

Test Parameters AutoRangeFiltering
Description This command indicates the filtering mode.

Syntax object.AutoRangeFiltering

Parameter Boolean

Response Boolean

Access Gel/Let

Note It is highly recommended to set the system in filtering mode.

object.AutoRangeFiltering = True
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Test Parameters AvailableTests
Description The response to this query indicates the tests that can be 

performed according to the modules detected, the calibration 
and the reference measurement.

Syntax object.AvailableTests

Parameters None

Response Enumeration EAvailableTests

For more information, see Public Enum EAvailableTests on 
page 329.

Access Get

Note Depending on the module detected, you can perform an IL, 
Il/ORL, IL/PDL, IL/ORL/PDL, and ORL measurement.

Test Parameters KeepILForAllPolarization
Description This command keeps the insertion loss curves for all states of 

polarization (4), when a PDL acquisition has been performed.

Syntax object.KeepForAllPolarization

Parameters Boolean

Response Boolean

Access Get/Let

Note Default: False

This command requires a lot of memory space as there are four 
more curves by channel.
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Test Parameters NumberOfAcqChannels
Description This command indicates the number of channels to test.

Syntax object.NumberOfAcqChannels

Parameters Byval Long

Response Long

Access Get/Let

Test Parameters NumberOfAvailableChannels
Description The response to this query indicates the number of channels 

available.

Syntax object.NumberOfAvailableChannels

Parameters None

Response Long

Access Get
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clsDescModule ComputerName
Description This command indicates the computer name.

Syntax object.ComputerName

Parameters String

Response String

Access Get/Let

clsDescModule ID
Description This command indicates the module ID.

Syntax object.ID

Parameters Long

Response Long

Access Get/Let
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clsDescModule InitDone
Description This read-only property indicates that the initialization of the 

module has been performed.

Syntax object.InitDone

Parameters None

Response A Boolean value.

Access Get

clsDescModule ModuleName
Description This command indicates the module name (part number).

Syntax object.ModuleName

Parameters String

Response String

Access Get/Let
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clsDescModule SerialNumber
Description This command indicates the module serial number.

Syntax object.SerialNumber

Parameters String

Response String

Access Get/Let

clsDescModule Slot
Description This command indicates the module slot (e.g., 1-0).

Syntax object.Slot

Parameters String

Response String

Access Get/Let

clsDescModule SlotNumber
Description This command indicates the module slot number (e.g., 3).

Syntax object.SlotNumber

Parameters Long

Response Long

Access Get/Let
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clsChannel PmChannel
Description This command indicates the power meter channel (1-4) used. 

Use only for IQS-1600 power meter modules (value = 0 for 
other types of module).

Syntax object.PmChannel

Parameters Long

Response Long

Access Get/Let

clsChannel PmNumber
Description This command indicates the number of the power meter used. 

A number is assigned to all IQS-1100 power meter modules 
according to their position in the system.

Syntax object.PmNumber

Parameters Long

Response Long

Access Get/Let
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Event

Note: With FireEvent = True, the object raises an event at the end of the process. 
With FireEvent = False, no event occurs.

clsChannel oDescModule
Description The response to this query indicates the object which contains 

information about the power meter used.

Syntax Object.oDescModule

Parameters Object oDescModule

Response Object oDescModule

Access Get/Let

Example Object.DescModule.Id

Object.DescModule.SerialNumber

Note See clsDescModule Object—Properties on page 314.

Event AcqCompleted
Description AcqCompleted will fire once the acquisition is complete.

Parameters Byval Long: Enum State indicates the internal state of the 
object.

Note Only if FireEvent=True
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Event AcqError
Description AcqError will fire when an error occurred during acquisition.

Parameters Long: Command indicates the command that generated the 
error.

EState: State indicates the internal state of the object.

Long: ErrNumber indicates the error number.

String: ErrSource indicates the name of the function that 
generated the error.

String: ErrDescription provides a description of the error.

Note Only if FireEvent=True

Event AcqInProgress
Description AcqInProgress will fire when the acquisition is in progress.

Parameters Double: PercentageDone indicates the progress of the 
acquisition in percentage.

EState: State indicates the internal state of the object.

ESubState: SubState indicates the internal substate of the 
object.

String: Description provides a description of the action.

Byref Boolean: Cancel allows you to stop the acquisition in 
progress.

Note Only if FireEvent=True
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Event CalCompleted
Description CalCompleted will fire when the calibration is complete.

Parameters Byval Long: Enum State indicates the internal state of the 
object.

Note Only if FireEvent=True

Event CalError
Description CalError will fire when an error in calibration occurred.

Parameters Long: Command indicates the command that generated the 
error.

EState: State indicates the internal state of the object.

Long: ErrNumber indicates the error number.

String: ErrSource indicates the name of the function that 
generated the error.

String: ErrDescription provides a description of the error.

Note Only if FireEvent=True
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Event CalInProgress
Description CalInProgress will fire when the calibration is in progress.

Parameters Double: PercentageDone indicates the progress of the 
calibration in percentage.

EState: State indicates the internal state of the object.

ESubState: SubState indicates the internal substate of the 
object.

String: Description provides a description of the action.

Byref Boolean: Cancel allows you to stop the calibration in 
progress.

Note Only if FireEvent=True

Event Error
Description Error will fire when an error occurred.

Parameters Long: Command indicates the command that generated the 
error.

EState: State indicates the internal state of the object.

Long: ErrNumber indicates the error number.

String: ErrSource indicates the name of the function that 
generated the error.

String: ErrDescription provides a description of the error.

Note Only if FireEvent=True
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Event InitCompleted
Description InitCompleted will fire when the initialization is complete.

Parameters Byval Long: Enum State indicates the internal state of the 
object.

Note Only if FireEvent=True

Event InitInProgress
Description InitInProgress will fire when the initialization is in progress.

Parameters Double: PercentageDone indicates the progress of the 
initialization in percentage.

EState: State indicates the internal state of the object.

ESubState: SubState indicates the internal substate of the 
object.

String: Description provides a description of the action.

Byref Boolean: Cancel allows you to stop the initialization in 
progress.

Note Only if FireEvent=True

Event NullingCompleted
Description NullingCompleted will fire when nulling is complete.

Parameters Byval String: Description provides a description of the action.

Note Only if FireEvent=True
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Event NullingInProgress
Description NullingInProgress will fire when nulling is in progress.

Parameters Byval Double: PercentageDone indicates the progress of the 
nulling in percentage.

Byval String: Description provides a description of the action.

Note Only if FireEvent=True

Event OptimizePowerCompleted
Description OptimizePowerCompleted will fire when the optimization is 

complete.

Parameters Double: PercentageDone indicates the progress of the reference 
measurement in percentage.

EState: State indicates the internal state of the object.

ESubState: SubState indicates the internal substate of the 
object.

String: Description provides a description of the action.

Byref Boolean: Cancel gives the possibility to stop the reference 
in progress.

Note Only if FireEvent=True
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Event OptimizePowerInProgress
Description OptimizePowerInProgress will fire when an optimization is in 

progress.

Parameters Double: PercentageDone indicates the progress of the 
acquisition in percentage.

EState: State indicates the internal state of the object.

ESubState: SubState indicates the internal substate of the 
object.

String: Description provides a description of the action.

Byref Boolean: Cancel allows you to stop the acquisition in 
progress.

Note Only if FireEvent=True

Event RefCompleted
Description RefCompleted will fire when a reference measurement is 

complete.

Parameters Byval Long: Enum State indicates the internal state of the 
object.

Note Only if FireEvent=True
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Event RefError
Description RefError will fire when an error occurred during the reference 

measurement.

Parameters Long: Command indicates the command that generated the 
error.

EState: State indicates the internal state of the object.

Long: ErrNumber indicates the error number.

String: ErrSource indicates the name of the function that 
generated the error.

String: ErrDescription provides a description of the error.

Note Only if FireEvent=True

Event RefInProgress
Description RefInProgress will fire when a reference measurement is in 

progress.

Parameters Double: PercentageDone indicates the progress of the reference 
measurement in percentage.

EState: State indicates the internal state of the object.

ESubState: SubState indicates the internal substate of the 
object.

String: Description provides a description of the action.

Byref Boolean: Cancel gives the possibility to stop the reference 
in progress.

Note Only if FireEvent=True
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Event SourceActive
Description SourceActive will fire when the source is active.

Parameters If ByVal bActive As Boolean=True, the source is ON.

If ByVal bActive As Boolean =False, the source is OFF.

ByVal Description As String provides safety information.

Note Only if FireEvent=True

Event StabIQ9401
Description StabIQ9401 will fire when the temperature of the IQS-9401 

module is not stable at the beginning of the acquisition.

Parameters Long: Command indicates the command that generated the 
error.

EState: State indicates the internal state of the object.

Long: ErrNumber indicates the error number.

String: ErrSource indicates the name of the function that 
generated the error.

String: ErrDescription provides a description of the error.

Note Only if FireEvent=True
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Event Waiting
Description Waiting will fire when the system is waiting for the next 

command.

Parameters None

Note To deactivate this function, see DWDMAcq Interface—Properties 
on page 270. EnablingWaitingEvent=False.

Only if FireEvent=True
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Public Enum EAcqType
Res5pm = 1

Res10pm = 2

Res20pm = 3

Res40pm = 4
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Public Enum EAvailableTests
None = 1

Il = 2

Orl = 3

IlOrl = 4

IlPdl = 5

IlOrlPdl = 6

Public Enum EDecimalFormat
DecimalFormat0 = 0

DecimalFormat1 = 1

DecimalFormat2 = 2

DecimalFormat3 = 3

DecimalFormat4 = 4

DecimalFormatAuto = 5
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Public Enum EErrNumber
ErrPrevInstance = vbObjectError + 512

ErrInit = vbObjectError + 512 + 1

ErrDetection = vbObjectError + 512 + 2

ErrInitSource = vbObjectError + 512 + 3

ErrInitWrm = vbObjectError + 512 + 4

ErrInitPsa = vbObjectError + 512 + 5

ErrInitPm = vbObjectError + 512 + 6

ErrNoHardware = vbObjectError + 512 + 7

ErrInitStopped = vbObjectError + 512 + 8

ErrCalWrm = vbObjectError + 512 + 9

ErrNulling = vbObjectError + 512 + 10

ErrNullingIndex = vbObjectError + 512 + 11

ErrNullingType = vbObjectError + 512 + 12

ErrAcqRun = vbObjectError + 512 + 15

ErrHardNotCompatible = vbObjectError + 512 + 16

ErrInprogress = vbObjectError + 512 + 17

ErrChannelNumber = vbObjectError + 512 + 18

ErrInvalidILCurvePolState = vbObjectError + 512 + 19
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Public Enum EErrNumber
ErrInitBefore = vbObjectError + 512 + 20

ErrCalOrlRtjBefore = vbObjectError + 512 + 21

ErrCalOrlMandrelRtjBefore = vbObjectError + 512 + 22

ErrCalWrBefore = vbObjectError + 512 + 23

ErrRefIlBefore = vbObjectError + 512 + 24

ErrRefIlPdlBefore = vbObjectError + 512 + 25

ErrRefOrlMandrelBefore = vbObjectError + 512 + 26

ErrAcqBefore = vbObjectError + 512 + 27

ErrOptimizeBefore = vbObjectError + 512 + 28

ErrPowerMin_Wrm = vbObjectError + 512 + 30

ErrPowerMin_Ref = vbObjectError + 512 + 31

ErrPowerMin_Cal = vbObjectError + 512 + 32

ErrAcqStopped = vbObjectError + 512 + 33

ErrSimData = vbObjectError + 512 + 34

ErrAcqChannel = vbObjectError + 512 + 35

ErrOrlResultCurve = vbObjectError + 512 + 36

ErrSweepSpan = vbObjectError + 512 + 37

ErrScanRange = vbObjectError + 512 + 38

ErrAcqType = vbObjectError + 512 + 39

ErrSynchro = vbObjectError + 512 + 40

ErrCommandNotSupportedBySource = vbObjectError + 512 + 41

ErrMissingCalibrationParameter = vbObjectError + 512 + 42

ErrMissingWRCalibration = vbObjectError + 512 + 43

ErrMissingORLCalibration = vbObjectError + 512 + 44

ErrMissingDBTemplate = vbObjectError + 512 + 45
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Public Enum MaskType
BandPass = 0

Notch = 1

Undefined = 4

Public Enum ENullingType
NullAll = 1

NullWrm = 2

NullSinglePm = 3

Public Enum PdCwTrace
Min = 1

Max = 2

EPolarizationState
UnknownState = -1

LinearHorizontal = 0

LinearPositiveDiagonal= 1

LinearVertical= 2

RightCircular = 3

LeftCircular = 4

LinearNegativeDiagonal = 5
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Public Enum EPossibleTestWithHard
None = 1

IlORL = 2

IlOrlPdl = 3

Public Enum EPowerStatus
NotAveraged = 6

OverRange = 3

OverScale = 1

UnderRange = 4

UnderScale = 2

Valid = 0
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Public Enum EState
ModulesDetection = 1

InitModules = 2

NullMeasurement = 3

CalWrStart = 4

CalWrInProgress = 5

CalWrCompleted = 6

CalOrlRtjStart = 7

CalOrlRtjInProgress = 8

CalOrlRtjCompleted = 9

CalOrlRtjMandrelStart = 10

CalOrlRtjMandrelInProgress = 11

CalOrlRtjMandrelCompleted = 12

Public Enum ESubStateAcq
SubAcqSynchro = 0

SubAcqStart = 1

SubAcqInProgress = 2

SubAcqEnd = 3

SubAcqTransferingData = 4

SubAcqAnalyzingData = 5

SubAcqLoadCal = 6

SubAcqSaveCal = 7
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Switch Detect
Description This method starts the detection process of all the switches 

connected to the system.

Syntax object.Detect

Parameters None

Response A Variant containing an array of strings. Each element of the 
array can be accessed by using an index:

Returned_array (Index)

The detection process first checks for the presence of all EXFO 
IQS switches and then scans the GPIB bus for the presence of 
external switches. The contents of each string depends on the 
brand of the switches that have been detected, i.e. EXFO or 
external switches.

The following table presents the possible content for the 
returned strings.

Note that the terms in italics are module-specific.

Switch brand String content

EXFO Model_name[Slot=(slot_id)]

External Description[BOARDID=? PAD=?]
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Switch InitSwitch
Description This method performs the initialization of the specified switch, 

optionally initializing it in simulation mode.

Syntax object.InitSwitch (DetectedIndex,FireEvent,[Simulator])

Parameters DetectedIndex: Required if the switch is not used in simulation 
mode. A Long value indicating the index of the detected switch 
from the Detect method.

FireEvent: Required. A Boolean value indicating if the 
initialization process runs in the background and raise an event 
at the end of this process.

The following table presents the possible settings for the 
FireEvent argument.

Setting Description

True Allows the process to run in the background 
and raises an event once the process is 
complete.

False The client application stops the process and 
waits for the completion of the initialization 
process. No event is raised at the end.
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Simulator: Optional. A Boolean value indicating if the switch 
component is initialized in a simulation mode or not. The 
default value is False.

The following table presents the possible settings for the 
Simulator argument.

Response None

Note An event will be raised once the initialization is complete if the 
FireEvent argument has been previously set to True.

This method starts the initialization process of the specified 
switch. If the index is invalid or if there is a problem while 
communicating with the switch device, an error will be raised 
and the switch won’t be correctly initialized.

Setting Description

True Initializes a simulated switch. In this case, the 
DetectedIndex argument is not used.

False (Default). Initializes the specified physical 
switch. The DetectedIndex argument must be 
valid.
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Switch Enabled
Description This property returns or sets a value that determines if the 

switch lets the light go through it or not.

Syntax object.Enabled = [Boolean]

The following table presents the possible values for the boolean 
argument.

Parameters A Boolean value.

Response If the property is used to get the state of the switch, it will return 
a Boolean value. 

True: The light passes through the switch. 

False: The light does not pass through the switch.

Access Get/Let

Setting Description

True (Default). Allows light to go through the switch 
port specified by the Position property.

False Prevents light from going through the switch 
port by positioning it in the reset (0) position or 
by returning to the last position used.
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Switch InitDone
Description This read-only property returns a value that indicates if the 

switch has been initialized or not.

Syntax object.InitDone

Parameters None

Response  A Boolean value.

The following table presents the possible settings for the 
Boolean value.

Note The InitDone property indicates if the switch can be used or not.

Access Get

Setting Description

True The switch has been correctly initialized.

False The switch has not been initialized or did not 
initialize successfully.
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Switch InPorts
Description This read-only property returns the number of In (input) ports of 

the switch.

Syntax object.InPorts

Parameters None

Response  A Long value

Access Get

Switch ModuleName
Description This property returns the module identification string as it 

would be returned by the *IDN? GPIB command. For an EXFO 
switch, this identification string corresponds to its part number. 

Syntax object.ModuleName

Parameters None

Response A String value

Access Get
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Switch OutPorts
Description This read-only property returns the number of 

Out (output) ports of the switch.

Syntax object.OutPorts

Parameters None

Response  A Long value

Access Get

Switch Position
Description This property returns or sets a value that determines the active 

output port of the switch.

Syntax object.Position = [PortNumber]

If the property is used to set the position, PortNumber is a Long 
value that specifies the port number to set as the active output 
port. This value must be comprised between 1 and the available 
number of Out ports of the switch.

Parameters If this property is used to set the active output port number, use 
a Long value.

Response If this property is used to get the active output port number, a 
Long value will be returned.

Access Get/Let
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Switch RefIlDone
Description This read-only property returns a one-dimensional array 

containing Boolean values indicating the IL reference status of 
each port on the switch.

Syntax object.RefIlDone

Parameters None

Response A Variant containing an array of Boolean values (one value per 
port). Each element of the array can be accessed by giving an 
index corresponding to the desired port number.

object.RefIlDone (PortNumber)

The array has OutPorts items (see OutPorts on page 341), each 
representing the IL reference status of each output port of the 
switch.

The following table presents the possible status for the items of 
the array.

See also For more information, see RefIl on page 278, RefIlPdl on 
page 279,RefOrlMandrel on page 279. 

Note that the methods listed above work in conjunction with 
the Position of the switch (see Position on page 341).

Access Get

Value Description

True The IL reference has been taken on the 
specified port.

False The IL reference has not been taken yet on the 
specified port.
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Switch RefIlPdlDone
Description This read-only property returns a one-dimensional array 

containing Boolean values indicating the IlPdl reference status 
of each port on the switch.

Syntax object.RefIlPdlDone

Parameters None

Response A Variant containing an array of Boolean values (one value per 
port). Each element of the array can be accessed by giving an 
index corresponding to the desired port number.

object.RefIlPdlDone (PortNumber)

The array has OutPorts items (see OutPorts on page 341), each 
representing the IlPdl reference status of each output port of the 
switch.

The following table presents the possible status for the items of 
the array.

See also For more information, see RefIl on page 278, RefIlPdl on 
page 279,RefOrlMandrel on page 279. 

Note that the methods listed above work in conjunction with 
the Position of the switch (see page 341).

Access Get

Value Description

True The IlPdl reference has been done on the 
specified port.

False The IlPdl reference has not been done yet on 
the specified port.
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Switch RefOrlDone
Description This read-only property returns a one-dimensional array 

containing Boolean values indicating the ORL reference status 
of each port on the switch.

Syntax object.RefOrlDone

Parameters None

Response A Variant containing an array of Boolean values (one value per 
port). Each element of the array can be accessed by giving an 
index corresponding to the desired port number.

object.RefOrlDone (PortNumber)

The array has OutPorts items (see OutPorts on page 341), each 
representing the ORL reference status of each output port of the 
switch.

The following table presents the possible status for the items of 
the array.

See also For more information, see RefIl on page 278, RefIlPdl on 
page 279, RefOrlMandrel on page 279. 

Note that the methods listed above work in conjunction with 
the Position of the switch (see Position on page 341).

Access Get

Value Description

True The ORL reference has been taken on the 
specified port.

False The ORL reference has not been taken yet on 
the specified port.
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Switch SerialNumber
Description This read-only property returns the serial number of the switch.

Syntax object.SerialNumber

Parameters None

Response  A String value

Access Get
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Switch UseCommonRefIlPdl
Description This property returns or sets a value that determines if the 

reference measurement performed on switch port 1 (for IL and 
PDL) is applied to all switch ports.

Syntax object.UseCommonRefIlPdl = [Boolean]

The following table presents the possible settings for the 
Boolean value.

Parameters If the property is used to indicate that the reference value of 
switch port 1 must be applied to all switch ports, use a Boolean 
value.

Response If the property is used to find out if the reference value of switch 
port 1 is being applied to all switch ports, it will return a Boolean 
value. 

True: A common reference value for IL and PDL is used. 

False: No common reference value for IL and PDL is used 
(each port has its own reference).

Access Get/Let

Setting Description

True Allows to use the reference value of switch 
port 1 as the reference value for all of the other 
switch ports. Using the same reference value 
for all ports speeds up the referencing process, 
especially when working with large switches. 
However, the result accuracy will be affected.

False (Default). Since no common reference will be 
applied to switch ports, individual reference 
measurements will have to be performed.
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Analysis AddRefExtTrace
Description This method lets you add a trace that will be used in the 

calculation of an offset that can be applied to acquired traces 
for periodic testing.

Syntax object.AddRefExtTrace (Trace)

Parameters Trace: Required. A Variant value containing a two-dimensional 
array representing pairs of X,Y coordinates of the trace to set. 

Response None

Note This method allows you to add a trace to define an offset that 
can be applied to acquired traces during periodic test. This 
trace should be the acquisition result of an external reference 
patchcord used as a reference device. There should be as many 
traces as there are external reference patchcords connected to 
the setup.

This offset may be used to compensate intrinsic deviation of the 
system, mainly caused by the repeatability of the switch.

Use this method in conjunction with the following methods: 
AddRefExtZeroTrace, GetDriftTrace, GetCorrectedIlTrace.
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Analysis AddRefExtZeroTrace
Description This method adds an initial (zero) trace for the calculation of an 

offset that can be applied to acquired traces for periodic testing.

Syntax object.AddRefExtZeroTrace (Trace)

Parameters Trace: Required. A Variant value containing a two-dimensional 
array representing pairs of X,Y coordinates of the trace to set. 

Response None.

Note This method lets you specify which traces will serve as the zero 
traces to calculate an offset that can be applied to acquired 
traces during periodic tests. This trace should be the acquisition 
result of an external reference patchcord used as a reference 
device. There should be as many zero traces as there are 
external reference patchcords connected to the setup.

This offset may be used to compensate intrinsic deviation of the 
system, mainly caused by the repeatability of the switch.

Use this method in conjunction with the following methods: 
AddRefExtTrace, GetDriftTrace, GetCorrectedIlTrace.
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Analysis ClearRefExtTraces
Description This method removes all the initial (zero) traces used in the 

calculation of an offset that can be applied to acquired traces 
for periodic testing.

Syntax object.ClearRefExtTraces

Parameters None

Response None

Note This method lets you remove all previously set external 
reference traces.

After clearing the zero traces, you can no longer use the 
following methods: GetDriftTrace, GetCorrectedIlTrace.
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Analysis ClearRefExtZeroTraces
Description This method removes all the initial (zero) traces used in the 

calculation of an offset that can be applied to acquired traces 
for periodic testing.

Syntax object.ClearRefExtZeroTraces

Parameters None

Response None

Note This method lets you to remove the previously set zero traces.

After clearing the zero traces, you can no longer use the 
following methods: GetDriftTrace, GetCorrectedIlTrace.
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Analysis ClearResults
Description This method removes all resulting (IL, ORL, PDL) traces and the 

analysis results from memory.

Syntax object.ClearResults

Parameters None

Response None

Note This method allows you to remove from memory all previously 
acquired traces, and all analysis results that are available 
through the ChannelResults property.
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Description This method performs the analysis on the most recently 

acquired data that is available. The available results depend on 
the type of test that has been selected and on the acquired data.

Syntax object.DoAnalysis (ChannelStart, ChannelStop, 
PerformCrosstalk, PerformPd)

Parameters ChannelStart: Required. A Long value indicating the channel 
number of the power meter on which we want to start the 
analysis.

ChannelStop: Required. A Long value indicating the channel 
number of the power meter on which we want to stop the 
analysis. 

For details on ChannelStart and ChannelStop, see 
ChannelLocalisation on page 291.

PerformCrosstalk: Required. A Boolean value indicating 
whether the analysis must include crosstalk results or not.

PerformPd: Required. A Boolean value indicating whether the 
analysis must include polarization dependency (pd) results or 
not.
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Response None

Note This method starts the entire analysis process. You must have 
set the starting and the ending power meter channels so the 
results can be compiled and analyzed correctly, accordingly to 
what is physically connected.

Once the analysis is complete, the results are available through 
the IResults and the IAnalysis interfaces. IResults allows you to 
retrieve the compiled traces for IL, ORL and/or PDL tests. 
IAnalysis is used to retrieve a Single value as a result for IL, ORL, 
PDL, central wavelength, flatness, bandwidth, polarization 
dependency, etc.

If a calculation cannot be properly performed for a certain 
property, the returned value will be a Double containing an 
infinite value (1.#INF).

All retrieved data is for a given switch port. If you select a new 
switch port, all results will be lost and new acquisitions must be 
done before starting a new DoAnalysis method.

Each time the DoAnalysis method is started, all structured 
results from prior analysis (available through the IAnalysis 
interface) will be erased from memory.

See also PowerLevels, PdBw, PdCw properties and GetPdCwTrace 
method.
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Analysis GetCorrectedIlTrace
Description This method returns a calculated trace where an offset is 

applied to an acquired trace.

Syntax object.GetCorrectedIlTrace (DriftTrace, IlResultTrace) As Variant

Parameters DriftTrace: Required. A Variant value containing a 
two-dimensional array representing pairs of X,Y coordinates of 
the trace to set. Normally, you should provide the DriftTrace 
retrieved through the use of the GetDriftTrace method.

IlResultTrace: Required. A Variant value containing a 
two-dimensional array representing pairs of X,Y coordinates of 
the trace to set. The IlResultTrace parameter should be a 
previously acquired trace coming from acquisitions done on the 
DUTs.

Response This method returns a Variant value containing a 
two-dimensional array representing pairs of X,Y coordinates of 
the trace.

Note This method computes a trace where we apply an offset trace 
(DriftTrace) to a resulting IL trace (IlResultTrace).

This method must manipulate both traces to obtain a matching 
trace in terms of X,Y coordinates pairs. In some cases, 
interpolation must be used to fit the traces.

Note that this method has been designed for IL-type traces only.

Use this method in conjunction with the following method: 
GetDriftTrace.
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Analysis GetDriftTrace
Description This method returns a calculated trace that acts as an offset that 

can be applied to acquired traces for periodic testing.

Syntax object.GetDriftTrace

Parameters None

Response This method returns a Variant value containing a 
two-dimensional array representing pairs of X,Y coordinates of 
the trace.

Note This method computes a trace based on those that have been 
set through the use of the AddRefExtZeroTrace and 
AddRefExtTrace methods. If either one of the latter methods has 
not been used correctly, the GetDriftTrace method will fail.

Once you have retrieved this drift trace, you can apply it to 
previously acquired traces you have stored somewhere using 
your own algorithm. If you prefer, you can use the 
GetCorrectedIlTrace method to apply this offset.

This offset may be used to compensate for intrinsic deviation of 
the system, mainly caused by the repeatability of the switch.

Use this method in conjunction with the following method: 
GetCorrectedIlTrace.
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Analysis SetIlTrace, SetOrlTrace, SetPdlTrace
Description Each of these methods allows to re-analyze a previously 

acquired trace.

Syntax object.SetIlTrace (Trace)

object.SetOrlTrace (Trace)

object.SetPdlTrace (Trace)

Parameters Trace: Required. A Variant value containing a two-dimensional 
array representing pairs of X,Y coordinates of the trace to 
re-analyze.

Response None

Note The SetIlTrace, SetOrlTrace and SetPdlTrace methods let you 
re-analyze any acquired trace at a later time. This is mainly 
useful when you want to compare the results before and after 
applying drift traces for environmental type tests.

Once the trace of interest is set, you must start the DoAnalysis 
method before retrieving results.

Use this method in conjunction with the following methods: 
AddRefExtZeroTrace, AddRefExtTrace, GetDriftTrace, 
GetCorrectedIlTrace.
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Analysis SetUserWavelengthRange
Description This method sets a user-specific wavelength range for the 

analysis of the results.

Syntax object.SetUserWavelengthRange (LowerBound,UpperBound)

Parameters LowerBound: Required. A Double value indicating the starting 
wavelength to limit the range for the analysis features.

UpperBound: Required. A Double value indicating the ending 
wavelength to limit the range for the analysis features.

Response None

Note This method allows you to specify a second wavelength range 
for the results of the analysis. An error will be raised if the 
LowerBound value is higher than the UpperBound value.

The results may be obtained through the following functions:

FlatnessOnUserRange, IlOnUserRange, OrlOnUserRange and 
PdlOnUserRange.
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Analysis ChannelResults
Description This read-only property returns a one-dimensional array 

containing ChannelResult objects.

Syntax object.ChannelResults

Parameters None

Response A Variant containing an array of ChannelResult objects.

Each object is accessible through the use of an index.

The index is a required Integer value that corresponds to the 
position of the ChannelObject in the array.

Example Set oChannel = object.ChannelResults (1)

Note There are as many ChannelResult objects in the array as there 
are (ChannelStop - ChannelStart + 1) channels to analyze. 
ChannelStart and ChannelStop are specified through the use of 
the DoAnalysis method.

Access Get
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Analysis CrossTalkTables
Description This read-only property returns a one-dimensional array 

containing several crosstalk tables (a crosstalk table for each 
power level). Each crosstalk table corresponds to a 
two-dimensional array containing crosstalk values (in dB) 
between all channels under test.

Syntax Each crosstalk table is accessible through the use of an index.

object.CrossTalkTables (Index)

Parameters Index: Required. A Long value corresponding to the power level 
for which a crosstalk table is requested.

Response A Variant containing a two-dimensional array of Variant values. 
The values can be either a string or a numeric value.

Note The array forms a square matrix where:

Number of rows = number of channels that have been 
scanned + 1 (for the title row).

Number of columns = number of channels that have been 
scanned + 1 (for the title column).

The first row (after the title row) and the first column (after the 
title column) represent the first channel scanned (i.e. 
ChannelStart set through the DoAnalysis method). In the same 
way, the last row and the last column represent the last channel 
scanned (i.e. ChannelStop).

The value at the intersection of a column and a row is the 
crosstalk calculated between the channels represented by the 
column and by the row. This means that the values in the 
diagonal of the matrix (i.e. where column = row) are all N/A.

Access Get
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Analysis PdPrecision
Description This property returns or sets the precision used for polarization 

dependency analysis. Precision is expressed in dB.

Syntax object.PdPrecision (to retrieve the values)

objet.PdPrecision=Precision (to set the values)

Precision: a Long value comprised between 36 and 100.

36: lowest precision (fastest analysis)

100: highest precision (slowest analysis).

Parameters If the property is used to set the precision used for polarization 
dependency analysis, use a Long value.

Response If the property is used to get the precision used for polarization 
dependency analysis, the property will return a Long value.

Access Get/Let
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Analysis PowerLevels
Description This property returns or sets the attenuation level values used to 

obtain: bandwidth, flatness, central wavelength, IL, ORL, PDL, 
PdBw and PdCw. Power level values are expressed in dB.

Syntax object.PowerLevels (to retrieve the values)

objet.PowerLevels=Powers (to set the values)

Powers: a one-dimensional array containing Double values 
representing power values.

Parameters If the property is used to set the power levels, use a Variant 
containing a one-dimensional array of Double values 
representing power values.

Response If the property is used to get the power levels, the property will 
return a Variant containing a one-dimensional array of Double 
values representing power values.

Note Once the power levels have been set and the DoAnalysis 
method has been started, it is possible to retrieve the results 
through the BandPassResult and the NotchResults objects.

For a single ChannelResult object, there will be as many of 
these objects as there are power levels defined through this 
property.

Access Get/Let
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Analysis UserWavelengthRangeLowerBound
Description This read-only property returns the lower bound of the 

user-defined wavelength range in use for the results of the 
analysis. This value, expressed in nm, was previously set with 
the SetUserWavelengthRange method.

Syntax object.UserWavelengthRangeLowerBound

Parameters None

Response A Double value corresponding to the lower bound of the 
wavelength range.

Access Get

Analysis UserWavelengthRangeUpperBound
Description This read-only property returns the upper bound of the 

user-defined wavelength range in use for the analysis of the 
results. This value, expressed in nm, was previously set with the 
SetUserWavelengthRange method.

Syntax object.UserWavelengthRangeUpperBound

Parameters None

Response A Double value corresponding to the upper bound of the 
wavelength range.

Note Until the upper bound is set via the SetUserWavelengthRange 
method, the default value for this property is 0.0.

Access Get
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ChannelResult Object

ChannelResult Object
Description This object acts as a repository that indicates the type of 

detected channel that references a unique object based on the 
detected type, and specifies the number of the channel from 
which the results have been analyzed.

ChannelResult objects constitute the items of the array returned 
by the ChannelResults property from the Analysis interface (see 
ChannelResults on page 358 for more details).

Note You can access a ChanneResult object (an individual item of 
the array)by using an index value.

object.ChannelResults (Index)

Index: Required. An Integer value that indicates the position of 
an element in the ChannelResults array.

A ChannelResult object contains a reference to a unique object 
containing the results of the analysis retrieved by the DoAnalysis 
method. The availability of the unique object is restricted by the 
DetectedMaskType property.

ChannelResult object has these properties:

Bandpass

ChannelNumber

DetectedMaskType

Notch

Undefined
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ChannelResult BandPass
Description This read-only property returns a reference to a Bandpass 

object. This type of object contains the results of the analysis for 
a channel type that has been detected as a bandpass.

Syntax object.Bandpass

Parameters None

Returned value A reference to a Bandpass object

Access Get

ChannelResult ChannelNumber
Description This read-only property returns the logical number of the power 

meter channel from which the acquired data has been 
analyzed.

Syntax object.ChannelNumber

Parameters None

Response A Long value. For more information, see ChannelLocalisation 
on page 291.

Access Get
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ChannelResult DetectedMaskType
Description This read-only property returns the mask type of the channel 

that has been detected during the analysis of the data.

Syntax object.DetectedMaskType

Parameters None

Response A numeric value that corresponds to the mask type of the 
detected channel.

The table below displays the different types of masks with their 
corresponding constants.

Note You must use this property to retrieve the right reference on the 
unique object that has been created to contain the results of the 
analysis.

Based on the DetectedMaskType value, you can select which of 
these properties point to a valid unique object: Bandpass, 
Notch, Undefined.

Access Get

Constant Value Description

Bandpass 0 The mask type is a bandpass.

Notch 1 The mask type is a notch.

Undefined 4 The mask type is undefined 
(not identifiable).
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ChannelResult Notch
Description This read-only property returns a reference to a Notch object. 

This type of object contains the results of the analysis for a 
channel type that has been detected as a notch.

Syntax object.Notch

Parameters None

Response A reference to a Notch object

Access Get

ChannelResult Undefined
Description This read-only property returns a reference to an object of type 

Undefined.

An Undefined object contains the results of the analysis for a 
non-detectable channel type (bandpass or notch).

Syntax object.Undefined

Parameters None

Response A reference to an Undefined object

Access Get
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BandPass Object
Description This object acts as a repository that contains the results of the 

analysis of a channel for which the mask type could be 
identified as a bandpass filter.

Note You can access a BandPass object directly.

object.BandPass

A BandPass object contains many analysis results based on the 
entire analysis range and on the user-defined range (if explicitly 
set). This object allows you to obtain the IL, ORL and PDL 
results for the current channel.

BandPass object has these properties:

IlOnAnalysisRange

IlOnUserRange

OrlOnAnalysisRange

OrlOnUserRange

PdlOnAnalysisRange

PdlOnUserRange

PowerLevels
DWDM Passive Component Test System 367



COM Objects Reference
BandPass—Properties
BandPass—Properties

BandPass IlOnAnalysisRange
Description This read-only property returns the maximum IL based on the 

entire analysis range. The value is expressed in dB.

Syntax object.IlOnAnalysisRange

Parameters None

Response A Double value

Note The entire analysis range has been previously set using the 
AnalysisRangeStart and AnalysisRangeStop properties available 
through the ITestParameters interface.

Access Get

BandPass IlOnUserRange
Description This read-only property returns the maximum IL based on the 

user-defined analysis range. The value is expressed in dB.

Syntax object.IlOnUserRange

Parameters None

Response A Double value

Note The user-specific analysis range has been previously set using 
the SetUserWavelengthRange method (see page 357).

Access Get
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BandPass OrlOnAnalysisRange
Description This read-only property returns the lowest ORL (strongest 

reflection) based on the entire analysis range. The value is 
expressed in dB.

Syntax object.OrlOnAnalysisRange

Parameters None

Response A Double value

Note The entire analysis range has been previously set using the 
AnalysisRangeStart and AnalysisRangeStop properties available 
through the ITestParameters interface.

Access Get

BandPass OrlOnUserRange
Description This read-only property returns the lowest ORL (strongest 

reflection) based on the user-defined analysis range. The value 
is expressed in dB.

Syntax object.OrlOnUserRange

Parameters None

Response A Double value

Note The user-specific analysis range has been previously set using 
the SetUserWavelengthRange method (see page 357).

Access Get
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BandPass PdlOnAnalysisRange
Description This read-only property returns the maximum PDL based on the 

entire analysis range. The value is expressed in dB.

Syntax object.PdlOnAnalysisRange

Parameters None

Response A Double value

Note The entire analysis range has been previously set using the 
AnalysisRangeStart and AnalysisRangeStop properties available 
through the ITestParameters interface.

Access Get

BandPass PdlOnUserRange
Description This read-only property returns the maximum PDL based on the 

user-defined analysis range. The value is expressed in dB.

Syntax object.PdlOnUserRange

Parameters None

Response A Double value

Note The user-specific analysis range has been previously set using 
the SetUserWavelengthRange method (see page 357).

Access Get
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BandPass PowerLevels
Description This read-only property returns a one-dimensional array 

containing BandPassResult objects.

Syntax object.PowerLevels

Parameters None

Response A Variant containing an array of BandPassResult objects.

Each BandPassResult object can be accessed using an index. 
The index is a required Integer value corresponding to the 
position of the item in the array.

Example Set oResult = object.PowerLevels (1)

Note There are as many BandPassResult objects in the array as there 
are defined power levels with the PowerLevels property (for 
more information, see PowerLevels on page 361).

Access Get
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BandPassResult Object

BandPassResult Object
Description This object acts as a repository that contains the analysis results 

of a channel for which the mask type has been identified as a 
bandpass.

BandPassResult objects constitute the items of the array 
returned by the PowerLevels property from the BandPass 
object.

Note You can access a BandPassResult object (an individual item of 
the array) with the help of an index value.

object.PowerLevels (Index)

Index: Required. An Integer value that uniquely identifies a 
member of the PowerLevels array. For more information, see 
PowerLevels on page 371.
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A BandPassResult object contains many analysis results based 
on one of the power levels defined in the PowerLevels property. 
This object allows you to obtain the bandwidth, central 
wavelength, flatness, IL, ORL, PDL, PdBw and PdCw results for 
the current channel at the current power level.

BandPassResult object has these properties:

Bandwidth

BwLowerBound

BwUpperBound

CentralWavelength

Flatness

IlBw

IlCw

MaxCrosstalk

OrlBw

OrlCw

PdBw

PdCw

PdlBw

PdlCw

PowerLevel

TotalCrosstalk

and method:

GetPdCwTrace
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BandPassResult GetPdCwTrace
Description This method returns the trace associated with the minimum or 

the maximum central wavelength values affected by the 
polarization state of the signal.

Syntax object.GetPdCwTrace (PdCwTrace) as Variant

Parameters PdCwTrace: Required. A numeric value that corresponds to the 
constant associated with the desired trace.

The table below shows the possible values with their 
corresponding constants.

Response A Variant value containing a two-dimensional array representing 
pairs of X,Y coordinates of the desired trace.

Note This method returns the trace that corresponds to an extreme 
trace (representing the minimum central wavelength value or 
the maximum central wavelength) that the analysis can find, 
based on polarization state variations. 

The central wavelength value is obtained from trace analysis.

Constant Value Description

Min 1 Retrieved trace will 
correspond to the minimum 
central wavelength values.

Max 2 Retrieved trace will 
correspond to the maximum 
central wavelength values.
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BandPassResult—Properties

BandPassResult Bandwidth
Description This read-only property returns the spectral-width value based 

on the power level of the parent object. The value is expressed 
in nm.

Syntax object.Bandwidth

Parameters None

Response A Double value

Note This property allows to retrieve the spectral width over which 
the transmission of the channel exceeds the current power 
level (from the peak)as specified in the PowerLevel property of 
the parent object.

Access Get

BandPassResult BwLowerBound
Description This read-only property returns the lower-bound wavelength 

value over the bandwidth interval, based on the current power 
level (from the peak). The power level is defined in the 
PowerLevel property of the parent object. BwLowerBound 
value is expressed in nm.

Syntax object.BwLowerBound

Parameters None

Response  A Double value

Access Get
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BandPassResult BwUpperBound
Description This read-only property returns the upper-bound wavelength 

value over the bandwidth interval, based on the current power 
level (from the peak). The power level is defined in the 
PowerLevel property of the parent object. BwUpperBound value 
is expressed in nm.

Syntax object.BwUpperBound

Parameters None

Response  A Double value

Access Get

BandPassResult CentralWavelength
Description This read-only property returns the wavelength at the midpoint 

between the lower and the upper wavelengths based on the 
power level of the parent object. The value is expressed in nm.

Syntax object.CentralWavelength

Parameters None

Response A Double value

Note The midpoint that is returned is calculated for the current 
power level (from the peak) as specified in the PowerLevel 
property of the parent object.

Access Get
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BandPassResult Flatness
Description This read-only property returns the flatness based on the power 

level of the parent object. The value is expressed in dB.

Syntax object.Flatness

Parameters None

Response A Double value

Note This property allows to retrieve the flatness over the bandwidth 
interval based on the current power level (from the peak)as 
specified in the PowerLevel property of the parent object.

Access Get

BandPassResult IlBw
Description This read-only property returns the maximum IL value based on 

the power level of the parent object. The value is expressed in 
dB.

Syntax object.IlBw

Parameters None

Response A Double value

Note This property allows you to retrieve the maximum IL value over 
the bandwidth interval based on the current power level (from 
the peak)as specified in the PowerLevel property of the parent 
object.

Access Get
DWDM Passive Component Test System 377



COM Objects Reference
BandPassResult—Properties
BandPassResult IlCw
Description This read-only property returns the IL value based on the 

calculated central wavelength available in the parent object. 
The value is expressed in dB.

Syntax object.IlCw

Parameters None

Response  A Double value

Note This property allows you to retrieve the IL value obtained from 
analysis at the calculated central wavelength as specified in the 
CentralWavelength property of the parent object.

Access Get
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BandPassResult MaxCrosstalk
Description This read-only property returns the maximum crosstalk value 

between the current channel and all channels under test. The 
value is expressed in dB.

Syntax object.MaxCrosstalk

Parameters None

Response  A Double value representing the crosstalk value.

Note There is a crosstalk value between the current channel and 
each of the other channels under test. If there are N channels 
under test, then there are (N−1) crosstalk results associated 
with the current channel.

This property returns the highest value of these calculated 
crosstalk values.

Access Get
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BandPassResult OrlBw
Description This read-only property returns the lowest ORL value (strongest 

reflection) based on the power level of the parent object. The 
value is expressed in dB.

Syntax object.OrlBw

Parameters None

Response A Double value

Note This property allows you to retrieve the lowest ORL value over 
the bandwidth interval based on the current power level (from 
the peak) as specified in the PowerLevel property of the parent 
object.

Access Get

BandPassResult OrlCw
Description This read-only property returns the ORL value based on the 

calculated central wavelength available in the parent object. 
The value is expressed in dB.

Syntax object.OrlCw

Parameters None

Response  A Double value

Note This property allows you to retrieve the ORL value obtained 
from analysis at the calculated central wavelength as specified 
in the CentralWavelength property of the parent object.

Access Get
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BandPassResult PdBw
Description This read-only property returns the critical bandwidth value that 

comes from the difference between the minimum and 
maximum PDL traces resulting from the analysis, based on 
polarization state variations. The value is expressed in nm.

Syntax object.PdBw

Parameters None

Response  A Double value

Note The bandwidth interval, for each trace case, is based on the 
current power level (from the peak) as specified in the 
PowerLevel property of the parent object.

Access Get
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BandPassResult PdCw
Description This read-only property returns the critical central wavelength 

value affected by the polarization state of the signal, based on 
the calculated central wavelength available in the parent 
object. The value is expressed in nm.

Syntax object.PdCw

Parameters None

Response  A Double value

Note This property allows to retrieve the central wavelength value 
that comes from the difference between the minimum and 
maximum PDL traces resulting from the analysis, based on 
polarization state variations. 

The central wavelength value is obtained from the analysis of 
each trace case.

Access Get
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BandPassResult PdlBw
Description This read-only property returns the maximum PDL value based 

on the power level of the parent object. The value is expressed 
in dB.

Syntax object.PdlBw

Parameters None

Response A Double value

Note This property allows you to retrieve the maximum PDL value 
over the bandwidth interval based on the current power level 
(from the peak) as specified in the PowerLevel property of the 
parent object.

Access Get

BandPassResult PdlCw
Description This read-only property returns the PDL value based on the 

calculated central wavelength available in the parent object. 
The value is expressed in dB.

Syntax object.PdlCw

Parameters None

Response  A Double value

Note This property allows you to retrieve the PDL value obtained 
from analysis at the calculated central wavelength as specified 
in the CentralWavelength property of the parent object.

Access Get
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BandPassResult PowerLevel
Description This read-only property returns the current attenuation level 

used for analyzing the results stored in the parent object. The 
value is expressed in dB.

Syntax object.PowerLevel

Parameters None

Response  A Double value

Note The property returns the power level used for the analysis to get 
the results that can be retrieved through the parent object. This 
power level is one of the defined power levels set in the 
PowerLevels property.

Access Get
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BandPassResult TotalCrosstalk
Description This read-only property returns the sum of all crosstalk values 

between the current channel and all channels under test. The 
value is expressed in dB.

Syntax object.TotalCrosstalk

Parameters None

Response  A Double value representing the total crosstalk value.

Note There is a crosstalk value between the current channel and 
each of the other channels under test. If there are N channels 
under test, then there are (N−1) crosstalk results associated 
with the current channel.

This property returns the sum of these calculated crosstalk 
values.

Access Get
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Notch Object

Notch Object
Description This object acts as a repository that contains the results of the 

analysis of a channel for which the mask type could be 
identified as a notch filter.

Note You can access a Notch object directly.

object.Notch

A Notch object contains many analysis results based on entire 
analysis range and on the user-defined range (if explicitly set). 
This object allows to obtain the rejection, flatness, IL, ORL and 
PDL results for the current channel.

Notch object has these properties:

FlatnessOnTransmission

IlOnTransmission

IlOnUserRange

OrlOnTransmission

OrlOnUserRange

PdlOnTransmission

PdlOnUserRange

PowerLevels

Rejection
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Notch—Properties

Notch FlatnessOnTransmission
Description This read-only property returns the flatness based on the 

transmission portion of the notch. The value is expressed in dB.

Syntax object.FlatnessOnTransmission

Parameters None

Response A Double value

Access Get

Notch IlOnTransmission
Description This read-only property returns the maximum IL based on the 

transmission portion of the notch. The value is expressed in dB.

Syntax object.IlOnTransmission

Parameters None

Response A Double value

Access Get
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Notch—Properties
Notch IlOnUserRange
Description This read-only property returns the maximum IL based on the 

user-defined analysis range. The value is expressed in dB.

Syntax object.IlOnUserRange

Parameters None

Response A Double value

Note The user-specific analysis range has been previously set using 
the SetUserWavelengthRange method (see page 357).

Access Get

Notch OrlOnTransmission
Description This read-only property returns the lowest ORL (strongest 

reflection) based on the transmission portion of the notch. The 
value is expressed in dB.

Syntax object.OrlOnTransmission

Parameters None

Response A Double value

Access Get
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Notch—Properties
Notch OrlOnUserRange
Description This read-only property returns the lowest ORL (strongest 

reflection) based on the user-defined analysis range. The value 
is expressed in dB.

Syntax object.OrlOnUserRange

Parameters None

Response A Double value

Note The user-specific analysis range has been previously set using 
the SetUserWavelengthRange method (see page 357).

Access Get

Notch PdlOnTransmission
Description This read-only property returns the maximum PDL based on the 

transmission portion of the notch. The value is expressed in dB.

Syntax object.PdlOnTransmission

Parameters None

Response A Double value

Access Get
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Notch—Properties
Notch PdlOnUserRange
Description This read-only property returns the maximum PDL based on the 

user-defined analysis range. The value is expressed in dB.

Syntax object.PdlOnUserRange

Parameters None

Response A Double value

Note The user-specific analysis range has been previously set using 
the SetUserWavelengthRange method (see page 357).

Access Get
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Notch—Properties
Notch PowerLevels
Description This read-only property returns a one-dimensional array 

containing NotchResult objects.

Syntax object.PowerLevels

Parameters None

Response A Variant containing an array of NotchResult objects.

Each NotchResult object can be accessed using an index. The 
index is a required Integer value that corresponds to the 
position of the item in the array.

Example Set oResult = object.PowerLevels (1)

Note There are as many NotchResult objects in the array as there are 
defined power levels with the PowerLevels property (for more 
information, see PowerLevels on page 361).

Access Get
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Notch—Properties
Notch Rejection
Description This read-only property returns the maximum attenuation value 

based on the entire analysis range and constraint to the 
non-transmission portion. The value is expressed in dB.

Syntax object.Rejection

Parameters None

Response A Double value

Note The maximum attenuation value is based on the entire analysis 
range previously set using the AnalysisRangeStart and 
AnalysisRangeStop properties available through the 
ITestParameters interface. It is also restricted to the section 
where the attenuation is said to lie in the notch portion.

Access Get
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NotchResult Object
NotchResult Object

NotchResult Object
Description This object acts as a repository that contains the results of the 

analysis of a channel for which the mask type has been 
identified as a notch.

NotchResult objects constitute the items of the array returned 
by the PowerLevels property from the Notch object.

Note You can access a NotchResult object (an individual item of the 
array) with the help of an index value.

object.NotchResults (Index)

Index: Required. An Integer value that uniquely identifies a 
member of the PowerLevels array.

A NotchResult object contains many results of analysis based on 
one of the power levels defined through the PowerLevels 
property. This object allows to obtain the bandwidth, central 
wavelength, ORL and PDL results for the current channel at the 
current power level.

NotchResult object has these properties:

Bandwidth

BwLowerBound

BwUpperBound

CentralWavelength

OrlBw

OrlCw

PdlBw

PdlCw

PowerLevel
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NotchResult—Properties
NotchResult—Properties

NotchResult Bandwidth
Description This read-only property returns the spectral width value based 

on the power level of the parent object. The value is expressed 
in nm.

Syntax object.Bandwidth

Parameters None

Response A Double value

Note This property allows you to retrieve the spectral width over 
which the transmission of the channel exceeds the current 
power level (from the peak) as specified in the PowerLevel 
property of the parent object.

Access Get

NotchResult BwLowerBound
Description This read-only property returns the lower-bound wavelength 

value over the bandwidth interval, based on the current power 
level (from the peak). The power level is indicated in the 
PowerLevel property of the parent object. BwLowerBound is 
expressed in nm.

Syntax object.BwLowerBound

Parameters None

Response  A Double value

Access Get
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NotchResult—Properties
NotchResult BwUpperBound
Description This read-only property returns the upper-bound wavelength 

value over the bandwidth interval, based on the current power 
level (from the peak). The power level is stated by the 
PowerLevel property of the parent object. BwUpperBound is 
expressed in nm.

Syntax object.BwUpperBound

Parameters None

Response  A Double value

Access Get

NotchResult CentralWavelength
Description This read-only property returns the wavelength at the midpoint 

between the lower and the upper wavelengths based on the 
power level of the parent object. The value is expressed in nm.

Syntax object.CentralWavelength

Parameters None

Response A Double value

Note The midpoint that is returned is calculated for the current 
power level (from the peak) as specified in the PowerLevel 
property of the parent object.

Access Get
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NotchResult—Properties
NotchResult OrlBw
Description This read-only property returns the lowest ORL value (strongest 

reflection) based on the power level of the parent object. The 
value is expressed in dB.

Syntax object.OrlBw

Parameters None

Response A Double value

Note This property allows to retrieve the lowest ORL value over the 
bandwidth interval based on the current power level (from the 
peak) as specified in the PowerLevel property of the parent 
object.

Access Get

NotchResult OrlCw
Description This read-only property returns the ORL value based on the 

calculated central wavelength available in the parent object. 
The value is expressed in dB.

Syntax object.OrlCw

Parameters None

Response  A Double value

Note This property allows to retrieve the ORL value obtained from 
analysis at the calculated central wavelength as specified in the 
CentralWavelength property of the parent object.

Access Get
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NotchResult—Properties
NotchResult PdlBw
Description This read-only property returns the maximum PDL value based 

on the power level of the parent object. The value is expressed 
in dB.

Syntax object.PdlBw

Parameters None

Response A Double value

Note This property allows to retrieve the maximum PDL value over 
the bandwidth interval based on the current power level (from 
the peak) as specified in the PowerLevel property of the parent 
object.

Access Get

NotchResult PdlCw
Description This read-only property returns the PDL value based on the 

calculated central wavelength available in the parent object. 
The value is expressed in dB.

Syntax object.PdlCw

Parameters None

Response  A Double value

Note This property allows to retrieve the PDL value obtained from 
analysis at the calculated central wavelength as specified in the 
CentralWavelength property of the parent object.

Access Get
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NotchResult PowerLevel
Description This read-only property returns the current power level used for 

analyzing the results stored in the parent object. The value is 
expressed in dB.

Syntax object.PowerLevel

Parameters None

Response  A Double value

Note The property returns the power level used for the analysis to get 
the results that can be retrieved through the parent object. This 
power level is one of the defined power levels set in the 
PowerLevels property.

Access Get
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Undefined
Undefined

Undefined Object
Description This object acts as a repository that contains the results of the 

analysis of a channel for which the mask type could not be 
identified.

Note You can access an Undefined object directly.

object.Undefined

An Undefined object contains many analysis results based on 
entire analysis range and on the user-defined range (if explicitly 
set). This object allows to obtain the flatness, IL, ORL and PDL 
results for the current channel.

Undefined object has these properties:

FlatnessOnAnalysisRange

FlatnessOnUserRange

IlOnAnalysisRange

IlOnUserRange

OrlOnAnalysisRange

OrlOnUserRange

PdlOnAnalysisRange

PdlOnUserRange
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Undefined
Undefined—Properties

Undefined FlatnessOnAnalysisRange
Description This read-only property returns the flatness based on the entire 

analysis range. The value is expressed in dB.

Syntax object.FlatnessOnAnalysisRange

Parameters None

Response A Double value

Note The entire analysis range has been previously set using the 
AnalysisRangeStart and AnalysisRangeStop properties available 
through the ITestParameters interface.

Access Get

Undefined FlatnessOnUserRange
Description This read-only property returns the flatness based on the 

user-defined analysis range. The value is expressed in dB.

Syntax object.FlatnessOnUserRange

Parameters None

Response A Double value

Note The user-specific analysis range has been previously set using 
the SetUserWavelengthRange method (see page 357).

Access Get
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Undefined
Undefined IlOnAnalysisRange
Description This read-only property returns the maximum IL based on the 

entire analysis range. The value is expressed in dB.

Syntax object.IlOnAnalysisRange

Parameters None

Response A Double value

Note The entire analysis range has been previously set using the 
AnalysisRangeStart and AnalysisRangeStop properties available 
through the ITestParameters interface.

Access Get

Undefined IlOnUserRange
Description This read-only property returns the maximum IL based on the 

user-defined analysis range. The value is expressed in dB.

Syntax object.IlOnUserRange

Parameters None

Response A Double value

Note The user-specific analysis range has been previously set using 
the SetUserWavelengthRange method (see page 357).

Access Get
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Undefined
Undefined OrlOnAnalysisRange
Description This read-only property returns the lowest ORL (strongest 

reflection) based on the entire analysis range. The value is 
expressed in dB.

Syntax object.OrlOnAnalysisRange

Parameters None

Response A Double value

Note The entire analysis range has been previously set using the 
AnalysisRangeStart and AnalysisRangeStop properties available 
through the ITestParameters interface.

Access Get
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Undefined
Undefined OrlOnUserRange
Description This read-only property returns the lowest ORL (strongest 

reflection) based on the user-defined analysis range. The value 
is expressed in dB.

Syntax object.OrlOnUserRange

Parameters None

Response A Double value

Note The user-specific analysis range has been previously set using 
the SetUserWavelengthRange method (see page 357).

Access Get

Undefined PdlOnAnalysisRange
Description This read-only property returns the maximum PDL based on the 

entire analysis range. The value is expressed in dB.

Syntax object.PdlOnAnalysisRange

Parameters None

Response A Double value

Note The entire analysis range has been previously set using the 
AnalysisRangeStart and AnalysisRangeStop properties available 
through the ITestParameters interface.

Access Get
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Undefined
Undefined PdlOnUserRange
Description This read-only property returns the maximum PDL based on the 

user-defined analysis range. The value is expressed in dB.

Syntax object.PdlOnUserRange

Parameters None

Response A Double value

Note The user-specific analysis range has been previously set using 
the SetUserWavelengthRange method (see page 357).

Access Get
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D Definitions and Calculation 
Methods

The IQS-12004B DWDM Passive Component Test System performs a series 
of measurements and uses them in automated calculations. The different 
definitions and calculation methods used are explained in the following 
subsections. 

The DWDM Passive Component Test System can automatically analyze 
three different filter types: 

bandpass

notch

undefined

Depending on the mode of operation (Specified or Generic), the user may 
specify the filter type (Specified) or the system will attempt to auto-detect 
the filter type (Generic). 

The following sections describe the methods used for this data analysis.

Bandpass Notch Undefined
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Bandpass Filters

The following table summarizes the analysis made with bandpass filters.

Bandpass Filters

Central Wavelength X-dB center, where X is the dB level at which BW1 is measured 
(see Central Wavelength (nm) on page 410). 

When PDL is available, this is calculated using the average 
attenuation.

Difference The difference between the defined wavelength and the 
measured central wavelength.

IL Max attenuation over operating wavelength range (BW1) (see 
Insertion Loss (dB) on page 410).

When PDL is available, this is calculated using the average 
attenuation.

PDL (BW1) Max PDL over the range defined by BW1.

PDL (CW) PDL at the defined central wavelength (measured center for 
Generic).

PDL (Central 
wavelength ±x nm)

Max PDL over the range.

PDL (x to y nm) Max PDL over the range.

BW1, BW2, BW3 The bandwidth at dB level relative to the peak transmission (see 
Bandwidth (nm) on page 408).

When PDL is available, this is calculated using the average 
attenuation.

Flatness Delta attenuation across BW1 (see Flatness/Ripple (dB) on 
page 411).

When PDL is available, this is calculated using the average 
attenuation.
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Crosstalk Smallest difference between in-band (BW1) loss and other 
channel band (BW1) loss (see Channel Crosstalk (dB) on 
page 412).

When PDL is available, this is calculated using the average 
attenuation.

Max Crosstalk Maximum crosstalk value between the current channel and all 
channels under test.

Total Crosstalk Sum of crosstalk from other channels.

When PDL is available, this is calculated using the average 
attenuation.

ORL Lowest ORL (strongest reflection) value within BW1.

Bandpass Filters
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Bandwidth (nm)

Bandwidth is the spectral width over which the transmission of the device 
exceeds some stated loss value. The system can measure bandwidth at 
three different power levels, called BW1, BW2, and BW3, relative to the 
peak power level, as illustrated in the following diagram.

These levels are configurable by the user, but they are given the default 
values of 1.0 dB, 3.0 dB, and 20.0 dB.

A BW1 bandpass filter (at 1.0 dB or 0.5 dB) is commonly referred to as 
the passband or operating wavelength range of the device.

BW2 (at 3 dB) is the half-power bandwidth.

BW3 (at 20 dB or higher) is often used to describe the rejection or 
isolation band. The BW1/BW3 ratio can be used as an indicator of 
the filter shape.

IMPORTANT
The application uses BW1 for a number of calculations (IL, ripple, 
and crosstalk), and the results will depend on the selected method.

Increasing loss

1.0 dB bandwidth (BW1)

3.0 dB bandwidth (BW2)

20.0 dB bandwidth (BW3)

Wavelength
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Measured BW1

In this method, BW1 is calculated based on measurement data. 
For example, if you select a 1.0 dB bandwidth, the software will calculate 
the wavelength range corresponding to the measured BW1. As shown in 
the diagram, λlower and λupper correspond to the 1.0 dB cutoff wavelengths, 
and this wavelength range will be used for the IL, ripple, and crosstalk 
measurements.

Defined BW1

In this method, you specify to the software the wavelength range to use for 
the evaluation. You will have to provide a specific wavelength (normally an 
ITU wavelength) and a span centered at this wavelength.

As shown in the diagrams, the wavelength range for each case is different 
and the resulting calculations will be different. The choice between the 
two calculation methods is made in the Optical Ports Configuration 
window, as explained in Configuring an Optical Port on page 39.

1.0 dB bandwidth (BW1)

Defined BW1Measured BW1

ITU

λupperλlower λupperλlower
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Central Wavelength (nm)

The central wavelength is the wavelength at the midpoint between the 
lower and upper wavelengths at BW1 dB level from the peak. Note that 
the central wavelength is not necessarily the peak wavelength.

Insertion Loss (dB)

The insertion loss (IL) of a filter or multiplexer channel can be described 
in many different ways. The DWDM Passive Component Test System uses 
the following method to determine the insertion loss:

Maximum attenuation within the BW1 interval

The BW1 value you specified will be used as an interval on which the 
highest loss will be taken. This is illustrated below:

Increasing loss

Wavelength

0 dB loss line

3 dB

λc

IL measured at highest loss 
within the defined BW1 region
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Flatness/Ripple (dB)

The flatness (or ripple) is the IL variation over the BW1 interval of each 
channel.

Note: The ripple value for a measured BW1 analysis would most often be the 
power (dB) value at which BW1 is measured.

Ripple

Ripple

1.0 dB cutoff wavelengths
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Channel Crosstalk (dB)

The software calculates the worst-case crosstalk, which is the smallest 
difference in IL between two intervals on the main channel curve (BW1main 
and BW1interf).

ILmax is the highest loss on the main channel curve in the BW1main 
interval.

ILmin is the lowest loss on the main channel curve in the BW1interf 
interval.

Note: Measurements are taken between all bandpass channels, not only 
adjacent channels.

Interfering 
channel

Main 
channel

ILmax (dB)

ILmin (dB)

BW1mainBW1interf

Crosstalk (dB) from 
interfering channel
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Notch Filters
.

Notch Filters

Central Wavelength X-dB center of the notch (X is the BW1 dB level) (see Central 
Wavelength (nm) on page 410).

When PDL is available, this is calculated using the average 
attenuation.

Difference The difference between the defined center and the measured 
central wavelength.

IL Maximum attenuation value in the transmission portion (see 
Transmission Portion of Notch on page 414).

When PDL is available, this is calculated using the average 
attenuation.

PDL (BW1 Range) Max PDL over the range defined by BW1.

PDL (CW) PDL at operating wavelength (measured center for Generic).

PDL (CW ±x nm) Max PDL over the range.

PDL (x to y nm) Max PDL over the range.

BW1, BW2, BW3 At dB level from maximum attenuation (see Bandwidth (nm) on 
page 408).

When PDL is available, this is calculated using the average 
attenuation.

Flatness Delta attenuation across complete transmission portion (see 
Flatness/Ripple (dB) on page 411).

When PDL is available, this is calculated using the average 
attenuation.

ORL ORL value at central wavelength.

Rejection Maximum attenuation in the notch region.
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Transmission Portion of Notch

The attenuation data is divided into three regions:

transmission left (Tleft)

transmission right (Tright)

notch

The transmission portion is the total range of Tleft and Tright.

The wavelengths that segregate these regions are determined in a function 
that will find the nominal attenuation for each of the left and right 
shoulders. This is a statistical calculation and can be different for the right 
and left shoulders. 

Tleft Tright
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Undefined Filters 

Undefined Filters

IL Maximum attenuation over the entire range.

When PDL is available, this is calculated using the average 
attenuation.

PDL Max PDL based on the entire analysis range.

ORL ORL value representing the strongest reflection.

Flatness Maximum attenuation minus minimum attenuation over the entire 
range.

When PDL is available, this is calculated using the average 
attenuation.
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